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Chapter 1:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an
Editor, and a Tracer all of which operate in windows on the screen. The session
window is created when you start APL and is present until you terminate your
APL session. In addition there may be a number of edit and/or trace Windows,
which are created and destroyed dynamically as required. All APL windows are
under the control of Windows and may be selected, moved, resized, maximised and
minimised using the standard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different
techniques for mapping keystrokes to APL characters and to special command
shortcuts.

The Classic Edition uses a proprietary technique for these mappings.

By default, the Unicode Edition uses Microsoft's IME (Input Method Editor)
technology. Many other applications use the same technology, which means that
the Dyalog Unicode IME may be used not only with Dyalog APL for Windows
Unicode Edition, but also with word processing applications, spreadsheets,
terminal emulators etc. Therefore with the Dyalog Unicode IME installed, and with
a suitable font selected, APL characters can be entered and viewed in many other
applications.

As an alternative to the Dyalog Unicode IME, whose installation requires
Administrator privileges, the key mapping for the Unicode Edition may be
specified in the Windows registry. See Unicode Edition and the Registry Keyboard
on page 3.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.
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For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the
keystrokes which define special command keyboard shortcuts. For further details,
see Unicode Edition Keyboard on page 7 or Classic Edition Keyboard on page 11

Unicode Edition and the Dyalog Unicode IME

The Dyalog Unicode IME is the default input mechanism for generating

APL characters for Unicode editions of Dyalog APL. The version of the

IME supplied with version 18.0 can be used with version 12.1 and later, provided
that they are patched to a version created on or after 15t April 2011.

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode
characters. Only keystrokes which resolve to characters that either do not appear on
the standard keyboard or which differ from those that appear on the standard
keyboard are included in the selectable translate table. In effect the Dyalog
Unicode IME can be regarded as an overlay of the standard keyboard which
contains just APL characters.

The Dyalog Unicode IME supplied with Version 18.0 includes support for
Belgian, Danish, Finnish, French, German, Italian, Spanish Swedish and British and
American English keyboards, based on the Dyalog hardware keyboard layout;
these keyboard layouts are described at https://dfns.dyalog.com/n_keyboards.htm.
Note that for Danish, British and American English keyboards the older layouts,
based on the Dyalog APL Ctrl Keyboard, are included in the UnicodeIME\aplkeys
directory.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes
used by Dyalog APL.

These command keystroke mappings are ignored by applications unless the
application is explicitly named in the Dyalog Unicode IME configuration. It is
expected that only terminal emulators used for running UNIX-based versions of
Dyalog APL will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the
mappings in the translate tables; the mappings are defined under
Options/Configure/Keyboard Shortcuts (see Installation & Configuration Guide:
Configuration Dialog: Keyboard Shortcut Tab).

Note that the Dyalog Unicode IME replaces any previous IME, as well as the
Dyalog Ctrl and Dyalog AltGr keyboards.
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Unicode Edition and the Registry Keyboard

The Registry Keyboard provides an alternative mechanism for the Unicode Edition.
This feature maps keystrokes to APL characters using entries in the Windows
Registry. Dyalog supports the mechanism but does not provide the mappings
which must therefore be defined by the user.

Note that the Dyalog IME is used if it is available; the Registry Keyboard
mechanism is used only if the Dyalog IME is not installed.

The mappings are defined in the Registry sub-folder :

Computer\HKEY LOCAL MACHINE\SOFTWARE\Dyalog\
Dyalog APL/W-64 18.0 Unicode\KeyboardShortcuts\chars

Each entry consists of theUnicode code point of an APL character followed by the
keystroke to which it is mapped.

The keystroke is defined by 4 hexadecimal values which specify the key, the shift-
state, and 2 zeros. The key is represented by the Unicode code point of the symbol
engraved upon it, so (on a UK keyboard) the <1> key is hex 31 and the <A> key
is hex 41. The Shift-states values are the sum of 1 (Shift), 2 (Ctrl), 4 (Alt).

"0x230A"=hex:44,02,00,00
"0x235F"=hex:38,03,00,00

In the first entry, the APL character is Unicode code point 2302 which is |. The
key is <D> (hex 44) and the shift-state is Ctrl (hex 02).

In the second entry, the APL character is Unicode code point 235F which is &.
The character is entered by pressing <*> (‘hex 38) with Shift+Ctrl (hex 03).

Classic Edition

The mapping for each of the [JAV positions and its associated keystroke is defined
by a selectable translate table. JAV includes all the APL symbols used by Dyalog
APL as well as all the (non-APL) characters which appear on a standard keyboard.
This mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.

The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Backtick Keyboard

In addition to the standard APL keyboards, the RIDE keyboard may be used
natively. See Backtick Keyboard on page 9.
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Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them.
Functions and variables can be stored in the session namespace. This is
independent of the active workspace; so there is no conflict with workspace names,
and your utilities remain permanently accessible for the duration of the session.
Finally, you may set up different session configurations for different purposes
which can be saved and loaded as required.

The session window is defined by an object called [JSE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status
bars on the session window are in fact MenuBar, ToolControl and StatusBar
objects owned by [JSE. All of the other components such as menu items and tool
buttons are also standard GUIT objects. You may use [JWC to create new session
objects and you may use QWS to change the properties of existing ones. [JWG and
[OWN may also be used with [JSE and its children.

Components of the session that perform actions (Menultem and Button objects) do
so because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be
performed by Dyalog APL/W. These are coded as keywords within square brackets.
For example, the system operation [WSClear ] produces a clear ws, after first
displaying a dialog box for confirmation. You may customise your session by
adding or deleting objects and by attaching system operations or APL expressions
to them.

Like any other object, [JSE is a namespace that may contain functions and
variables. Furthermore, JSE is independent of the active workspace and is
unaffected by ) LOAD and ) CLEAR. It is therefore sensible to store commonly used
utilities, particularly those utilities that are invoked by events on session objects,
in [SE itself, rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the
requirement to have different sessions for different purposes. To meet this need,
sessions are stored in special files with a .DSE (Dyalog Session) extension. The
default session (i.e. the one loaded when you start APL) is specified by the
session_file parameter. You may customise this session and then save it over the
default one or in a separate file. You can load a new session from file at any stage
without affecting your active workspace.
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Positioning the Cursor

The cursor may be positioned within the current APL window by moving the
mouse pointer to the desired location and then clicking the Left Button. The APL
cursor will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple
lines, the use of the left mouse button always selects text from the start of the line.
A contiguous block of text can be selected by dragging with the right mouse
button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the
scrollbar.

Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an
editable object and double-clicking the left button on the mouse. If you double-
click on the empty Input Line it acts as "Naked Edit" and opens an edit window
for the suspended function (if any) on the APL stack. For further details, see
Invoking the Editor on page 111. See also "Installation and Configuration Guide:
DoubleClickEdit".

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property
of the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or
click a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.
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Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short
distance within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse
button. When the drag-and-drop pointer appears, drag the cursor to a new
location.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.

Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.
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Unicode Edition Keyboard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the
additional capability to generate APL characters when the user presses Ctrl, Alt,
AltGr (or some other combination of meta keys) in combination with the normal
character keys.

Dyalog APL is supplied with the Dyalog Unicode IME keyboard for a range of
different languages as listed below. The intention is that only APL characters and
characters that appear in locations different from the underlying keyboard are
defined; any other keystroke is passed through as is.

Installation

During the Installation of Dyalog APL Unicode Edition, setup installs the Dyalog
Unicode IME (IME). For any given Input Language the IME consists of an
additional service for that Input Language, and a translate table which maps
keystrokes for the appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs
Dyalog APL has defined, as well as every Input Language for which Dyalog has
support.

The keyboard mappings are defined for the following national languages: Belgian,
Danish, Finnish, French, German, Italian, Spanish, Swedish and British and
American English

These mappings are described at https://dfns.dyalog.com/n_keyboards.htm.

For any other Input Language the American English translate table is selected.
Note that some Input Languages are defined to be substitutes for other Input
Languages; for example Australian English Input is a substitute for American
English Input, Austrian German Input a substitute for German German Input. In
these cases the IME will install the appropriate translate table. It is also possible to
create support for new languages or to modify the existing support. See the IME
User Guide for further details.
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Configuring the Dyalog APL IME

The Dyalog Unicode IME is added as an additional service to all keyboards
defined to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined
for the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME
translate table that has been associated with the IME for the specific keyboard. In
the case of languages not supported by the IME the keyboard will default to en-
UsS.

IME Properties

To change the properties of the IME go to Options/Configure/Unicode Input tab
and select Configure Layout:

® Dyalog APL/W-64 Configuration

Windows Session Trace/Edit Auto Complete SALT User Commands Object Syntax
General Unicode Input Keyboard Shortcuts Saved Responses Workspace Help/DMX

[ipalog can automatically load pour zelected keyboard when the session window is made visible:

Activate selected keyboard ] Show keyboards for all languages
K.ewboard:
|Dyalog APL IME [enGB] W

Configure Lapout...

Cancel
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General  Ahout

Imput Tranzlate T able:

| C:MProgram FileshDyalogsUnicodel ME \aplkevshen-GB.din Browse...

[ Use Crrl+,C.3 for clipboard

[]Enable Backtick Kevboard introducer

Enable Overstrikes
[] Overstrikes do not require the '05" introducer key

[JUze Overstike popup

Cancel Apply

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create
support for new keyboards by altering the translate table, or by selecting a different
translate table. See the IME User Guide for more details.

Backtick Keyboard

The Backtick keyboard provided by the RIDE may be used natively. By default it
is disabled. To enable it, check the box labelled Enable Backtick Keyboard
introducer. You may replace the backtick character (*) with an alternative
character to act as the introducer for APL glyphs, but take care to choose a
character that is otherwise unused.

For information on using this keyboard interface, see RIDE User Guide.
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Overstrikes:

In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the
appearance of the glyphs. For example, the symbol for Grade Up (4) is actually the
symbol for delta (A) superimposed on the symbol for vertical bar (])

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example A may be
generated using Shift+Ctrl+4, or by switching to Replace mode and typing the
three keystrokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike
Introducer Key (key code OS).

Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last
character typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

A

Note the fine (red) line under the A. This indicates that an overstrike creation
operation is in progress.

The input of the symbol A can be completed by pressing Ctrl+m, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down.

Overstrikes do not require the OS introducer key:

With this option selected, the IME identifies characters which are part of a valid
overstrike, and when such a character is entered into the session, begins an
overstrike creation operation.
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Classic Edition Keyboard

The standard Classic Edition keyboard tables are files supplied in the aplkeys sub-
directory named cc.din where cc is the standard 2-character country code, e.g.
uk.din.

Note that the standard tables do not support the entry of APL underscored
characters AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

The Classic Edition keyboard layout is close to that of the Unicode Edition, but
does not include certain symbols which are only provided in the Unicode Edition.

Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that
produces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of
Dyalog APL, these are identified by 2-character codes; for example the action to
start the Tracer is identified by the code <TC>, and mapped to user-configurable
keystrokes.

In the Unicode Edition, Keyboard Shortcuts are defined using
Options/Configure/Keyboard Shortcuts and stored in the Windows Registry. Note
that the Unicode IME translate tables have definitions for the Keyboard Shortcuts
too; these are ignored by the interpreter, and are intended for use with terminal
emulators being used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

=Ny you hover the mouse over this icon, a pop-up tip is displayed to remind
you of your keyboard shortcuts as illustrated below.
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File Edit View Windows Session Log Action Options
WS g + Ml °r | Object @ 51 @ D 9 MW

Language Bar

Tools  Threads Help

Tool 2 o} 1= & |(Edit (1 41 9 Q| Session

[RERAPL38S Lnicode

] FETELEERIT) (O FFEFPR

[t <lT=I0e[¥]

L5lelelefa] [7=[%].[o[3[cle] DDEEB=|e[3]

x
oo~ u[a|v[z] = E
|

Dyalog APL/W-64% Version 18.0.38293

Cur0bj+

Serial number: 000042 - pre-release software
Sun May 2% 12:16:36 2020 [i ] Keyboard Shortcuts
QT: Quit (and lose changes): ShiftsEse
T8: Tab between windows: (None}
BT: Back Tab between windows: (None}
EP: Exit (and save changes): Esc
RS: Right Screen: (None)
LS: Left Screen: (Nane}
HO: Scroll to Current Line: (Nane}
CT: Cut: (None}
€P: Copy: (None}
PT: Paste: (None)
RD: Reformat: Num divide
DK: Delete Block: Control+Delete
FD: Forward or Redo: Control+Shift+Enter
BK: Backward or Undo: Control+Shift+Back
5C: Search: (None}
RP: Replace: (None)
NX: Next: (None)
PV: Previous: (None)
ED: Edit: Shift+Enter
TC: Trace: Control+Enter
FX: Fix the current function: (None}
LN: Toggle Line numbers: Num -
JP: JumP between current window and session window: (None)
BH: Run to exit (in tracer): (None)
8P: Toggle breskpoint: (Nane}
RM: Resume execution (in tracer): (Nane}
TL: Toggle lecalisation: Control+Up
UA: Undo all changes: (None}
AO: Comment out selected lines: (None)
DO: Uncomment selected Lines: (None)
GL: Go to Line: (None)
SA: Select all: (Nane}
AC: Align Comments: (None}
MA: Resume all threads (in tracer): (None}
OF: Open file in editor: (None}
FS: Save file in editor: (None)
FA: Save file "As” in editor: (None)
TT: Toggle the tree view in the editor: (Nane}
FT: Cycle focus around edit windows: (Nane}
PL: Go back to Previous Location: (None}
T0: Toggle outline: (None}
MO: Goto matching outline: (None)
S1: Fix script and exit editor: (None)
§2: Fix script but remain in editor: (None)
CA: cut to CApsule: (Nane}
IL: Insert Line under cursor: (None}
EL: Empty the line Line under cursor: (None}
HE
£
Debugger aox|®
Ready. .. Ins NUM

&:1 0pQ:0  OTRAP

0sI:0 O0OIO:1 [OML:1
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing
directives and special operations, and are summarised in the following tables. The
input codes in the first column of the tables are the codes by which the commands
are identified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input ..

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

US PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Armow Moves ‘Ehe cursor to the curren‘F character position
on the line below the current line

uc Up Arrow Moves ‘Ehe cursor to the curren't character position
on the line above the current line

UL Ctrl+Home M.ove the cursor to the top-left position in the
window

DL Ctrl+End Move§ the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

LL Home Moves the cursor to the beginning of the current
line

LW CtrlLeft Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor
TB Ctrl+Tab Switches to the next session/edit/trace window
BT Ctrl+Shift+Tab | Switches to the previous session/edit/trace window
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Table 2: Selection Commands

Input o
Code Keystroke Description
Le ShifitLeft Amow i);ttends the selection one character position to the
Re Shift+Right Extends the selection one character position to the
Arrow right
L Ctrl+Shift+Left | Extends the selection to the beginning of the
W Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Ue Shift+Up Arrow Extf:r}ds the selec?tlon to the current cha'racter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
Ll ShifitHome Extends 'the selection to the beginning of the
current line
RI ShifitEnd Extends the selection to the end of the current
line
Ul Ctrl-Shifi+ Home Extepds the s'electlon to the beginning of the first
line in the window
DI Ctrl-Shifi+End Extenfis the selection to the end of the last line in
the window
Us Shift+PgUp Extends the selection up by a page
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

Input

Code Keystroke Description

DI Delete Deletes the selection

DK [cutpue D st ne n Et v
CT Shifi+Delete E?S:,(:;iz the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard

FD Ctrl+Shift+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation

I R
OP Ctrl-Shifi+ Insert izs:?sdailtzia(r)li(l}l]i)ne immediately after the current
HT Tab Indents text

TH Shift+Tab Removes indentation

RD Keypad-slash Reformats a function (editor only)

TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]

AO Ctrl+Alt+, Add Comments

DO Ctrl+Alt+. Delete Comments

AC Align Comments
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Table 4: Special Operations

2?:;; Keystroke Description

IN Insert Insert on/off

LN Keypad-minus |Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify
different types of information. These colours are normally defined by registry
entries and may be changed using the Colour Configuration dialog box as
described later in this chapter.

In the Classic Edition, colours may alteratively be defined in the Output Translate
Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue
intensities (also 0-255). Foreground and background colours are specified
independently as Cnnn or Bnnn. For example, the following entry in the Output
Translate Table defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of
data in edit windows.

Table 5: Default Colour Scheme - Session

Colour | Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red
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Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 [OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue

Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a
syntax colouring scheme to the current Session Input line(s). You may also extend
syntax colouring to previously entered input lines, although this only applies to
input lines in the current session; syntax colouring information is not remembered
in the Session Log.

Syntax colouring may be used to highlight the context of names and other
elements when the line was entered. For example, you can identify global names
and local names by allocating them different colours.

See Installation & Configuration Guide: Colour Selection Dialog for further

details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as
the session log. Normally, the session window will have a menu bar at the top
with a tool bar below it. At the bottom of the session window is a status bar.
However, these components of the session may be extensively customised and,
although this chapter describes a typical session layout, your own session may
look distinctly different. A typical Session is illustrated below.

® CLEAR WS - Dyalog APL/W-64

File Edit View Windows Session Llog Action Options Tools Threads Help
ws g Y Y Obet @ g @ Y AM  Too O & IS & | Edit (7 51 9 Q| Session [ | APL385 Unicode v

Language Bar

(LIl efBlo[t]7] [l [Ffls(pllA ]
Dyalog APL/H-6% Version 18.0.38293

serial number: 000042 - pre-release software
Wed May 27 16:34:28 2020

® | X

==l [l LI feel] [l BOBEHELL baa | O
-

Editor

Debugger g0 x
Ready... Ins  NUM
CurObj: &:1 0oQ:0  OTRAP | OSI:0 [I0:1  [OML:1

A typical Session window
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Window Management

When you start APL, the session is loaded from the file specified by the session_
file parameter. The position and size of the session window are defined by the Posn
and Size properties of the Session object [SE, which will be as they were when
the session file was last saved.l

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the
standard Windows facilities.

In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows.
You may dock and undock these windows as required. The standard Session layout
illustrated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL
requests input from or output to the session. This means that end-user applications
that do not interact with the user through the session will not have an APL session
window.

IIn a Windows shortcut to an application, the Run: state may be one of "Normal window",
"Minimised" and "Maximised". There are other states which can be set when a process is spawned. If
the Run: state is Normal or Default, Dyalog APL will use the settings in the current session file to
determine the state and size of the session on startup; for all other states (including Maximised and
Minimised) these states will be used, superceding the settings in the current session file.
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Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the
Session window or be stand-alone floating windows. When windows are docked in
the Session, the Session window is split into resizable panes, separated by splitters.
The following example, using the Status window, illustrates the principles
involved. (The use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)

window as shown below.

5]

File Edit View Windows Session Log Action Options Tools Threads Help

ws g VM r | Object @ ol @ D AN | Tool £ 5 IS 8 | Edit [ 51 D Q| Session ol [ [APLIS Unicode [ 16[Z]

Language Bar

FETEBOlTs] (T EEREER (R (=R [Rbrr [Te3[H [EFLIFFE [POEBEEL FRELERES |2

~

® | X

Dyalog APL/W-64 Version 18.0.38293
Serial number: 000042 - pre-release software
Wed May 27 16:3%:28 2020

File Options

Close

v

Editor

Debugger =N=
Ready... Ins  NUM
CurObj: &:1 0DQ:0 [OTRAP | [SI:0 [I0:1 [OML:1
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If you press the left mouse button down over the Status window title bar, and drag
it, you will find that when the mouse pointer is close to an edge of the Session
window, the drag rectangle indicates a docking zone as shown below. This
indicates the space that the window will occupy if you now release the mouse

button to dock it.

@ cear 0g APL/W-6 - o x

File Edit View Windows Session log Action Options Tools Threads Help

ws g By [ Obet @ A @B EM [To O oS Edit (7 & 9 @ | Session EE

Language Bar x| %

=BR[] (T [ R FENap] KR R e [T FFHe POBRE:) Freeerss
3 ~

yalog APL/W-64 Version 18.0.
erial number: 000042 - pre-release software
Wed May 27 16:34%:28 2020

Close

v

Editar

aox

Debugger
Ready... Ins NUM
2:1 0DQ:0 [OTRAP [OSI:0 OI0:1 [ML:1

Curbj:
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session
log window in the lower pane. You can resize the panes by dragging with the

mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked

window.

File Edit View Windows Session Log Action Options Tools Threads Help
Object g ] @ B A W@ | Tool 2 = & | edit (P 5] 9 Q| Session . [ |APL3S5 Unicode v

Ws g + W r ¥ 1=
XX

Language Bar
(o ] (L) (-pfelebefee (] (f=E=0ale [l el ] [-[%] [BOBEBL] clluellal | O

- oax

Status

Dyzlog APL/W-64 Version 18.0.38293
Serial number: 000042 - pre-release software
Wed May 27 16:34:28 2020

Editar

v
[= =i

Debugger
Ready... Ins  NUM
2:1 ObQ:0  OTRAP | OSI:0 [0I0:1  [OML:t

Cur0bj+
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,

which is used to restore the pane to its original size.

@ cLEar log A 64

File Edit View Windows Session log Action Options Taols Threads Help
ws g SB[ Obect @ A @ T GM (Tool O 5 IE & Edit (f 4 9D Q| Session
Language Bar x | %
LBl O] [l PREF] MR [ [fell-] [[-Jelelep] [T¥-[-[5Ffe] DOBBBLL]] [cp[ufefrfes ©
Status ==
Dyalog APL/W-6% Version 18.0.38293 ~
Serial number: 000042 - pre-release softwsre
Wed May 27 16:34:28 2020
8
Debugger aox @
Ready. .. Tns  NUM
Curdbi: g:4  [ODQ:0 OTRAP [DSI:0 [OIO:t [DML:t




Chapter 1: The APL Environment 25

You can pick up a docked window and then re-dock it along a different edge of
the Session as illustrated below.

File Edit View Windows Session log Action Options Tools Threads Help
ws 13 JHlY (ot @ @@ D AM ool O 5 S & (Rt P g1 D C | Session o [H[APLEE Unicode [ T615]
Language Bar x| %
[P EL[ERE] ([ [e]<PRER [F[s[<[=[<0fa] [:[s]e el [[lelelele] [FF-[[F[efe] [OOEEBfx]s] [o[a-[ua(s |
Status oox
yalog APL/H-64 Version 18.0.38203 Y
erisl number: 000042 - pre-relesse software
Wed May 27 16:34:28 2020
3
Debugger aox|€
Ready. .. Tns  NUM
Curdbi: 2:1 | [ODQ:0 OTRAP [SI:0 [DIO:1  OML:t

Docking the Status window along the left edge of the Session causes the Session
window to be split into two vertical panes. Notice how the title bar is now drawn

vertically.

® CLEAR WS - Dyalog A

File Edit View Windows Session log Action Options Tools Threads Help

ws g JHlY Ot @I @D AM ool O 5 S & (R 61 D @ | Session <) [H[APLEE Unicode [ 1617]

Language Bar x| %

M - - = B ERE u = EEGRBGE E F] i

FEEleEe] [T FHFRER [t =[=[[0]4]] [ulefels]~ [[le[elels] [FIF[.[-[FEe] [DOBER]s] [e[a-ule[v]8]&5 o

x Dyalog APL/W-64 Version 18.0.38293 ~

o Serial number: 000042 - pre-release software

i Wed May 27 16:34:28 2020

E

2

k- ) 2
Debugger a0 x| B
Ready... Ins  NUM
CurObj: 2:1 | [ODQ:0 OTRAP [SI:0 DOI0:1  OML:t
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If you click the right mouse button over any window, its context menu is
displayed. If the window is dockable, the context menu contains the following

options:

Undocks the docked window. The window is displayed at

Undock whatever position and size it occupied prior to being docked
Hlde. Hides the title bar of the docked window
Caption

Specifies whether the window is currently dockable or is locked in
Dockable | its current state. You can use this to prevent the window from
being docked or undocked accidentally

The last picture shows the effect of using Hide Caption to remove the title bar. In
this state, you can resize the pane with the mouse, but the Minimise, Maximise and
Close buttons are not available. However, you can restore the object's title bar
using its context menu.

@ CLEAR Ws - Dyalog APL/W-64

File Options
ws 13 Y% [Obet g ) @V T Teol O G IS & | Edit i 51 9 Q| Session APLIS Unicode [ 16[Z]

Language Bar

R

-] CELERelEll ] (T-F FFEFRER ([ [esf[[] [Ielelels] [T<[.[=[<[6e] [DOEBR[EL:]s] [o[R}olals]s}E g
P
a
1

Dyalog APL/W-6% Version 18.0.38293 ~
Serial number: 000042 - pre-release software
Wed May 27 16:3%:28 2020

Clear
Copy
Select All

Auto Status

UnDock
+  Dockable
v Above Session
Hide Caption

Status

Editor

Debugger a0 x
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Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the Language Bar, a pop-up tip is

displayed to remind you of its usage. If you click on a symbol in the Language
Bar, that symbol is inserted at the cursor in the current line in the Session.

CurObj:

File Edit View Windows Session log Action Options Tools Threads Help
ws 13 JHlY (ot @ @@ D AM ool O 5 S & (Rt P g1 D C | Session o [H[APLEE Unicode [ T615]
Language Bar x| %
PR [ERE] [ [<PRER ([ [<[=[<0fa] [:[s]ele]eln[ [[lelelele] FFF-[[Fee] [OOEEBfx] e[ |
Dyalog APL/W-6% Version 18.0.38203 2l -
Serial number: 000032 - pre-rel s
sun May 24 12:37:01 2020 @ Cirdle Dieresis (&)
Keyboard: Control+Shifts0
Dyadic operatar: Over
-8l 3.6 A Same =5 o or ¥ monsdically
-3
5.1 5L 3.6 A Applies L to both srguments
2
‘Dyalog’ =#[lC 'DYALOG' & Case-insensitive match
1
‘Dyalog’ =d0c 'T8M'
0
More
J 5
Debugger aox|€
Ready. .. Tns  NUM
2:1 | [ODQ:0 OTRAP [SI:0 [DIO:1  OML:t
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Popup Menu
If you click the right mouse button in the Language Bar, the context menu displays

the following options:

Insert Space Before
Delete
Help

Use the Session font
Revert to defaults

UnDock
«  Dockable

Above Session

Hide Caption
Item Description
Insert
Space Inserts a blank space before the current symbol (or blank)
Before
Delete Deletes the current symbol (or blank)
Help Displays the (F1) help topic for the current symbol.
Use .the Displays the symbols using the current Session font (by default
Session . .
font the symbols are displayed using a small font)
Revert to | Removes all user customisation and reverts to the standard
defaults Language Bar.
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Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last
line in the session, and is (normally) the line into which you type an expression to
be evaluated.

The session log is a history of previously entered expressions and the results they
produced.

If you are using a log file, the Session log is loaded into memory when APL is
started from the file specified by the log_file parameter. When you close your APL
session, the Session log is written back out to the log file, replacing its previous
contents.

In general you type an expression into the input line, then press Enter (ER) to run
it. After execution, the expression and any displayed results become part of the
session log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the
beginning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the
end of the last (i.e. the current) line in the session log. Home (LL) and End (RL)
move the cursor to the beginning and end respectively of the line containing the
Cursor.

Deleting Lines

You may delete one or more lines from the Session using the DK command
(Ctrl+Delete). This action removes the current line or the selected block of lines
from the Session window and from the Session log. The removal is permanent and
you will be prompted to confirm:

|, This will permanently modify the session log
~ Are you sure you want to do this?

(] Do net ask this question again Yes
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Auto Complete

As you start to enter characters in an APL expression, the Auto Complete
suggestions pop-up window (AC for short) offers you a choice based upon the
characters you have already entered and the current context.

For example, if you enter a [, AC displays a list of all the system functions and
variables. If you then enter the character r, the list shrinks to those system
functions and variables beginning with the letter r, namely Orefs, Or L, Orsi,
and [rt L. Instead of entering the remaining characters, you may select the
appropriate choice in the AC list. This is done by pressing the right cursor key.

If you begin to enter a name, AC will display a list of namespaces, variables,
functions, operators that are defined in the current namespace. If you are editing a
function, AC will also include names that are localised in the function header.

If the current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.

As an additional refinement, AC remembers a certain number of previous auto
complete operations, and uses this information to highlight the most recent choice
you made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two
characters ) c, AC displays the same list of choices, but this time ) cs is pre-
selected.

You can disable or customise Auto Completion from the Auto Complete page in
the Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER).
Alternatively, you can select Execute from the Action menu. Following execution,
the expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you
do so, it will be displayed using colour 249 (Red on White), the same as that used
for the input line. When you press Enter the new line is copied to the input line
prior to being executed. The original line is restored and redisplayed in the normal
session log colour 250 (Black on White).
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An alterative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle
backwards and forwards through the input history, successively copying previously
entered expressions over the current line. When you reach the expression you want,
simply press Enter to re-run it. These operations may also be performed from the
Edit menu in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the
session log before pressing Enter. Each line that you change will be displayed
using colour 249 (Red on White). When you press Enter, these marked lines are
copied down and executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a
leading space for instance.

It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste
them back into the session using Shift+Insert (PT). Lines pasted into the session are
always marked (Red on White) and will therefore be executed when you press
Enter. To execute lines from an edit window, you use a similar procedure. First
select the lines you want to execute, then cut or copy the selection to the
clipboard. Then move to the session window and paste them in, then press Enter to
execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable (JPW to specify the width
of the user's terminal or screen. Session output that is longer than [PW is
automatically wrapped and split into multiple lines on the display. This feature of
APL was designed in the days of hard-copy terminals and has become less relevant
in modem Windows environments.

Dyalog APL continues to support the traditional use of [JPW, but also provides an
alternative option to have the system wrap Session output according to the width
of the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.
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Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect,
but also in the Session. For example, if you have just entered a series of
expressions involving a variable called SALES and you want to perform the same
calculations using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box, and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White).

Now click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it
is either closed or replaced by the other. This is particularly convenient if the same
operations are to be performed over and over again, and/or in several windows.
Find and Find/Replace operations are effective in the window that previously had
the focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window,
APL will display a pop-up window containing the value of the symbol under the
mouse pointer.

For example, in the following picture the mouse pointer was moved over the name
of the variable HW in the Session window.

clear ws
HW+'Hello World'
MAT+-3 4priZ2

lvars

HR vis T
Hello World I
Character Vectar I

The next picture illustrates the Value Tip displayed when the mouse is hovered
over the name of the variable MAT.

clear ws
HW="Hello World'
MAT+-3 4pri2
lvars

HW MA

Readonly Murmeric Array
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Similarly, if you hover the mouse pointer over the name of a function, the system
displays the body of the function as a pop-up, as illustrated below.

zlear ws
HW+'Hello World®
MAT+3 4pri2
JVARS
HW MAT
JCOPY UTIL MATRIX

C:\Program Files\Dyalog\Dyalog APL-6% 18.0 Unicode\ws\UTIL.dws saved Mon Apr 20 20:32:24% 2020

JFNS
MATRI [o] i R+<MATRIX X n Converts scalars and vectors
[11:¢ ¢ R+~{72t1 1,pX)pX A ... to 1 row matrices.

Function Dyadic: 04/11/...
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Value Tips for External Functions

Value Tips can also be used to investigate the syntax of external functions. If you
hover over the name of an external function, the Value Tip displays its Function
Signature.

For example, in the example below, the mouse is hovered over the external
function dt.AddMonths and shows that it requires a single integer as its
argument.

clear ws
OUSING~'System’
dt=DateTime.Now
dt .MethodlList

Add AddDays AddHours AddMilliseconds AddMinutes AddMonths
nMonth Equals FromBinary FromFileTime FromFileTimeUte
TypeCode IsDaylightSavingTime IsleapYear Parse Parseixa
ileTime ToFileTimeUtc TolocalTime TolongDateStrimg Tele
ing ToS5tring TelUniversalTime TryParse TryParseExact
dt.AddMonth

System.DateTime AddMonths{Int32)

Function Signature

Should the external function provide more than one signature, they are all shown
in the Value Tip as illustrated below. Here the function ToString has four
different overloads.

clear ws

OUSING='System'
dt+~DateTime.Now

)Cs dt
#.[System.DateTime]

JMETHODS
Add AddDays AddHours AddMilliseconds AddMinutes AddMonths
AddSeconds AddTicks AddYears Compare CompareTo DaysInMonth
Equals FromBinary FromFileTime FromFileTimeUtc FromOADate
GetDateTimeFormats GetHashCode GetType GetTypeCode IsDaylightSavingTime
IsleapYear Parse ParseExact Referencefquals SpecifyKind Subtract
ToBinary ToFileTime ToFileTimeUtc TolocalTime TolongDateString
TolongTimeString ToOADate ToShortDateString ToShortTimeString
Tostr-'l Tollas I 0 I 0 L i

LIs
System.String ToString()
System.String ToString(System.String)
System.5tring ToString(System.IFormatProvider)
System.5tring ToString(System.String, System.IFormatProvider)

Function Signature
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab
of the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips
are displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

[ Dyalog -84 Configuration
Windows Session Trace/Edit Auto Complete SALT User Commands Object Syntax
General Unicode Input Keyboard Shortcuts Saved Responses Workspace Help/DMX

Recently used file list size: IZI

Underline URLs and links

Enable Mative Look and Feel

Enable DP| Scaling of the interpreter and development environment

[JEnable DP Scaling of GUI application

Configuration saved in:

|HKEY_EUFIF!ENT_USEH\SDFTWAF!E\Dyang\Dyang APLAW-54 18.0 Uricods

Cancel
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Array Editor

The Array Editor! allows you to edit arbitrary arrays. It is invoked by either:

o Clicking the “H icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.

« Calling the user command Jarray.edit, specifying the name of a
suitable variable as its argument.

o Calling it directly via ONA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

Array Editor

File Edit Actions Insert Options Help
KEH&|f @ ~ Q| B |ABC 123 a ¥ |

o =c (B BE B 2 | @

et cadeq 1735 ,['"'] c[ppw]

~
ICharacters I.&BC agy
INumbers: |o 1 |4 5 6 |3.14 5.6£723 (071
IScaI.ars:
IFector5= IFour score and seven years ago
IHatrices: 1 2 3 &
5 & 7 B
9 10 11 12
]
Type: Nested array =: 3 =/p: 5 pp: 2 p: 51 =:

I Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2015
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Documentation

Full documentation for the Array Editor, including a list of the keystrokes it uses,
is available from the Help menu in the Array Editor's window.

Supported Arrays

The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a [JOR.

Reject unsupported data

The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.

If this is set to true (the default), and you try to edit an array containing an object
reference, the Array Editor will refuse to start and the system will generate an error
message.

(OSE.NumEd.numed: Unexpected error in array editor:
DOMAIN ERROR Argument contained data that is
neither simple or nested.

If this option is cleared, the Array editor will start but you will not be able to do
anything. It is therefore advisable that you leave this option set.

Notes

o The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.

« Namespaces are not supported.

« Internal representations returned by [JOR are not supported.

¢ Only one instance of the Array Editor may be executed at a time.

o All calls to interpreter primitives use a value of 3 for [IML.

« Negative numbers must be represented using high minus signs. For example,
~3 not -3.
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Implementation

The Array Editor is implemented by a DLL named dlaedit.dl11l (32-bit) or
dlaedit64.d1ll (64-bit).

The DLL exports two functions: DyalogEditArray and

DyalogEditArrayTitle. The latter is used when you click the W icon in the
Session toolbar (via the APL function (JSE . NumEd.numed) and by the user
command Jarray.edit

Calling the Array Editor Directly

If you wish to use the Array Editor directly, you may do so as follows using [JNAL.

For both DyalogEditArray and DyalogEditArrayTit le the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0

For DyalogEditArrayTitle the 3rd argument is a character vector whose
contents are displayed in the caption of the array editor window.

The result is the newly altered array.

Examples

ONA'dlaedit.dll|DyalogEditArray <pp >pp' A 32-bit
ONA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' ~n 32-bit

ONA'dlaedité4.dl | |DyalogEditArray <pp >pp' A 64-bit
ONA'dlaedité4.dll|DyalogEditArrayTitle <pp >pp <0C2[]'m 64-bit

New<DyalogEditArray Old O
New<DyalogEditArrayTitle Old 0O Name

INote that these are not standard [JNA calls, but rather use an extension to [ONA, called Direct
Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.
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The Session GUI Hierarchy

As distributed, the Session object SE contains two CoolBar objects. The first,
named (JSE . cbtop runs along the top of the Session window and contains the
toolbars. The second, named [JSE . cbbot, runs along the bottom of the Session
windows and contains the statusbars.

The menubar is implemented by a MenuBar object named [JSE .mb.

The toolbars in JSE . cbtop are implemented by four CoolBand objects,
bandtb1, bandtb2, bandtb3 and bandtbl each containing a ToolControl
named tb.

The statusbars in [JSE . cbbot are implemented by two CoolBand objects,
bandtb1 and bandtb2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (OSE .mb) contains a set of menus as follows. Note that,
unless specified, the screen-shots are taken using Unicode Edition and the
keyboard short-cuts will be different in Classic Edition.

The File Menu

The File menu (OSE.mb. file) provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents
of a typical File menu and the operations they perform are illustrated below.

Mew

Open...

Save

Save As...

Export...

Export to Memary

Close AppDomain
Drop..
Edit Text File...

Print...
Print Setup...

Continue

Exit

1 CAPrograrn Files\DyaloghDyalog APL-84 15.0 Unicodebws\buildse.dws
2 ChlUsers\Pete\Documents\Filos\useful. WS
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Table 7: File Menu Operations

Item Action Description
New [WSClear] Prompts for confirmation, then clears
the workspace
Prompts for a workspace file name,
Open [WSLoad] then loads it
Prompts for a workspace file name,
Copy [WSCopy] then copies it
Save [WSSave] Saves the active workspace
Save As [WSSaveas] Prompts for. a workspace file name,
then saves it
Creates a bound executable, an OLE
Server, an ActiveX Control, or a NET
Export [Makeexe] Assembly. See Installation &
Configuration Guide: Creating
Executables and OLE Servers.
Export to [MakeMemory .
Memory Assembly] Creates an in-memory NET Assembly
Close . .
AppDomain [CloseAppDomain] |Closes NET App Domain
Prompts for a workspace file name,
Drop [WSDrop] then erases it
Edit Text . . Displays the Open Source File dialog
File [EditTextFilel] to select a file to exit.
Print [PrintFnsInNS] Prints functions and operators in
current namespace
Print Setup |[PrintSetup] Invokes the print set-up dialog box
. . Saves the active workspace in
Continue | [Continue] CONTINUE.DWS and exits APL
Exit [Off] Exits APL
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Edit Text File

The Edit Text File menu item allows you to edit a Dyalog script file (.dyalog) or
an arbitrary text file. The system prompts you to choose the file as shown below:

® open source file

— v <« O5(C) » MiServer_Alonissos » webcam v O Search webcam 2
Organize ~ Mew folder - TH e
~
Invoices L Mame Date modified Type Si
Recordings Admin 19/04/201517:10  Filefolder
22 Dropbox Code 19/04/2015 17:10 File folder
Config 16/04/201517:10 File folder
& OneDrive Data 19/04/201517:10  File folder
I This PC Examples 9/04/201517:10 File folder
“ 3D Objecis images 017 1441 Filefolder
Deskt jbgames File folder
-_ ssKtop MiCart Filefolder
= Documents Scripts File folder
4 Downloads Styles File folder
Js Music @ index.dyalog Dyalog APL Script File
& Pictures |ﬂ timelapse.dyalog Dyalog APL Script File
@ Videos @ webcam.dyalog 18/05/2015 17:00 Dyalog APL Script File
i 05 I[C)
= HP_RECOVERY (D:)
= Transcend (K:)
s TOSHIBA EXT (L) v < b4
File name: | webcam.dyalog V‘ Dyalog source files (“.dyalag)

The file is then displayed in the Editor, allowing you to change it and save it. See
Editing Scripts and Text Files on page 149.
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The Edit Menu

The Edit menu (OSE.mb.edit) provides a means to recall previously entered
input lines for re-execution and for copying text to and from the clipboard.

Back Control+ 5hift+Back
Forward Control+Shift+Enter
Cut Control+Delete
Copy Control+Insert
Paste Shift+Insert
Find...

Replace...

Unicode Edition

Back Ctrl+Shift+Bksp
Forward Ctrl+Shift+Enter
Cut Ctrl+Delete
Copy Ctrl+c

Paste Unicode

Paste Mon-Unicode

Find...

Replace...

Classic Edition
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Table 8: Edit menu operations

Item Action Description
Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.
Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.
Cut [Delete] Cuts the selected text to the clipboard
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
Paste [Paste] the session log at the current location. The
new lines are marked and may be executed by
pressing Enter.
Paste Same as Paste, but gets the Unicode text from
. [PasteUnicode] |the clipboard and converts to JAV. Classic
Unicode .
Edition only
Paste Same as Paste, but gets the ANSI text from
Non- [PasteAnsi] the clipboard and converts to JAV. Classic
Unicode Edition only
Find [Find] Displays the Find dialog box
Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb.view) toggles the visibility of the Session Toolbar,
StatusBar, and Language Bar.

»  Toolbar
«  Statusbar

~  LanguageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars
Statusbar Shows/Hides Session statusbars
LanguageBar Shows/Hides Language Bar

The Windows Menu

This contains a single action (OSE .mb.windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

Debugger »
Editor

Table 10: Window menu operations

Item Action Description

Close all Windows |[CloseAll] [Closes all Edit and Trace windows

Note that [CloseAl L] removes all Trace windows but does nof reset the state
indicator.

In addition, the Window menu will contain options to switch the focus to any
subsidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE.mb.session) provides access to the system operations
that allow you to load a session (SE) from a session file and to save your current
session (SE) to a session file. If you use these facilities rarely, you may wish to
move them to (say) the Options menu or even dispense with them entirely.

Open...
Save

Save As...

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
[SELoad] from it, replacing the current one. Sets the File
property of JSE to the name of the file from which the
session was loaded.

Open

[SESave] Saves the current session (as defined by [JSE) to the

Save session file specified by the File property of OSE

Save Prompts for a session file name, then saves the current
As [SESaveAs] |session (as defined by [JSE) in it. Resets the File
property of (JSE.
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The Log Menu

The Log menu (OSE.mb . Log) provides access to the system operations that
manipulate Session log files.

Mew

Open...

Save

Save As..,

Print...

Table 12: Log menu operations

Item | Action Description

Prompts for confirmation, then empties the current

New | [NewLog] Session log

Prompts for a Session log file, then loads it into

Open | [OpenLog] memory, replacing the current Session log

Saves the current Session log in the current log file,

Save L ing i i
ve |[Savelog] replacing its previous contents

Save Prompts for a file name, then saves the current
[SavelLogAs] . o
As Session log in it

Print | [PrintLog] |Prints the contents of the Session log

The Action Menu

The Action menu (OSE .mb.action) may be used to perform a variety of
operations on the current object or the current line. The current object is the object
whose name contains the cursor. The current line is that line that contains the
cursor. The Edit, Copy Object, Paste Object and Print Object items operate on the
current object. For example, if the name SALES appears in the session and the
cursor is placed somewhere within it, SALES is the current object and will be
copied to the clipboard by selecting Copy object or opened up for editing by
selecting Edit.
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Edit...

Trace...

Execute

Shift+Enter

Copy Object

Paste Object

Print Object...

Clear Stops

Interrupt

Rezet

Table 13: Action menu operations

Item Action Description
Edit [Edit] Edit the current object

Executes the current line under the control of the
Trace [Trace]

Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object | LOPICOPY] | hih vard
Paste [ObjPaste] Pastes the contents of the clipboard into the
Object J current object, replacing its previous value
Print Prints the current object. Note that if the object is

. [ObjPrint] |being edited, the version of the object displayed

Object . . .

in the edit window is printed.
Clear [ClearTsM] Clegrs all JSTOP, JMONITOR and [JTRACE
Stops settings
Interrupt | [Interrupt] | Generates a weak interrupt
Reset [Reset] Performs )RESET
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The Options Menu

The Options menu (OSE .mb.options) provides configuration options.

Object Syntax

" Line Mumbers Mum -

~*  Disable traps in session

Configure..,

Colours...

Table 14: Options menu operations

i%  Expose GUIl Properties
Expose Root Properties

Expose Session Properties

Item Action Description
Expose Exposes the names of
GUI [ExposeGUI] properties, methods and
Properties events in GUI objects
Expose Exposes the names of the
Root [ExposeRoot] properties, methods and
Properties events of the Root object
Expose Exposes the names of the
Session [ExposeSession] properties, methods and
Properties events of [JSE
. Toggle the display of line
Line . . .
[LineNumbers] numbers in edit and trace
Numbers :
windows on/off
Disables the error trapping
Disable mechanism used by
traps in [DisableTrapsAtSuspension]| :Trap and OTRAP. This
session can be useful in debugging
applications.
X Displays the
Configure | [Configure] Configuration dialog box
Displays the Colours
Colours [ChooseColors] Selection dialog box
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The values associated with the Expose GUI, Expose Root and Expose Session
options reflect the values of these settings in your current workspace and are saved
in it. When you change these values through the Options menu, you are changing
them in the current workspace only.

The default values of these items are defined by the parameters default_wx,
PropertyExposeRoot and PropertyExposeSE which may be set using the Object
Syntax tab of the Configuration dialog.

The Tools Menu

The Tools menu (OSE.mb . tools) provides access to various session tools and
dialog boxes.
Explorer...
Search...
Status...
" AutoStatus

Event Viewer

Properties...

Table 15: Tools Menu Operations

Item Action Description

Explorer [Explorer] Displays the Workspace Explorer tool
Search [WSSearch] Displays the Workspace Search tool
Status [Status] Displays or hides the Status window

Toggle; if checked, causes the Status
AutoStatus | [AutoStatus] |window to be displayed when a new
message is generated for it

Event

Viewer [EventViewer] |Displays or hides the Event Viewer

Displays a property sheet for the current

Properties | [ObjProps] object
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The Threads Menu

The Threads menu (OSE.mb.threads) provides access to various session tools
and dialog boxes.

Show Threads...

~  Show Stack...
Show Token Pool...
Auto Refresh

" Pause on Error
Pause all Threads
Resume all Threads

Restart all Threads

Table 16: Threads Menu Operations

Item Action Description

Show [Threads] Displays the Threads Tool
Threads s splays the Threads Too
Show Stack |[Stack] Displays the SI Stack window
Show Token [TokenPool ] D}splays the Token Pool

Pool window

Refreshes the Threads Tool on

Auto Refresh | [ThreadsAutoRefresh] every thread switch

Pause on

[ThreadsPauseOnError] | Pauses all threads on error
Error

Pause all

Threads [ThreadsPauseAll] Pauses all threads

Resume all

Threads [ThreadsResumeAll] Resumes all threads

Restart all

Threads [ThreadsRestartAll] Restarts all threads




Chapter 1: The APL Environment 53

The Help Menu

The Help menu (OSE.mb . he L p) provides access to the help system which is
packaged as a single Microsoft HTML Help compiled help file named
help\dyalog.chm.

Documentation Centre

Read Me

Latest Enhancements
Language Help

Gui Help

Third Party Licences

Dyalog Web Site
Ernail Dyalog

About Dyalog APL
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Table 17: Help menu operations

Label Action Description
Opens your web browser on
Documentation help\index.html which displays an
Centre [DocCenter] index to the on-line PDF documentation
and selected internet links
Opens help\dyalog readme.htm
in your default web browser. Note that
Read Me [ReadMe] setup_readme.htm is also included in
this directory
Opens help\dyalog.chm, starting at
Latest the first topic in the Version 18.0
[RelNotes] Release Notes section. Note that
Enhancements . .
previous Release Notes are also included
for your convenience.
Opens help\dyalog.chm, starting at
Language Help | [LangHe lp] the first topic in the Language Reference
section
Opens help\dyalog.chm, starting at
Gui Help [GuiHelp] the first topic in the Object Reference
section
. Opens help\dyalog.chm, starting at
Thlrd Party [LicenceHelp] [the first topic in the Licences for third-
Licences
party components
Dyalog Web [DyalogWeb] Opens your web browser on the Dyalog
Site home page

Email Dyalog

[DyalogEmail]

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of Dyalog
APL you are running

About Dyalog
APL

[About]

Displays an About dialog box
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Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse
button anywhere in the Session or Editor window.

Edit

Chart Wizard
Print...
Delete
Properties
Help

Select All

Cut Shift+Delete
Copy Control+Insert
Paste Shift+Insert
Paste Unicode

Paste Mon-Unicode

Copy Object

Paste Object

Line Mumbers Mum -

Align Comments

Explorer...
Search..,
Event Yiewer...
Threads...
Status...

Colours...
Interrupt

Open link
Copy link to clipboard
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If the mouse pointer is over a visible object name, the popup menu allows you to
edit, print, delete it or view its properties. Note that the name of the pop-up menu
is specified by the Popup property of [JSE.

Table 18: Session popup menu operations

Item

Action

Description

Edit

[Edit]

Edits the current object

Chart Wizard

0OSE.Dyalog.Chart.
DoChart

Opens Chart Wizard
on current object

Print

[ObjPrint]

Prints the current
object. Note that if the
object is being edited,
the version of the
object displayed in the
edit window is printed.

Delete

[ObjDelete]

Erases the current
object

Properties

[GUIHelp]

Displays the Object
Properties dialog box
for the current object

Help

[Help]

Displays the help topic
associated with the
current object or the
APL symbol under the
cursor

Select All

[selectall]

Selects all text (Editor
only)

Cut

[Cut]

Deletes selected text

Copy

[Copy]l

Copies the selection to
the clipboard

Paste

[Paste]

Pastes the text contents
of the clipboard into
the session log at the
current location. The
new lines are marked
and may be executed
by pressing Enter.
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Item

Action

Description

Paste Unicode

[PasteUnicode]

Same as Paste, but gets
the Unicode text from
the clipboard and
converts to [JAV

Paste Non-Unicode

[PasteAnsi]

Same as Paste, but gets
the ANSI text from the
clipboard and converts
to JAV

Copies the contents of

Copy Object [ObjCopy] the current object to
the clipboard
Pastes the contents of
Paste Object [ObjPaste] the clipboard into the

current object

Line Numbers

[LineNumbers]

Toggles line numbers
on/off

Aligns Comments to

Align Comments [AlignComments] ot o
Displays the

Eplorer [Exptorer] Workspace Explorer

Search [WSSearch] Displays the Find

Objects tool

Event Viewer

[EventViewer]

Displays the Event
Viewer

Displays the Threads

Threads [Threads]
Tool
Status [Status] D¥splays the Status
window
Colours [ChooseColors] DISpla‘ys the Colour
Selection dialog
Generates a weak
Interrupt [Interrupt] interrupt
Opens the URL or link
Open link [OpenLink] using the appropriate

program. Unicode
Edition only.
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Item Action Description
Copies the URL or
Copy link to clipboard | [CopyLink] link to the Windows

Clipboard. Unicode
Edition only.

For the last two items, see Installation & Configuration Guide: Configuration

Dialog: General Tab)
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing
you to configure their order in whichever way you choose. The tool buttons appear
differently according to whether or not Native Look and Feel is enabled.

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBar [JSE . cbtop. These represent the
ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively. These images derive from three bitmap resources
contained in dyalog.exe named tb_normal, tb_hot and tb_inactive.

If Native Look and Feel is enabled all three bitmap resources are mapped to a
different set of images which are capable of reflecting the Visual Styles in use.

Native Look and Feel Enabled
Ws % Gl el W %y =

Object O] ] = /7 & [R
Tool P g7 =

Edit g1 g 9 <

Session |:’-".F'L3-E~5 Unicode vI 1642 |

Native Look and Feel Disabled
ws OO E 0 E Z

obiect B B B3 V E R
Tool Q @ - &

Edit By (A v cu

Session (= |:’-'-.P'LE-E~5 Unicode ﬂ| 16—
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Workspace (WS) Operations

a [ Executes the system operation [WSClear] which asks

Clear Workspace for confirmation, then clears the workspace

'

= Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the

Load Work
oa orkspace selected workspace

L OE Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the

C Work
opy Workspace (entire) selected workspace

H & Executes the system operation [WSSaveas] which
displays a file selection dialog box and saves the

Save Workspace X
workspace in the selected file

oy o Executes the system operation [MakeExe ] which re-
exports the workspace using the settings, parameters and
options that were previously selected using the Create
Bound File dialog

Export Workspace

& S Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace

Print Functions
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Object Operations

I
Copy Object

] B
Paste Object

= s
Print Object

B v
Edit Object
T
Edit Array
m %
SharpPlot

Executes the system operation [ObjCopy ] which
copies the contents of the current object to the clipboard

Executes the system operation [ObjPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value

Executes the system operation [ObjPrint]. Prints the
current object. Note that if the object is being edited,
the version of the object displayed in the edit window
is printed.

Executes the system operation [Edit] which edits the
current object using the standard system editor

Executes a defined function in [JSE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See Array Editor on page 37

Executes a defined function in [JSE that runs the Chart
Wizard to plot the current object using the Jchart
User Command.



Ul Guide

Tools

H @

Explorer

o

Search

= K

Line Numbers

& X

Clear all Stops

Edit Operations
ul

Copy Selection

g @

Paste Selection

2w
Recall Last

LS o
Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool

Executes the system operation [WSSearch] which
displays the Workspace Search tool

Executes the system operation [LineNumbers] which
toggles the display of line numbers in edit and trace
windows on and off

Executes the system operation [ClearTSM] which
clears all JSTOP, [IMONITOR and OTRACE settings

Executes the system operation [Copy ] which copies
the selected text to the clipboard

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point

Executes the system operation [Undo] which recalls
the previous input line from the input history stack

Executes the system operation [Redo] which recalls
the next input line from the input history stack
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Session Operations

'

=

Load Session

Boxing On/Off

APL335 Unicode

Select Font

16 =

w

Select Font Size

Executes the system operation [ SELoad] which
displays a file selection dialog box and loads the
selected Session File

Executes the user command ]box1ing to toggle
boxing on/off.

Selects the font to be used in the Session window

Selects the size of the font to be used in the Session
window



64 Ul Guide

The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a
StatusBar object. There are a number of StatusFields as illustrated below. Your own
status bar may be configured differently.

Ready... Ins NUM  Uni
CurObj: 82:1  0OpQ:0 OTRAP [OSI:0 0OI0:1 [0OML:1

Classic Edition

Ready... Ins NUM

CurObj: &:1 Opq:0 OTRAP [SI:0 QOI0:1 [OML:1

Unicode Edition

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are
summarised in the tables shown below.

Table 19: Session status fields: first row
StatusField | Style Description

Displays hints for the session objects, or "Ready..."

hint None when APL is waiting for input

insrep InsRep Displays the mode of the Insert key (Ins or Rep)

Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
defined by the Mn= string in the Input Table. Classic
Edition Only

mode KeyMode

Indicates the state of the Num Lock key. Displays

fnum NumLock |\ 150w i Num Lock is on, blank if off

Indicates the state of the Caps Lock key. Displays

caps CapsLock "Caps" if Caps Lock is on, blank if off

Displays a flashing red "Pause" message when the

ause Pause . .
p Pause key is used to halt session output
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Table 20: Session status fields: second row

StatusField | Style Description

curobj CurObj Displays the name of the current object (the name
last under the input cursor)

tc ThreadCount D1§p.lays the number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if JTRAP is set

si SI Displays the length of SI. Turns red if non-zero

o 0 Displays the value of JI0. Turns red if IO is not
equal to the value of the default_io parameter

m ML Displays the value of ML. Turns red if (ML is not
equal to the value of the default ml parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to
display the value of JI0, the state of the Insert key (Ins/Rep) and the current
keyboard mode (e.g. Apl/Uni) have callback functions attached to MouseDblClick.
This means that you can toggle the state of these fields by double-clicking with
the left mouse button.

If you dislike this behaviour, you may set the Event property of the StatusFields to
0 and re-save the Session file. Alternatively, you may modify the buildse
workspace and rebuild the Session from scratch.
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Status Window

The Status window is used to display system messages and supplementary
information. These include the operations that take place when you register an
OLEServer or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For example if you attempt to use a .NET method with incorrect argument(s) you
will get a suitable error message in the Status window, in addition to the DOMAIN
ERROR message in the Session.

Example

OUSING«'System'

bd<[JNEW DateTime (2015 4) A Typo (2015 4 30)
DOMAIN ERROR

bd<[INEW DateTime(2015 4) A Typo (2015 4 30)

A

@ Status

File Options

Void .ctor(Inté4)

Void .ctor(Inté4, System.DateTimeKind)

Yoid .ctor(Int32, Int32, Int32)

Void .ctor(Int32, Int32, Int32, System.Globalization.Calendar)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32)

VYoid .cter(Int32, Int32, Int32, Int32, Int32, Int32, System.DateTimeKind)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization.Calend
Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.DateTimeKind)
Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization
Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization

< >

Close

The Status window can be explicitly displayed or hidden using the [Status]
system operation which is associated with the Tools/Status menu item. There is
also an option to have the Status window appear automatically whenever a new
message is written to it. This option is selected using the [AutoStatus] system
operation which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the
system action [Explorer]. In a default Session, this is attached to a Menultem

in the Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the
namespace structure of your workspace using a TreeView. The right-hand window
is a ListView that displays the contents of the namespace that is selected in the
TreeView.

& C\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode\ws...

File Edit Options View Tools
HEX PZ A EEEE A
Waorkspace Tree Contents of #WDesign.PropFmt (Global Scope)
E'"'E # 1| Name Type Description ™
E'i WDesign ) Animation Function  Animation
¢ [Fns/Ops] w0 BTNS Variable  Vector: & nes
i [Vars] SIBTNSCONV  Function  BTNS—BTNS
W Bitmaps . Bitmap Function  Bitmap
mi EMED # BrowseBox Function BrowseBox
: il:;t;unrspicker - CHOICES variable  Vector: & nes
---i Events #J Calendar Function Calendar
& GridTitles ) Check Function Check
---i GWiz ) Circle Function Circle
---i ILWiz i Cambo Function  Combo
---i PropFmt i ComboEx Function  ComboEx
ol Propval #J CoolBar Function  CoolBar
+-Ml Styles #J Cursor Function Cursor
&0l TabWiz " DateTimePicker Function DateTimePic ,,
-] OSE vl< >
75 object(s). 252.8Mb free, 4097192 bytes used (0 bytes selected)

The Explorer is closely modelled on the Windows Explorer in Windows and the
facilities it provides are very similar. For Windows users, the operation of this tool
is probably self-explanatory. However, other users may find the following
discussion useful.
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Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its
contents are those that appear in the ListView. You can expand or collapse the
TreeView of the workspace structure by clicking on the mini-buttons (labelled +
and -) or by double-clicking the icons. A single click on a namespace icon opens it
and causes its contents to be displayed in the ListView. Another way to open a
namespace is to double-click its icon in the ListView. Only one namespace can be
open at a time. The icons used in the display are described below.

I] Class

i Namespace

E GUI Namespace

l] Function

I] Variable

Operator

I] Indicates an object that has been erased
sl

"35" Type Library
wha )
wHETN NET object

$
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icons view, Small Icons view, List Icons view or Details view. You
can switch between views using the View menu or the tool buttons that are
provided. In the first three views, the system displays the name of the object
together with an icon that identifies its type. In Details view, the system displays
several columns of additional information. You may resize the column widths by
dragging or double-clicking the lines in the header. To hide a column, drag its
width to the far left. The additional columns are:

This is the namespace containing the object. By definition, this
Location |is the same for all of the objects shown in the ListView and is
normally hidden.

Type Type of object.

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the

Description description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.

Size The size of the object as reported by [0SIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who last
by fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size,
timestamp or class by clicking the appropriate tool button. In Details view, you
may sort in ascending or descending order by clicking on the appropriate column
heading. The first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse
button.

You may also move and copy objects using the Edit menu. To do so, select the
object(s) and then choose Move or Copy from the Edit menu. You will be
prompted for the name of the namespace into which the objects are to be moved or
copied. Enter the namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the
original name is discarded. Unlike changing a function name in the editor, this is
not a copy operation.
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Using the Explorer as an Editor

If you open the Fns/Ops item, the names of the functions and operators in the
namespace are displayed below it alphabetically in the left (tree view) pane. When
you select one of these names, the function itself is opened in the right (list view)
pane.

[ K< rogram Files\Dyalog\Dyalog APL-64 18.0

File Edit Options View Tools
HEX PE E EEEDE YA
Workspace Tree Contents of WDesign.LX
I IGNOREKE~ | IS B2 « A & 0 HSearch... How| B na Bl K
#J INHFONT |97 LX:0OML
1 INITIDS [1] OML«0
INSCOL [2] +If 2=[INC'DESCRIBE
) INSROW E:% T :End;EESCRIBE
-] KEYPRESS
5 LAST BTN
LIST_OBJ
i LOCATE
3 LOWER
LX
1 MAKE
5 MAKE_BTN
MAKE_EXE(
o] MAKE_FMT
o] MAKE_FMT
< > Function Pos: 0/5,1
413 object(s). 252.8Mb free. 1727416 bytes used (0 bytes selected)

You may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

You may also edit the function directly in the right (list view) pane before moving
on to another.
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The File Menu

Print...
Print setup...

Delete
Rename F2

Properties Alt Enter

Close

The File menu, illustrated above, provides the following actions. All but Print
setup and Close act on the object or objects that are currently selected in the

ListView.
Print Prints the object(s). Note that if an object is open in the editor,
the version shown in the edit window is printed.
Print . . . .
setup Displays the Print Configuration dialog box.

Delete Erases the object(s).

Renames the object. This option only applies when a single

Rename L
object is selected.

Properties | Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu

Edit Enter
Copy Ctrl C
Mowe

Select >

Select Functions

Select Variables

Select Mone
Select All Ctrl A

Invert Selection

The Edit menu, illustrated above, provides the following actions. The Edit, Copy
and Move operations act on the object or objects that are currently selected in the
ListView.

Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select. Selects all of the functions and operators in the ListView.
Functions

Sele.ct Selects all of the variables in the ListView.

Variables

Select None | Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

«  Toolbar
Toolbar Captions
"  Status Bars

Expand All
Refresh Mow F5
« Auto Refresh

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.

Toolbar

Captions Displays or hides the button captions on the Explorer toolbar.

StatusBar | Displays or hides the Explorer statusbar.

Eiyl?rearies Enables/disables the exploring of Type Libraries

Expand Expands all namespaces and sub-namespaces in the TreeView,

Allp providing a complete view of the workspace structure, including
or excluding the Session object [JSE.

Refresh Redisplays the TreeView and ListView with the current structure

Now and contents of the workspace. Used if Auto Refresh is not
enabled.

Auto Specifies whether or not the Explorer immediately reflects changes

Refresh |in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-
calculator mode. This means that it is always in step with the active workspace. If
you have a large number of objects displayed in the Explorer, the update may take
a few seconds and you may wish to prevent this by un-checking this menu item If
you do so, the Explorer must be explicitly updated by selecting the Refresh Now
action.
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The View Menu

Columns s % MName

Large lcons ~ Location

Srall lcons v Type

List Icons ~  Description
® Details W Size

~  Meodified on
—— > Medified by
Arrange lcons ¥

Line up lcons

~ Auto Arrange

The View menu, illustrated above, provides the following actions.

Columns | Allows you to select which columns you wish to display.
Large Selects Large Icons view in the ListView.

Icons

Small g, ects Small Icons view in the ListView.

Icons

List Icons

Selects List Icons view in the ListView.

Arrange

Details Selects Details view in the ListView.

Allows you to choose whether the Explorer displays objects in
Scope .

local scope or in global scope.
ﬁzl;;nge Sorts the items in the ListView by name, type, size or date.
Line up Rearranges the icons into a regular grid
Icons & & gnd.
Auto If checked, the icons are automatically re-arranged when

appropriate
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The Tools Menu

Find... F3
Go to.. Ctrl G

Go to Session Space

Set Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool
Prompts for a namespace and then opens that namespace in the
Go to . . S . o
TreeView, displaying its contents in the ListView
Go to . . .
Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.
Space

Set Session | Sets the current space in the Session to be the namespace that is
Space currently open in the TreeView.
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Browsing Classes

Classes are represented by lj icons. The picture below shows 3 classes: Bird,
Parrot and DomesticParrot.

&« CADyalog18.0\Core\ws\Parrots.dws Exploring [#] — O

File Edit Optiocns VYiew Tools
MEX PE A EEEE MDA

Workspace Tree Contents of # (Global Scope)
E-a] #
M1 OSE I] @I] I]

-4 Typelibs Bird Parrot
w2 MetaData rrot

3 ohject(s). 254.5Mb free. 89008 bytes used (45664 bytes seled
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If you open the # node in the left-hand pane, you see the contents of # as a tree.

& Ch\Dyalogl8.0\Core\ws\Parrots.dws Exploring [#] — O

File Edit Optiens View Tocls
HaEX P @ EEEE YA

Workspace Tree Contents of # (Global Scope)
T DN g A
B¢ Bird €]

i-¢1) DomesticParrot Bird Parrot
- Parrot rrot

-] OSE

-4k Typelibs

H-EF MetaData

3 ohject(s). 254.5Mb free. 89008 bytes used (45664 bytes sele
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Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in
the right-hand pane.

ploring [#.Dom

File Edit Options View Tools
HEX P E EWEEEE YA AU

Workspace Tree Contents of #.DomesticParrot
@l ZE €0 8 0] sear. x v % &
11 Bird :Class DomesticParrot: Parrot
’l_j ] :Field Public name
- Parrot fo] [ )
| = v egglname species
&) ose . [1] thccess Public
£ Typelibs [2] tImplements Constructor :Base species
-2 MetaData [3] OOF Name+name
[4] L v
[o] B v eggl
[1] thccess Public
[2] :Implements Constructor :Base 'Generic’
[3] ODF Name+'Polly’
[4] L v
[0] 3] v Speak
[1] thccess Public
[2] R+[IBASE,Speak 'Who''s a pretty boy then!’
[3] L v
:EndClass A DomesticParrot
Class Pos: 0/21,0

3 ohject(s). 254.5Mb free. 82008 bytes used (43664 bytes selected)
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... and selecting Parrot in the left-hand pane brings up the Class Script for

Parrot.

Workspace Tree

BE #
3 Bird
71 DomesticParrot
]
OSE
% Typelibs
2 MetaData

ploring [#.Parrot]

File Edit Options View Tools
wEx PZ @ EEEE YA

Contents of #Parrot

3 object(s). 254.5Mb free.

== € A § 0||Search..‘ How| W & Aa Aal
:Class Parrot: Bird

[o] 5] vV egg species

[1] :Access Public Instance

[2] :Implements Constructor :Base 'Parrot: ',species

[3] ODF Name+name

[%] L v

[o] & v Speak

[1] :Access Public

[2] R+'Squark!’

[3] L v

[o] 5] v kill

[1] :Implements Destructor

[2] ‘This Parrot is dead’

[3] L v
:EndClass A Parrot

Class Pos: 0/18,0

80008 bytes used (45664 bytes selected)
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... and finally, selecting Bird in the left-hand pane brings up the Class Script for

Bird.

ploring [#.Bird]

Workspace Tree

BE #

oy

-0 DomesticParrot
-] Parrot

& OSE

2 Typelibs

w MetaData

File Edit Options View Tools
HEX P W@ EEEE YA

3 object(s). 254.5Mb free.

Contents of #Bird
ZE €08 0 ||Search‘.. na Al
:Class Bird
O :Field Public Species
[0] Vv egg spec
[1] :Access Public Instance
[2] tImplements Constructor
[3] Species~'spec’
[+] v
[0] v Speak
[1] shccess Public
[2] R+'Tweet, tweet!'
[3] v
:EndClass A Bird
Class Pos: 0/15,0
89008 bytes used (45664 bytes selected)
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If you open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and
highlighting the appropriate section of the script.

xploring [#.DomesticParrot]

File Edit Options View Tools
wEx PZ @ EEEE YA

Workspace Tree Contents of #.DomesticParrot
9"'5# == € A § 0||Search..‘ How| W & Aa Aal
#-¢1 Bird :Class DomesticParrot: Parreot
-1-f DomesticParrot O :Field Public name
. w9 [Constructors] ‘0] ( )
e = v egglname species
D\\ [Fields] [1] :Access Public
BD [Methods] [2] :Implements Constructor :Base species
: [.D [3] [ODF Name+name
-] Parrot [¥] L v
&0 OSE . [o] 5 v egg0
-4 TypeLibs [1] :Access Public
-3 MetaData [2] :Implements Constructor :Base 'Generic'
[3] [ODF Neme+'Polly’
[4] L v
o] | IR
[1] :Access Public
[2] R+[IBASE ,Speak 'Who''s a pretty boy then!'®
[3] L v
:EndClass A DomesticParrot
Class Pos: 15/21,0

3 object(s). 254.5Mb free. 80008 bytes used (45664 bytes selected)
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

« Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

o Load Type Libraries for COM objects

o Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft .NET Framework is installed, you may in addition:

o Load Metadata for specific NET classes
« Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

If the Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

# CLEAR WS Exploring [#]

File Edit Opticns View Tools
uEX CZE @ EEEE MaAU

Workspace Tree Contents of # (Global Scope)
- .l # MName Type De
-] OSE

El:!- Typelibs

: ----- 42 Loaded Libraries

. ----:} Registered Libraries
-2 MetaData

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

If you select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 16.0 Object Library is
illustrated below.

& CLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools
HEX PE @ EEEDE IAAdU

Workspace Tree Contents of Registered Libraries
----- L3 Microsoft Direct Tri » || attribute Value
""" & Microsoft Disk Quote || ¢ 5pp {00020813-0000-0000-C000-000000000046}
""" & Microsoft DTS Runtir || gijanjame Capraaram Eilas (x36)\Microsoft Office\Roat\Office 16\EXCELE
----- :!-I Microsoft Excel 16.0 Object Library. (Version:1.8,Locale:0) (x86)\Microsoft Office\Root\Office16\
""" i Mfm’“’: Fadeer\flcz HelpFile C:\Program Files (x86)\Microsoft Office\Root\Office16\VBAXL10)
..... - M F 2.0
crosott Feeds HelpiD X000
----- £ Microsoft Forms 2.0 Versi 18
) ersion .
----- % Microsoft Graph 16.0%
< > < >
0 ohject(s). 234.5Mb free. 0 bytes used (0 bytes selected)

If instead, you select the Registered Libraries folder itself, the list of Registered
Type Libraries is displayed in the list view pane

& cLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools
HEX PE A EEEE YACAY

Workspace Tree Caontents of Registered Libraries
@] # “ || Name ~
@-@] OSE Microsoft DirectX Transforms Image Transforms Type Libi
=5 Typelibs Microsoft Disk Quata 1.0

4% Loaded Libraries

E-4% Registered Libraries

I . (Version:b.0 Locale:
2. (Version:e.0,Localed

-3 0, (version:1.0.Locale ¥
< > < >

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)

Microsoft Excel 16.0 Object Library
Microsoft Fax Service Extended COM Type Library
Microsoft Feeds 2.0 Object Library

Microsoft Forms 2.0 Object Library v
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Loading a Type Library

You can load a library shown in the tree view pane by selecting Load from its
context menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 16.0 Object Library brings in the
Microsoft Office 16.0 Object Library and the Microsoft Visual Basic for
Applications Extensibility 5.3 Library too. It also contains references to a general
library called the OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the
Workspace Explorer or as a result of creating one or more OLEClient objects, you
can select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 16.0
Object Library.

& CLEAR WS Exploring [Loaded Libraries]
File Edit Options View Tools

t2 pelys:

A EEEE YU

Workspace Tree Contents of Loaded Libraries
@] OSE A || Name Load.. CLSID
=& Typelibs OLE Automation Yes  {000204
E':} Loaded Libraries Unknown Types Yes [2FCA3EB

&4 Microsoft Excel 16.0
-4 Microsoft Office 16.C
-4 Microsoft Visual Basi
w2 OLE Automation

H-4F Registered Libraries v
< > < >

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)

Microsoft Office 16.0 Object Library FD{
Microsoft Visual Bas.. Yes 10002E1
Microsoft Excel 168.0... Yes 000208

Notice that any external references to other libraries causes these to be brought in
too.

If you select a loaded Type Library, summary information is displayed in the list
view pane.

If you open a loaded Type Library, four sub-folders appear named Object
CoClasses, Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have
properties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 16.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

ﬂ CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools
HEx PZ @ EEERE AU

Workspace Tree Contents of Loaded Libraries

B:!- Loaded Libraries * 1| Mame cLsip ™

E|:!- Microsoft Excel 16.0 C || uppication 1000245

P Chart {000208

Global {00208

OLEObject {000208
| R Event Sets v || QueryTable 159191C ¥

< > < >

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)
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Opening the Application folder you can see that the Application CoClass
comprises the _Application object coupled with the AppEvents event set as shown
below.

& CLEAR WS xploring [Loaded Libraries]

File Edit Opticns View Tools
HEX PE @ EERE YA Y
Workspace Tree Contents of Loaded Libraries
..... = # -
@-@] OSE MName _Application
=& Typelibs CLSID {000208D5-0000-0000-C000-000000)
E\::!I- Loaded Libraries HelpString
El:} Micros.oft Excel 16.0 Object L HelpFile Ch\Program Files (x88)\Microsoft Off
El:.'!- Object ;oc!asses HelpiD OX00020000
=-4F Application
B4 Event Sets )
:!_ AppEvents Properties: 0
B 2 Interfaces Methods: 78
:!_ Gets: 249
a8 Chart Puts: 132
[:l"":!' Global Refs: 2
EH-4F OLEOhject
-4 QueryTable
-8 Workbook
-4 Worksheet v
< > < >
0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)

The specific methods, properties and events supported by the CoClass object can
be examined by opening the appropriate sub-folder. The same information for these
and other objects is also accessible from the Objects and Event Sets folders as
discussed below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties.
Selecting one of these causes the list of Methods or Properties to be displayed in
the list view pane. The picture below shows the Methods exposed by the Microsoft
Excel 16.0 Range object.

& cLEsR WS Exploring [Loaded Libraries]

File Edit Opticns View Tools
HEX PE EEEEE AU

Workspace Tree Contents of Loaded Libraries
E-4F Protection ~ || Name Result ~
- PublishedDoc Activate VT VARIANT
w5 pUbeShEd[_JOCS AddComment Comment
wi pUbI!ShObJ_ECt AddCommentThreaded CommentThreac
D"g PublishObjects AdvancedFilter VT_VARIANT
-1 ueries
b2 3 Tabl AllocateChanges VT_VOID

ueryTables
422 QuickAnalysis ApplyNames VT_VARIANT
&4 Range ApplyOutlineStyles VT_VARIANT
_"_:} Methods Autoclomplete VT_BSTR
@42 Properties AutoFfII VT_VARIANT

-4 Ranges AutoFilter VT_VARIANT
&2 Recentfile AutoFit VT_VARIANT
[]....:} RecentFiles AutoFormat VT_VARIANT
-4t Rectangle AutoOutline VT_VARIANT
-4+ Rectangles BorderAround VT_VARIANT
(4% RectangularGradient || Calculate VT_VARIANT

< > < >

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)
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If you open the Methods or Properties subfolder, you can display more detailed
information about individual Methods and Properties. For example, the following
picture shows information about the Saveds method exposed by the Microsoft
Excel 16.0 Worksheet object.

ploring [Loaded Libr:

File Edit Options View Tools

HEX PE @ EEEE AU
Workspace Tree Contents of Loaded Libraries

----- &% PrintOut ~

----- L3 PrintPreview Name Saveds

""" g E{ried I Help String

----- 4} Rectangles

HelplD 0x0002ac3e

..... g R“etmlpageareaks DispID 0%00000C66

----- 4 BRI

----- L% Scenarios

_____ 2 ScrollBars Result VT VOID

..... .:} Select

----- % SetBackgroundPicture A.rguments. )

_____ 2 showallData F?Iename VT_BSTR in] . .

_____ # ShowDataFarm FileFormat VT _VARIANT [Optfonal],[fn]

..... £+ Spinners Password VT_VARIANT [Optional],fin]

..... % TextBoxes WriteResPassword VT_VARIANT [Optional],[in]

..... £ Unprotect ReadOnlyRecommend... WT_VARIANT [Optional],[in]

..... £ XmiDataQuery CreateBackup VT_VARIANT [Optional],[in]

----- 2 XmiMapQuery AddToMru VT_VARIANT [Optional],fin]
-4 Properties TextCodepage VT _VARIANT [Optional],fin]
Abovefverage TextVisualLayout VT_VARIANT [Optionall,fin]
Action y Local VT_VARIANT [Optional],[in]
T > < >
0 ohject(s). 251.1Mb free. 0 bytes used (0 bytes selected)

This tells you that the Saveds method takes up to 10 parameters of which the first,
Filename, is mandatory and is of data type VT BSTR (a character string). Note that
[in] indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose

value must be one of a list of Enumerated Constants. Even without looking at the

documentation, the possible values can be deduced by browsing the Enums folder,
with the results shown below.

& cLEAR WS

loring [Loaded Libraries]

File

Edit

Options View Tools
wEX PE alEBEEEE YA
Workspace Tree

Contents of Loaded Libraries

<

----- 2 XEnableCancelkey — #
----- 4 XlEnableSelection

..... 2 XIEndStyleCap

----- 4 XIErrorBarDirection

----- £ ¥ErrorBarinclude

----- 4% XErrorBarType

----- 4 XIErrorChecks

----- % XlIFileAccess

----- i (FileFormat

----- £ XFilevalidationPivotMi
----- % XIFillwith

----- £ XFilteraction

----- 2% XFilterallDatesinPerioc
----- 4F XIFilterstatus

----- £ XIFindLoaokin

----- 4 XIFixedFormatQuality
----- 2 XFixedFormatType

----- 4 XIForecastAggregatior

----- :'.} XForecastChartType .,
>

MName

xladdin

xlC5W
xICSVMac
*CSVMSDOS
xICSVWindows
xIDBF2

xIDBF3

xIDBF4

xIDIF

xExcel2
xIExcel2FarEast
xIExcel3
xIExceld
xExcel5
xIExcel7
x|Exceld795
xlExceldWorkbook
<

Value
18
&
22
24
23
7
g
11
9
16
27
29
33
39
39
43
35

Help

0 ohject(s). 251.1Mb free.

0 bytes used (0 bytes selected)

You can therefore deduce that the following expression, executed in the namespace

associated with the currently active worksheet, will save the sheet in comma-

separated format (CSV) in a file called mysheet.csv:

or

SaveAs

SaveAs

"MYSHEET.CSV' xLCSV

'‘MYSHEET.CSV' 6
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Event Sets

The Event Sets folder contains several sub-folders each of which represents a

named set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are
displayed in the tree view pane. If you then select one of the events, its details are
displayed in the list view pane as shown below.

File

X LB

Workspace Tree

loring [Loaded Libraries]

Edit Options View Tools

W EEEE YA

Contents of Loaded Libraries

<

@] OSE
24 Typelibs
-2 Loaded Libraries

& £ Microsoft Excel 16.0 Object Library
7145 Object CoClasses

=4 Event Sets

E-4% AppEvents

-4 Events

-4 AfterCalculate

-4 NewWorkbook

-4 ProtectedViewWindow,
£ ProtectedViewWindow!

4 ProtectedViewWindowl

4 ProtectedviewWindowl

4 ProtectedViewWindow

4 ProtectedViewWindowl

4% RemoteSheetBeforeDe

-4 RemoteSheetChange

£ RemoteSheetPivotTabl

-4 RemoteWorkbookNew

-4 RemoteWorkbookNew
- g

4 SheetBeforeDelete

e . -

>

MName SheetActivate
Help string

HelplD 0x0007b10d
DisplD 0x00000619
Result VT _VOID
Arguments:

Sh VT_DISPATCH

<

fin]

0 object(s). 251.1Mb free.

0 bytes used (0 bytes selected)

This example shows that when it fires, the SheetActivate event invokes your
callback function with a single argument named S# whose datatype is VT _
DISPATCH (in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which
represents a named set of enumerated constants.

If you select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.

VS Exploring [Loaded Libraries]

File Edit
L RE |
Workspace Tree

Options  View Tools

LPE @A EEEDE YA

Contents of Loaded Libraries

€

= #

&1 OsE

4% TypelLibs

2-£% Loaded Libraries

H-4F Object CoClasses

H-4 Objects

=4 Enums

----- 4% Constants

----- % XlaboveBelow

----- 4T XlActionType

----- £ ¥lallocation

----- £ ¥lallocationMethod
----- £ ¥lallocationvalue

----- 4% XlapplyNamesOrder
----- 4% XlarabicModes
----- 4 XlarrangeStyle

E|:!- Microsoft Excel 16.0 Object Library

----- 23 x| Applicationinternational

Mame

x124HourClock
xMDigityears
xlalternateArraySeparator
xlColumnSeparator
xlCountryCode
xlCountrySetting
xlCurrencyBefore
xlCurrencyCode
xlCurrencyDigits
xlCurrencyleadingZeros
xlCurrencyMinusSign
xlCurrencyNegative
xlCurrencySpaceBefore
xlCurrencyTrailingZeros
xIDateOrder

v || xlDateSeparator
> <

Value
33

43

16
14

"

2

37
25
27
40

38

28

36

39

32

17 W

Help ~

0 object(s). 251.1Mb free.

0 bytes used (0 bytes selected)
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Browsing .NET Classes

Microsoft supplies a tool for browsing .NET Class libraries called TLDASM.EXEL,

As a convenience, the Dyalog APL Workspace Explorer has been extended to
perform a similar task as TLDASM so that you can gain access to the information
within the context of the APL environment.

The information that describes .NET classes, which is known as its Metadata, is
part of the definition of the class and is stored with it. This Metadata corresponds

to Type Information in COM, which is typically stored in a separate Type Library.

To gain information about one or more .NET Classes, open the Workspace
Explorer, right click the Metadata folder, and choose Load.

& CLEAR WS Exploring []

File Edit Opticns View Tools
MEX PE @ BEEE|MAAD
Workspace Tree

& Typelibs There is no viewable content for the selected it
ere is no viewable content for the selected tem
8o ietaData
Load
Unload
0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)

1 ILDASM.EXE can be found in the NET SDK and is distributed with Visual
Studio
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This brings up the Browse .NET Assembly dialog box as shown below. Navigate to
the .NET assembly of your choice, and click Open.

« « 4 | |» ThisPC > OS(C) > Windows > MicrosoftNET > Frameworksd > v4030313 v @] | searchvaa. o
Organize New folder =~ ™ @
Microsoft.NET A Name Date medified Type Size ~
assembly %] MicrosoftVisualBasic.dil 19/ ’ Application exten... b2 KB
[5] Microsoft.VisualC.DII Application exten.. 30KB
authman - : o
[%] Microsoft Visual C.STLCLR.dil Application exten.. 50 KB
Framework 4] Microsoft Win32 Primitives.dll Application exten... 28K8B
Frameworkb4 [] Microsoft Windows ApplicationServerAp... Application exten... 137KB
1032 5] MmeAspExt.dll Application exten.. 114 KB
V2050727 [2] mscordacwks.dll Application exten... 1,767 KB
30 [5] mscordbi.dil Application exten.. 1623 KB
5 [2] mscoreei.dll Application exten.. 673 KB
4 mscoreeis.di Application exten.. 33KB
v4.0.30319 ‘J ; peicen
[%] mscorlib.dll Application exten... 5312 KB
Managed DirectX 4] mscorpell Application exten... 101 KB
Migration 4] mscarpehost.dil Application exten... 190 KB
Minidump [2] msconcdil Application exten.. 339 KB
MedemLogs [5] mscorsecimpl.dil Application exten... 131 KB
OCR [%] mscorsn.dil Application exten.. 2 KB
% Panther 5] mscorsve.dil Application exten.. 552 KB
[#] netstandard.dil Application exten.. 104 KB
Performance )
[5] ngentasklauncher.dil Application exten.. 29 KB
pLA [2] PerfCounter.dll Application exten.. 261 KB
PolicyDefinitions Y @ neverifedl Annlicatinn svien IR KR ©
File name: | mscorlib.ll | |.NET Assemblies (*.dll) v

The .NET Classes provided with the NET Framework are typically located in
C:\WINDOWS\Microsoft.NET\Framework64\vV4.0.30319 (on a 64-bit
computer). The last named folder is the Version number.

The most commonly used classes of the .NET Namespace System are stored in this
directory in an Assembly named mscorlib.dl11, along with a number of other
fundamental .NET Namespaces.



96 Ul Guide

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.

@ CLEAR WS Exploring [I

File Edit Options View Tools
wHEX PZ @ BEERE| N
Workspace Tree

&1 OSE
:} Typelibs
2% MetaData
52 Loaded Metadata
=2 mscorlib
2 Modules
E|$ ChWindows\Microsoft. MNET\Frameworksdyw4.0.303 1% mscorlib.dll

B Narespace:
i [Unnamed]
+ Microsoft.Win3z
: MicrosoftWin32,SafeHandles
r System
: System.Collections
+ System.Collections.Concurrent
- System.Collections.Generic
: System.Collections.ChjectModel
- System.Configuration.Assemblies
- System.Deployment.internal
: System.Deployment.Internal.lsolation

[
b4 4 4 4 4 4 4 4 4 3 4

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)
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Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the NET Namespace System as shown in the picture below.

@ CLEAR W5 Exploring ]

File Edit
I I
Workspace Tree

<

ER =] Classes
I System._ComObject
: System._AppDomain

Options  View  Tools
» B

a EERE YAAY

: System.AccessViolationException

+ System.Action

: System.Action™

- System.Action’2

r System.Action’3

- System.Action’d

- System.Action’s

- System.Action’d

- System.Action’7

r System.Action’@

- System.ActivationContext

- System.Activator

r System.AggregateException

r System.AppContext

» System.appDomain

- System.AppDomain+CAPTCASearcher

- System.AppDomain+EvidenceCollection
: System.AppDomain+MamespaceResolverForintrospection
: System.appDomaininitializer

- System.appDomaininitializerinfo+teminfo
: System.AppDomainhanager

: System.AppDomainsetup

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .ctor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateTime.New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth.
There are in fact seven different ways that you can create an instance of a
DateTime.

File Edit Options View Tools
wEx P E EEEE Al
\Workspace Tree

= System.ContextBoundObject o
+ System.ContextMarshalException

+ System.ContextStaticattribute

w System.Convert

~ System.Converter2

: System.CrossAppDomainDelegate

: System.DataMisalignedException

: System.DateTime

% Base Class

(Private)Void .cctor()

(Private)Vaid .ctor(Inté4, System.DateTimeKind, Boalean)

(Private)Void .ctor(System Runtime.Serialization.Serializationinfo, System.Runtime Serialization.StreamingContext)
(Private)void .ctor(Uint64)

Void .ctor{Int32, Int32, Int32)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization.Calendar, System.DateTimeKind)
Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization.Calendar)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, System.DateTimeKind)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.DateTimekKind)

Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.Globalization.Calendar)

Void .ctor(Int32, Int32, Int32, System.Globalization.Calendar)

Void .ctor(Int64)

Void .ctor(Inté4, System.DateTimeKind) ©

U U GF 4 3 4 3 4 4 4 O O 3

0 object(s). 254.5Mb free. 0 bytes used (0 bytes selected)

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the moming on 30t April 2001):

mydt<[INEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

& cLEAR W5 Exploring []

File Edit Options View Tools
uEx PE @ BEEE|MACY
Workspace Tree

=8 System.DateTime

[+
i+ 4 4 3F 43

Base Class
Constructors
Fields
Methods

=
=
=]
=]
m
=+
m
%

: (Private)internalkind : System.Ulnta4
(Private]InternalTicks : System.Intéd
Date : System.DateTime

Day : System.Int32

DayofWeek : System.DayOfWweek
DayOfyYear : System.Int32

Hour @ System.Int32

Kind : System.DateTimeKind
Millisecond : System.Int32

Minute @ System.Int32

Month : System.Int32

Mow : System.DateTime

Second : System.Int32

Ticks : System.Int6d

TimeOfDay : System.TimeSpan
Today : System.DateTime

UtcMow : System.DateTime

Year : Systemn.Int32

£

0 object(s). 254.5Mb free, 0 bytes used (0 bytes selected)

b
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You can query a property by direct reference:

mydt.DayOfWeek
Monday

Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance of the System.DateTime object:

mydt.Now
07/11/2001 11:30:48
aTs
2001 11 7 11 30 48 O
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The Methods folder lists the methods supported by the Class. The Explorer shows

the data type of the result of the method, followed by the name of the method and

the types of its arguments. For example, the IsLeapYear method takes an
Int32 parameter (year) and returmns a Boolean result.

mydt.IsLeapYear 2000

@ cLEAR WS Exploring []

taE X P
Workspace Tree

File Edit Options View Tools

Elal EBEEEE YA

L4

CLF 3 4 OF 3 OF OF 3F 08 OF 3 OF 40 38 5 43

Boolean Equals(System.DateTime)

Boolean EqualsiSystem.DateTime, System.DateTime)
Boolean Equals(System.Object)

Boolean IsDaylightSavingTime()

Boolean op_Equality(System.DateTime, System.DateTi
Boolean op_GreaterThan(System.DateTime, System.D
Boolean op_GreaterThanOrEqual(System.DateTime, S
Boolean op_Inequality(System.DateTime, System.Cate
Boolean op_LessThan(System.DateTime, System.Date’
Boolean op_LessThanOrEqual(System.DateTime, Syst:
Boolean TryParse(System.String, System.DateTime Byl
Boolean TryParse(System.5tring, System.FormatProvi
Boolean TryParseExact(System.String, System.5tring, ¢
Boolean TryParseExact(System.5tring, System.Stringl],
Double ToOADate()

0 objectis). 254.5Mb free., 0 bytes used (0 bytes selected)
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Many of the reported objects are listed as Private, which means they are
inaccessible to users of the class — you are not able to call them or inspect their
value. For more information about classes, see Language Reference Guide: Object
Oriented Programming.

& CLEAR W5 Exploring []
File Edit Options View Toocls
WEX PZE A EEEE IACAY

Workspace Tree

(Private)Void Finalize()
s (Private)Void GetDatePart(Int32 ByRef, Int32 ByRef, Int
(Private)Void GetSystemTimeWithLeapSecondsHandli
(Private]Void System.Runtime.Serialization.|Serializabl
Boolean Equals(System.DateTime)

Boolean Equals(System.DateTime, System.DateTime)
Boolean Equals(System.Ohbject)

Boolean IsDaylightSavingTime()

Boolean IsLeapYear(int32)

Boolean op_Equality(System.DateTime, System.DateTi
Boolean op_GreaterThan(System.DateTime, System.D
Boolean op_GreaterThanOrEqual(System.DateTime, S
Boolean op_Inequality(System.DateTime, System.Date
Boolean op_LessThan(System.DateTime, System.Date’
Boolean op_LessThanOrEqual{System.DateTime, Syste
Boolean TryParse(System.String, System.DateTime Byl
Boolean TryParse(System.String, System./FormatProvi
Boolean TryParseExact{System.String, System.5tring, ¢
Boolean TryParseExact{System.5tring, System.Stringf],
Double ToOADate()

Int32 Compare(System.DateTime, System.DateTime]
< >

0 ohject(s). 254.5Mb free. 0 bytes used (0 bytes selected)

IO 4F O OO0 48 OF OF O O 0P OF O O O 4 O 4 4 O
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by
the system action [WSSearch]. In a default Session, this action is attached to a
Menultem in the Tools menu and a Button on the session toolbar.

The Find Objects tool allows you to search the active workspace for objects that
satisfy various criteria.

File Edit View Columns Search

x B B8 a4 @
Delete Props | Large Small  List  Details | Mame Size Date Type
Options
Containing Test: ‘ A ‘ Stop
Mamed: ‘ ‘ New Search
Look in: ‘ ‘ Close
Include: fatch Caze [ Madified Objects:
BUDFEEREERES Use Regular Expressions Modified by:
] Sessi
e td ateh wihole whord (®) &y date
Fird:
24/05/2018
Variables Az Symbol Reference () between
Functions and 23062018
Operators () during the previous 1 = monthls]
Mamespaces () during the previous 1 2 dayls]
Size:
[ between 0O ]

The Named field is used to search for objects with a particular name and is case-
insensitive.

Containing Text

The Containing Text field is used to search for objects that contain a particular
text string. The string search is controlled by the fields Match Case, Use Regular
Expressions, Match Whole Word and As Symbol Reference.

Match Case specifies whether or not the string search (for name and/or contents) is
case sensitive.

Use Regular Expressions specifies whether or not regular expressions are
applicable. For example, if you enter FOOx into the field labelled Containing Text
and check this box, the system will find objects that contain any text string
starting with the 3 characters FOO.
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If this box is not checked, the system will find objects that contain the 4 characters
FOOx.

Text searches are performed using PCRE. If the Use Regular Expressions box is
checked, the full range of regular expressions provided by PCRE are available for
use. See Language Reference Guide: Appendix A.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL
symbols. If so, matching text in comments and other strings is ignored.

Object Criteria

Four check boxes are provided for you to specify the types of objects you wish to
locate. For example, if you clear Variables, Operators and Namespaces, the system
will only search for functions.

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates
or time spans.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields
provided.

Location Criteria

You can restrict the search to a particular namespace by typing its name into the
field labelled Look in. You can further restrict the search by clearing the Include
sub-namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have
specified in Look in, and does not search within any sub-namespaces contained
therein. Clearing the latter causes the system to ignore SE in its search.
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When you press the Find Now button, the system searches for objects that satisfy
all of the criteria that you have specified on all 3 pages of the dialog box and
displays them in a ListView. The example below illustrates the result of searching
the workspace for all objects containing references to the symbol Speak.

File Edit View Columns Search
x B 8 a4 a4 J
Delete Props | Large Small  List Details | Mame Size Date Type
Options
Containing Text: ‘Speak V‘ Stop
Marned: ‘ ‘ New Search
Look ir: ‘ ‘ Close
Include: [Match Case [ Madified Dbjects:
] Sub- "
IR [ Use Regular Expressions Modified by:
Session namespace
i g [ Match whole Ward (@) Ay date
Find:
] 24/06/2018
Yariables [+] &5 Symbol Reference () between
Functions and 23/06/2018
Operatars () during the previous 1 2 month(s]
Mamespaces () during the previous 1 = day(s]
Size:
[ between 0 and |0 KB
Name Location Type Description 5ize Modified on Modif
1 Speak #.DomesticParrot  Function Speak 78Lb  06/05/2016 1L:53 Pete
1 speak #.Parrot Function Speak T68b  06/05/2016 1k:bb Pate
;r_D Parrot # Class Namespace 26.73Kb
m'_j DomesticParrot # Class Namespace 44 .59Kb
ml—j Speak #.Bird Function Speak 776b  06/05/2016 15:00 Pete
flBird # Class Namespace 13.59Kb
< >
6 object(s) found in Local Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in
the Workspace Explorer. You may also edit, delete and rename objects in the same
way. Furthermore, objects can be copied or moved by dragging from the ListView
in the Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search
button. This will reset all of the various controls of the dialog box to their default

values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object.
It is displayed by executing the system action [Ob jProps]. In a default Session,
this is provided in the Tools menu, the Session popup menu and from the Explorer.
An example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function,
this includes an extract from its header line, when it was last modified, and by
whom.

@l # CENTRE - Properties

Properties  Value = Monitor

l_j CENTRE

Type Function

Description TEXT—W CENTRE TEXT

Location &
Size 2.055Kb [2104 bytes]

Modified 04 Movember 1998 14:35

By Dipadic
Locked External
Shared Exported

Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it
displays its canonical representation.

@l # CENTRE - P roperties

Properties  Value  Manitor

v TEXT+W CENTRE TEXT;SPCS:;FORE;BACK & Centre TE!
[1] TEXT+({ 14pTEXT) W)tTEXT A Stretch t
[2] SPCS+TEXT=" ' A Identify
[3] FORE++/fA\5PCS A MNumber of
[4] BACK++/a\$SPCS A .
[5] TEXT+{[0.5=FORE-BACK }$TEXT A Rotate ea
v
£ >

TEAT—W CEMNTRE TEXT




108 Ul Guide

Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JMONITOR for the lines on which it is currently set. The
Set All Lines button sets JMONITOR to monitor all the lines in the function. The
Clear All Lines switches JMONITOR off.

@l #CENTRE - P roperties

Properties  Value  Monitor

Line Mumber Count CPUtime (ms)  Elapsed time (ms)
1] 5000 a7 45
1 5000 16

2 5000 ] 10
3 5000 16

4 5000 ]

5 5000 15

Reset Set &l Lines Clear All Lines
Cancel
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COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or
ActiveXControl namespace. The tab is used to define arguments and data types for
an exported Method or Property. For further information, see Interface Guide.

= #.Loan.CalcPayments - Properties

Propetties  Value Monitor  COM Properties

Faram Mame Type b odifier Optional
Result WT_RB w | WT_ARR&Y

Loandmt WT_I4 w w [l
Lerhdax WT_I4 e e ]
Lenkdin YT 14 “ w ]
[rithd 2= VT _14 w ~| [
Inthin /73] v v O

Help | | ID| |

(® Method () Prop Get () Prop Set | |

Ew=ported

Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab
is used to define arguments and data types for an exported Method or Property. For
further information, see .NET Interface Guide: .

= # APLClasses.[Primitives].IndexGen - Properties

Propetties  Value Monitor .MNET Properties

Faram Mame Type bl odifier Optional
Reszult Int32[] e e
Mumber Int32 w ~ [

(@) Method (iwieb Method () Prop Get () Prop Set ‘

Public [] 5tatic [ virtual [ Constructar
[ Protected

Cancel
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The Editor

Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the
system command ) ED or the system function [JED, specifying the names(s) of the
object(s) to be edited. You can also type the name of the object and then press
Shift+Enter (ED), click the Edit tool on the tool bar, or select Edit from the Action
menu. If you invoke the editor when the cursor is positioned on the empty input
line, with a suspended function in the state indicator, the editor is invoked on the
suspended function and the cursor is positioned on the line at which it is
suspended. This is termed naked edit. These ways of invoking the editor apply
only in the session window

@) File Edit Syntax Window Refactor View - 8 x
== € A & 0||Search... X ow| % % A2 BEal ¥

[o] {FILE}BUILD_SESSION LANG:0BJ;MSG;0IO;0OML;OLD;NEW;FN;MB;581;5B82;TB;5B;58k A
[1] f Build the =zesszion object and zave if desired

[2] :If 0=0NC'NoPrompt’' ¢ NoPrompt+0 ¢ :EndIf

[3] +If O=[NC'FILE' ¢ FILE« ¢ :EndIf

[4]

[5] OWX-0SE.OWX~1 o OML OI0-1 ¢ [OPATH='#.Trans

[&] OPW+122 m allows room for Status Bar

[7] LA upCase,LANG A translation assumes uppercase

[8] INICODE+80=[DR

[91]

[10] ( ‘Unknown language, pick one of',sTrans.CODES)OSIGNAL(Trans.CODESe~cLANp
[11]

[12] :If GUI+'Windows '=7t0I0=0WG'APLVERSION

[13] T Ose'[WS'Cooard ScaledPixel

[1%] :EndIf

[15]

[16] A Expunge MenuBar(s), StatusBar(s), ToolBar(s), TipField(s), OSE.WSDoc akw
£ >
Function Pos: 8/183,23

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the
left mouse button. Alternatively, you can press Shift+Enter or select Edit from the
File menu. The name can appear in the Session, in an Edit window, or in a Trace
window; the effect is the same. Note that, in the Session, typing a name and
pressing Shift+Enter is actually a special case of point-and-edit. Note also that a
naked edit can be invoked by double-clicking the left mouse button in the empty
input line.
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The type of a new object defaults to function/operator unless the object is
shadowed, in which case it defaults to a variable (vector of character vectors). You
can however specify the type of a new object explicitly using ) ED or JED. For
example, typing ")ED €LIST -MAT"in a CLEAR WS would create Edit
windows for a vector of character vectors named LIST and a character matrix
called MAT. See ) ED or [JED for details.

If the name is not already being edited, it is assigned a new edit window. If you
edit a name which is already being edited, the system focuses on the existing edit
window rather than opening a new one. Edit windows are displayed using the
colour combination associated with the type of the object being edited.
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Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone
window, or be docked in the Session window. Each of the objects being edited is
displayed in a separate sub-window. Individual edit windows are managed using
standard MDI facilities.

-0 X

% vl-)p «

{FILE}BUILD_SESSION LANG;OBJ;MSG;0IO0:0OML b A
A Build the session object and save if ded
:If O=[NC'NoPrompt’' ¢ NoPrompt+0 ¢ :EndI )
:If O=[NC'FILE' & FILE+'' ¢ :EndIf

Muyaco May. ramaitil OTNed a MDATW H T [
BUILD_MB_FILE S 4
SE <€A &8 0 ||Search... % Aa Bal

[ BUILD_MB_FILE LANG
Ocs Ms

Function

"file'[WC'Menu’ (LANG TranslateString'&File')

'file.clear 'OWC'Menultem’ (LANG TranslateString'&New')
'file.clear 'OWS 'Event' 'Select' "[wsclear]’

‘file.clear 'OWS'Hint' (LANG TranslateString'Clear Work)
v

>

Function Pos: 0/72,1

The first edit sub-window window is created at the position specified by the edit_
first_y and edit_first_x parameters which are specified in terms of the size of a
character in the current font relative to the top-left corner of the main Editor
window. Subsequent ones are staggered according to the values of the edit_offset
y and edit_offset_x parameters.

The initial size of an edit window is specified by the edit rows and edit_cols
parameters.

Note that the blue triangles indicate that the line of text is longer than can be
displayed in the current Edit window.
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By default, the Session has the Editor docked along the right edge of the Session
window. When you edit a function, the Editor window automatically springs into
view as illustrated below.

File Edit View Windows Session Log Action Options Tools Threads Help
ws 13 + Bl % | Object @ ) @ W T MM | Tool O IS & | Edit () 4] D | Session [ [APL38S Unicode [ 16[%]
I G LI B 008 5 B 5005 b
CE-[l=[efBle 7] [ILffr[H] [=f=[sle] ([ [=Te[Oa]¥] | [lefelelw DB [olaFlelefrle] [ &
is impertant and should not be altered) ~ll X
o
For example, to redefine the session with an Italian look try =
BUILD_SESSION 'IT*
lon Windows to make the changes permanent, you should save your session when
prompted or via the menu item Session/Save or Save as...
On all platforms (including Windews) you can can call the function SaveSession:
an empty argument uses the current value of '[SE'IWG'File’', and a non empty is
used as the file name to be written to.
Remember that it is best not to everwrite the session file in the Dyalog
instzllation directory, and that you will probably need to run with root or
administrator permisssions should you wish to do so.
lon non-Windews platforms, if you use other than the default session file
location, you should set the SESSION_FILE environment variable.
You can also reset SALT here by doing
BootSALT
Dyaleg 2019
Version 3.10
)ed BUILD_SESSION BUILD_MB_FILE 8
2
o 2
Debugger - o0x
Ready. .. Ins NUM
CurObj: BUILD_MB_FILE (Function) R:1 0DQ:0  [OTRAP  [OSI:0 OIO:1 [ML:0
File Edit Syntax Window Refactor View
ws ig + % Obhet @A E T IM T O Edit [} 4] 9 Q| Session [E] |APL385 Unicode mg
Language Bar

] - elleBlol 7] (T[] [fsl] BEEEED

~
For example, to redefine the session with a || o
1 1=
BUILD_SESSION 'IT' EE £ A 8 0]sah.
) {FILE)BUILD_SESSION LANG;0BJ;MSG:OI0:OML b A
[0n Windous to make the changes permanent, y A Build the session object and save if deb
prompted or via the menu item Session/Save :If 0=0NC'NoPrompt’' o NoPrompt+d o :EndIh
) ) :If 0=ONC'FILE' & FILE<'' o :EndIf
lon all platforms (including Windows) you ca
an empty argument uses the current value of 5] P s P o . n
used as the file name to be written to. BUILD MB FILE _ox
Remember that it is best not to overwrite t EE £ 8 8 offsean. ty eel
installation directory, and that you will p : M8 BUTLD M8 _FILE LANG B
administrator permisssions should you wish [1 Dcs Ms
lon non-Windows platforms, if you use other ] “file'IMC'Menu’ (LANG TranslateString &File’)
location, you should set the SESSION_FILE e |
“file.clear'[MC'Menultem' (LANG TranslateString'&New')
: "file.clear 'IMS'Event' 'Select' '[wsclear]'
Vou can also reset SALT here by doing i "file.clear ‘WS Hint' (LANG TranslateString'Clear Workb
BootSALT : "file.load'IMC'MenuTtem' (LANG TranslateString'&0pen..»
: | "file.load'[MS Event' 'Select' '[wsload]’
Dyalog 2019 : : "file.load'[IMS Hint' (LANG TranslateString'Load Worksph
Version 3.10 : i v
)ed BUILD_SESSION BUILD_MB_FILE N - 5
5
vl 2 Pos: 0/72,1
< > 2
Debugger
Ready. .. Ins  NUM

CurObj: BUILD_MB_FILE (Function) g:1 0pQ:0 QOTRAP [SI:0 QOIO:1 [ML:0
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You can resize the Editor pane to view more or less of the Session itself, by
dragging its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_
SESSION edit window is itself maximised within the Editor too.

® ci\program Fil a yalog APL-64 1 nic - Dyalog AP|

&) File Edit Syntax Window Refactor View - &%

ws 73 Sy Ot @l @ VT | Tool £ 5 [ & | Edit (P ) P Q| Session o [H[APL5 Unicode [ 187Z]

Language Bar X
o = O P B Y e R S R = LUJ_LLI:I AR [Tslelelele] [T [-[5]elel [OOREB][s] [o[el-[ulalz] [ &

EE £ 8 & ©[san

[0l {FILE)BUILD_SESSION LA
[t] # Build the session objec
[2] :If 0-INC'NoPrompt’ o NoPromp

[3] sIf 0=0NC'FI o FILE='' o :

sidyalogikinsok;OPATH; font;bm;UNI » A

x
=]
1

[5] OWx-DSE.OMX=3 o OML 010~ & OPATH='#.Trans

[6] OPW~122 A allows room for Status Ba

pCase,LANG A translation assumes uppercase
80=[DR

[101 (‘Unknown language, pick one of',¥Trans.CODES)OSIGNAL(Trans.CODESe~=LANG)411

[12]1 :If GUI+'Windows ' =7t[I0=0WG'APLVERSION
DOse '0MS‘Coord ScaledPixel
:EndIf

unge MenuBar(s), StatusBar(s), ToolBar(s), TipField(s), OSE.WSDoc and OSE.NumEd

Type')e'MenuBar' ‘StatusBar’ 'ToolBar' 'TipField’ 'Menu' 'CoolBar'}/08J
OSE . NumEd

[22]

[23] t 1

[24] T N=g‘t\1 *‘=I]DD MSG'OWC ‘MsgBox BUILD SESSION'w('Style Query')('Event ALLY 1)
ras1

<

Editor

Function Last saved by: adam: 18/05/2020 Pos: 4/181,51

Debugger 80 x
Ready... Ins  NUM

CurObj: BUILD_MB_FILE (Function) &:1 ObQ:0 OTRAP [OSI:0 [IO0:1 [ML:0

Note that when the Editor has the focus, the Editor menubar is displayed in place
of the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit
window is a top-level window created as a child of the Session window. This
means that normally Edit windows appear on top of the Session. However, if the
SessionOnTop parameter is set, the Session window, when given the focus, will

appear on top of Edit windows.

When the first Edit window is opened, its position is determined as follows:

« If the ClassicModeSavePosition parameter is set, the first Edit window is
displayed at the position that was previously occupied by the most recently

saved Edit window.

« Ifnot, the first edit window is created at the position specified by the edit_
first_y and edit_first x parameters which are specified in terms of the size
of a character in the current font relative to the top-left comer of the screen.

The initial size of an edit window is specified by the edit rows and edit_cols

parameters.

® EUILD SESSION

File Edit Syntax Refactor View

= = € A & ﬂ| Search... X | %W
[0] {FILE}BUILD_SESSION LANG;OBT:MSG:0I0:0OML: Mk ~
[1] B Build the session ocbject and save if desp
[2] :If O=[NC'NoPrompt® ¢ NoPrompt+0 ¢ :EndIf
[3] :If O=[ONC'FILE' & FILE=+ ¢ :EndLlf

[%]

[5] OWx-{JSE.OWx+3 ¢ OML OIC+1 ¢ [OPATH+'#.Tranp
[&] OPW+122 B allows room for Status Bar

[7] LANG+upCase,LANG A translation assumes upp
[8] UNICODE+80=[DR W
£ >
Functicn Pom ..

Subsequent ones are staggered according to the values of the edit_offset y and

edit_offset_x parameters.
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)

File Edit Syntax Refactor View

= ©

[0]| File Edit Syntax Refactor View

[1] pr=y

[2] 1= E = [ & B| Search... ®ow| B

[3]1[0] BUILD_TC LANG:X;IL:;TB:5 A

[%]1[1] A Build Toel Control

[211[2] IL+"'0SE.cbtop.il e, "'nhi

[e] 03] TB+'[se.cbtop.bandtbl. th

[7]1[%] T8 OWC'Toclcontrel'('Divider' 0)}('ShowCaph

[8]|[5] :With T8

< [lel OWS 'Imagelist'IL

Func[?] OWS('Event MouseDown OSE.cbtop.TB
[8] W
£ >
Function Pos ...

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and
the PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the
beginning of the top-line in the object and Ctrl+End moves the cursor to the end
of the last line in the object. Home (LL) and End (RL) move the cursor to the
beginning and end respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then
closes the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the
normal way, or by an attempt to re-edit the same name.

Selecting Text

You may select text in an Editor window by clicking the left or right mouse
button over any character, dragging out a highlighed area, and then releasing the
mouse button. When using the left button, moving up or down one line extends
the selection from the beginning of that line, so the selection may be ragged. The
right button selects a rectangularr box.
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Editor ToolBar
§EE(— R & o”sga'ch... ® v % % B oA Al *|{} il

In the table below, the first image shows the appearance of the toolbutton with
Native Look and Feel enabled; the second with it disabled.

Button

= [

Toggle line numbers

-
= =

[ —

Toggle tree view

Previous Location

H A

Comment selected text

o M

Uncomment selected text

0 X
Save changes and return
Search... w
Search Box
-:..l:' E}D

Search for Next Match

Description

Toggles Line numbers on/off

Toggles the treeview on/off. See
Editing Classes on page 140.

Certain operations (such as selecting
an item in the treeview) reposition
the caret in the Editor window. This
button moves the caret back to its
previous location.

Inserts a comment symbol to the left
of the selection in each of the
selected lines.

Removes the comment symbol (if
present) from the left-most column
of the selection in each of the
selected lines.

Saves changes and closes the current
edit window

Enter search text and click one of
the following two buttons

Locates the next occurrence of the
search text
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Button Description

= A Locates the previous occurrence of
Search for Previous Match the search

Determines whether or not the
Search hidden text search examines collapsed blocks
A al Specifies whether or not the search
Match case is case-sensitive

Al al Specifies whether or not the search

Match whole word matches a whole word

L Specifies whether or not the search

Use Regular Expressions uses PCRE regular expressions

" Inserts a Method template for the

Refactor text as method selected name

1) *F Inserts a Field template for the

Refactor text as field selected name

i1 *p Inserts a Property template for the

Refactor text as property selected name
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The File Menu
Fix
Fix script
Open File...
Save

Save As,.,

Always ask on close
Edit Shift+Enter

Print...
Print Setup...

Properties

Exit (and Fix) Esc
Exit (and fix script)
Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and
provides the following options.
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Item Description
Fixes the object in the workspace, but leaves the edit
Fix window open. Edit history is also preserved. If the

data has changed and the confirm_fix parameter is set,
you will be prompted to confirm.

Fix whole script

(Disabled unless editing a script)

Allows you to edit a Dyalog script file or an arbitrary

Open File text file.
Save Saves the file being edited.
Save As Renames and saves the file being edited.

Always ask on close

Toggles the value of the confirm_fix parameter.

Opens an Edit window on the name under the cursor

Edit (Disabled when there is no such name).

Print Prints the current contents of the edit window
Print Setup Displays the Print Configuration dialog box
Properties Displays the Object Properties dialog box for the

current object

Exit (and Fix)

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm exit
parameter is set, you will be prompted to confirm

Exit (and fix script)

(Disabled unless editing a script)

Exit and discard
changes

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted
to confirm.
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The File Menu (editing a script)

Fix whole script

Fix cnly functions

Open File...
Save

Save As..,

Always ask on close

Edit

Print...
Print Setup...

Properties

Shift+Enter

Exit and fix whole script Esc

Exit and fix cnly functions

Exit and discard changes

Shift+Esc

Fix whole script

Fixes the entire script

Fix only functions

Fixes only the functions in the script.

Exit and fix whole
script

Fixes the entire script, and exits the Editor.

Exit and fix only
functions

Fixes only the functions in the script and exits the
Editor.




Chapter 1: The APL Environment 123

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so
somewhere in the script would appear a line such as:-

:Field shared public List<«8

You run your application for a bit, and List, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want List to be reset back to the empty vector although you do want the new
version of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i st re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration Dialog (see Installation & Configuration Guide:
Configuration Dialog: Trace/Edit Tab) allows you to define the behaviour of the
keystrokes <EP> and <S1> for both the suspended case and the non-suspended
case. This association will be displayed against the appropriate action according to
the state of the script you are editing.
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The Edit Menu

The Edit menu provides a means to execute those commands that are concerned
with editing text. The Edit menu and the actions it provides are described below.

Reformat Murn divide
Reformat Scripts Automatically

Undo Control+5Shift+Back
Redo Control+Shift+Enter
Select All

Cut Shift+Delete
Copy Control+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode

Clear Delete

Open Line
Delete Line Control+Delete
Goto Line

Find...
Replace...

Highlight All Matches

Comment Selected Lines

Uncomment Selected Lines

Toggle Local Mame Control+Up
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Item Description
Reformats the function body in the edit window,
Reformat

indenting control structures as appropriate.

Reformat Scripts

If checked, the Editor will automatically reformat a

Automatically Dyalog script when it loads it.
Undoes the last change made to the object. Repeated
Undo use of this command sequentially undoes each change
made since the edit window was opened.
Re-applies the previous undone change. Repeated use
Redo of this command sequentially restores every undone
change.
Select All Sellects and highlights the entire contents of the Edit
window.
Copies the selected text to the clipboard and removes it
Cut .
from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the
clipboard and converts to [JAV

Paste Non-Unicode

Same as Paste, but gets the ANSI text from the
clipboard and converts to [JAV.

Clear

Deletes the selection or the character under the cursor.
Has no effect on the clipboard

Open Line

Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Prompts for a line number, then positions the cursor on

Goto Line that line.
Find Displays the Find dialog box.
Replace Displays the Replace dialog box.
If checked, all strings in the object being edited that
Highlight All match the search string are highlighted. The
Matches highlightedted items change dynamically as the search

string is entered or changed.
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Item Description

Comment selected | Adds a comment symbol to the beginning of all
lines selected lines.

Uncomment selected | Removes a comment symbol from the beginning of all
lines selected lines.

Adds or removes the name under the cursor to/from the

Toggle Local name function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.

Once displayed, each of the two dialog boxes remains on the screen until it is
either closed or replaced by the other. This is convenient if the same operations are
to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.

The Syntax Menu

Mothing
~  APL

JSON

XML

The Syntax menu illustrated above provides options to specify how the data
displayed in the Editor window is to be syntax coloured. For workspace objects,
the default is APL for functions and operators, and Nothing for variables.

Item Syntax Colour as
Nothing Variable

APL Function

JSON JSON array

XML XML array
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The Window Menu

The Window menu provides a means to control the display of the various edit
windows. The Window menu and the actions it provides are described below.

Close All Windows
Cascade

Tile Vertically

Tile Horizontally

Arrange lcons

Language Bar
Debugger H]
Editor L]
Item Description

Close All Windows

Closes all the edit windows. If Confirm on Edit
Window Closed is checked, you will be prompted to
confirm for any objects that you have changed.

Cascade

Arranges the edit windows in overlapping fashion.

Tile Vertically

Arranges the edit windows tiled one above the other.

Tile Horizontally

Arranges the edit windows tiled alongside one
another.

Arrange Icons

Arranges any minimised edit windows.

Editor

Allows you to Select the edit window corresponding
to the named object.
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The Refactor Menu

Add text as Field

Add text as Property

Add text as Method

The Refactor menu illustrated above applies only when editing a Class and
provides the following options. In each case, the user must highlight a name in the
Edit window, and then select one of these options to insert the appropriate
template for that name into the body of the Class.

Item

Description

Add text as Field

Inserts a Field template for the selected name.

Add text as Property

Inserts a Property template for the selected name.

Add text as Method

Inserts a Method template for the selected text name.
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The View Menu

Trace
~  Stop
Manitor
»"  Line Mumbers Murm -

Function Line Mumbers

Tree View

Compiler Errors

~ Outlining
Expand All Outlines
Collapse All Qutlines
Expand all Qutlines below here

The View menu, illustrated above, provides the following actions.

Item Description

Trace Displays a column to the left of the function that
displays OTRACE settings

Sto Displays a column to the left of the function that

p displays [JSTOP settings

Monitor Displays a column to the left of the function that
displays JMONITOR settings

Line Numbers Toggles the display of line numbers on/off.

Toggles the display of line numbers on individual
functions on/off. This option is only enabled when
editing a Class, Namespace script or Interface.

Function Line
Numbers

Toggles the display of the treeview in the left-hand
pane.

Tree View

If enabled, the Editor identifies which lines of code
would not compile. These are identified by a red
Compiler Errors vertical line to the left. Hovering over the red bar
gives you a pop-up telling you what the compiler
didn't like about that line of the function.
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Item

Description

Outlining

Turns outlining on and off.

Expand All Outlines

Expands all outlines.

Collapse All
Outlines

Collapses all outlines

Expand all Outlines
below here

Expands all outlines below the level of the current
line.

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each
individual function (or operator) in the Class. This option is only enabled when
you are editing a Class, Namespace script or Interface, and is disabled for all other

types of object.

Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the
number of lines in the Class) in addition to having line-numbering on each

individual function.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on
the screen with the name you have chosen displayed in the top border. The name is
also inserted in the function header and the cursor positioned to the right. The new
window is automatically given the input focus.

Line-Numbers on/off

Try changing the line numbers setting by clicking on the Line Numbers option in
the Options menu. Note that line-numbering on/off is effective for all edit
windows.

Adding Lines

If the keyboard is in Insert mode, pressing Enter at the end of a line opens you a
new blank line under the current one and positions the cursor there ready for input.
You can also open a new blank line by pressing Ctrl+Shifi+Insert (OP).

If the cursor is at the end of the last line in the function, pressing Enter adds
another line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless
the AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar
or the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to
the value of the TabStops parameter. If the AutoIndent parameter is set, new lines
are automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a
function according to your AutoFormat and TabStops settings. See Installation &
Configuration Guide: Configuration Dialog: Trace/Edit Tab.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the
keyboard and then press Delete or select Clear from the Edit menu. A quick way
to delete the current line without selecting it first is to press Ctrl+Delete (DK) or
select Delete Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard.
Then press Ctrl+Insert or select Copy from the Edit menu. This action copies the
selection to the clipboard. Now position the input cursor where you wish to make
the copy and press Shift+Insert, or select Paste from the Edit menu. You can also
use this method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard.
Then press Shift+Delete or select Cut from the Edit menu. This action copies the
selection to the clipboard and removes it. Now position the input cursor at the new
location and press Shift+Insert, or select Paste from the Edit menu. You can also
use this method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse
button. When the drag-and-drop pointer appears, drag the cursor to a new
location.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines

To join a line to the previous one: select Insert mode; position the cursor on the
first character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it
split; press Return.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of the name under the cursor. If the name is currently global, pressing Ctrl+Up
causes the name to be added to the list of locals in the function header. If the name
is already localised, pressing Ctrl+Alt+] removes it from the header.
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Matching Occurences

When you position the caret over a name, control word, or simple text or to the
right of a parenthesis, bracket, or brace, matching occurrences are identified (by a
thin box). In particular :

« matching occurrences of the word under the caret (except the actual instance
under the caret)
« matching parentheses, brackets and braces
« all control words associated with the one under the caret. For example, if the
caret is on :If, then nested :AndIf, :0OrIf, :Else and the final
:Endif are identified.

Aligning Comments

When you press the <AC> key, or select Align Comments in the Editor's context
menu, the alignment of the comments in every line in the function will be changed
so that the left-most comment (Lamp) symbol is in the same column as the cursor,
except that:

« Comment symbols that are preceded only by white space, i.e. comments in
lines that contain no code, are ignored and are not adjusted in any way.

« Comment symbols that lie between the first column and the first tab stop
will remain in or be moved to the first column. For information on setting
tab stops, see Installation & Configuration Guide: Configuration Dialog
(Edit/Trace Tab).

o Comment symbols will not move further left than the end of the statement.

When a comment is re-aligned, text to the right of the left-most comment symbol
(including spaces and other comment symbols) will remain fixed in relation to that
symbol.

Note that there is no keystroke associated with this command by default; the user
must define one. See Installation & Configuration Guide: Configuration Dialog
(Keyboard Shortcuts Tab).
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Stop, Trace and Monitor Controls

If any of the Stop, Trace, and Monitor options of the View menu are set, the Editor
displays an area to the left of the function body containing up to 3 columns. If a
function line is enabled by OTRACE,[JSTOP or DMONITOR the corresponding
column displays a yellow circle (trace), red circle (stop) or clock symbol (monitor).

E Editor - [foo]

@) File Edit Syntax Window Refactor View - & %
== €« [0 & 9 HSearch... P v|'>p € fa  Bal Kk
[0l i foo

[1] (} imA OTRACE is set on this line

2] & o] OSTOP is set on this line
[3]1: @ |~ OMONITOR is set on this line
[4] 0w [A ALL 3 are set on this line

Mew Modified Function Pos: 2/5,1

When you move the mouse-pointer over this area, the pointer displays the
appropriate symbol and you can toggle the corresponding setting on and off by
clicking the mouse.

White Space in Source Code

Settings that impact the automatic reformatting of code can cause changes to
whitespace — this can be interpreted as changes to the source code. This means
that:

« opening a scripted object in the Edit window can cause the source of that
object to change (when closing an Edit window, you might be prompted to
save a function even though you have not made any changes to it).

« viewing an object can change its file timestamp; source code management
systems can subsequently report changes due to the changed file timestamp.

« source code changes resulting from reformatting will be evident in the
results of system functions such as JAT, OSRC, OCR, OOVR and [NR.
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Outlining

When you are editing a function, outlining identifies the blocks of code within
control structures, and allows you to collapse and expand these blocks so that you
can focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_
POPUP.

Jed OSE.cbtop.TB_POPUP

& Editor - [OSE.cbtop.TB8_POPUP]

[ed File Edit Syntax Window Refactor View - 8 x
EE €0 8 0 ||Search... X ov| % % ha  Bal Kk
[0] | {FLAG)}TB_POPUP| M5G;TC

[1] E A Popup menu on Session ToolControl

[2] @ :If 0=0ONC'FLAG’

[3] g :If (2=5=M5G) A Right mouse button ?

[4] 'popup.captions 'OWS'Checked'

[5] ‘popup. list'[OWS 'Checked’'{'FlatList’'s=s )

[&] "popup.multiline'[OWS'Checked’

[7] 00Q ' popup’

sl | tEnd

[9] :Else

[10] TC+'bandtbl.tb’' ‘bandtb2.tb' 'bandtbd.tb’' ‘bandtb4.tb’' p
[11] @ :Select FLAG

[12] :Case 1

[13] -~

[14] TC OWS"<"ShowCaptions'

[15] :Case 2

[16] ~(1+'FlatList'=s )="FlatlList' 'FlatButtons p
[17] TC OWS"="Style’

[18] :Case 3

[19] N

[20] TC OWS"e'Multiline’

[21]

[2z2] | :End

[23] | :End

< >
Function Pos: 0/24,15
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Notice that the various control structure blocks are delineated by a treeview

diagram.

« When you hover the mouse pointer over one of the boxes that mark the start
of a block, the line marking the extent of that block becomes highlighted, as
shown above.

« Ifyou click on a [=l box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

o Ifyou click on a It box, the corresponding section is expanded.

%) File Edit Syntax Window Refactor View - & %
= e [0 &8 O HSearch... ¥ v % % A2 Fal gk
[0] | {FLAG}TB_POPUP| M5G;TC

[1] A Popup menu on Session ToolControl

[2] :If 0=[NC'FLAG

[3] :If (2=5=M5G) B Right mouse button 7|

[9] :Else

[10] TC+'bandtbl.tb bandtb2.tb bandtb3.tb bandtbk.th' »
[11] = :Select FLAG

[12] :Case 1

[13] -~

[14] TC OWS"c'ShowCaptions

[15] :Case 2

[16] +{1+'FlatList's y="FlatList FlatButtons »
[17] TC OWS"='Style

[18] :Case 3

[19] 4

[20] TC OWS"e'Multiline

[21]

[221 | tEnd

[23] [ :End

€ >
Function Pos: 0/24,15
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into
Sections with :Section and :EndSection statements. Both statements may be
followed by an optional and arbitrary name or description. The purpose is to split
the function up into sections that you can open and close in the Editor, thereby
aiding readability and code management. Sections have no effect on the execution
of the code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmap and CopyToClipBoard.

The first picture shows the function with all sections closed.

@ Editor - [DumpWindow]
<) File Edit Syntax Window Refactor View - 8 %

=i « QA 4 ﬂ| Search... ® v % % Aa Ral

[0] DumpWindow ref;0I0;0ML

[1] :5ection Comments

[6] @ :Section Init

[10] @ :Section NAs

[25] :5ection MakeBitmap

[37] :Section CopyToClipBoard

< >

Function Pos: 07441
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The next picture shows the effect of opening the Comments section. Notice how
this is delineated by the statements:

:Section Comments

:EndSection Comments

ﬁl Editor - [DumpWindow]

&) File Edit Syntax Window Refactor View - & X
== € A & ﬂ| Search... Wow| %W ta Fal e
[0] DumpWindow ref;[I0;0ML

[1] :Section Comments

[2] A eg DumpWindow f A note unguoted name

[3] A Note only the visible part of the window is dumped

[4] A you may need to set "OnTop’ to ensure total window vwisib)
[5] :EndSection

[6] @ :Section Init

[10] @ :Section MNAs

[25] @ :Section MakeBitmap

[37] @ :Section CopyToClipBoard

£ >
Function Pos: 0/44.1

And with the Init section opened too:

ﬁ-_"l Editor - [DumpWindow]

&) File Edit Syntax Window Refactor View - 8 X
= E € A & ﬂ| Search... ®ow| W fa  Bal K
[0] DumpWindow ref;0I0;0ML

[1] :Section Comments

[2] A eg DumpWindow f A note unguoted name

[3] A Note only the visible part of the window is dumped

[+] A you may need to set "OnTop’ to ensure total window visibh
[5] :EndSecticon

[&] :Section Init

[7] OML OI0+0

[&8] OSHADOWt (="' ref ' )~=" "~Z"40OREFS=0SI

[9] :EndSection

[10] @ :Section NAs

[25] @ :Section MakeBitmap

[37] @ :Section CopyToClipBoard

€ >
Function Pos: 0/441
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Finally, with all the sections opened:

S Editor - [Dum pWindow]

[ed File Edit Syntax Window Refactor View - 8 x
EE €[ & 9 HSearch... X v % ha Bal *
[0] DumpWindow ref;[I0;0ML

[1] :Section Comments

[2] g A eg DumpWindow f A note unguoted name

[3] A Note only the visible part of the window is dumped

[4] | A you may need to set 'OnTop’ to ensure total window visibp
[5] L :EndSection

[6] @ :5ection Init

[7] OML OI10+0

[8] OSHADOWt (='ref ' })~=" '~Z"40OREFS=[SI

[9] L :EndSection

[10] @ :Section NAs

[11] ONA'P  user32|GetWindowDC P 3
[12] ONA'U% user32|GetWindowRect Poo={U% U% Uy Uk} 3
[13] ONA'U% user3?|ReleaseDC PP 3
[1%] ONA'U% user3?|0OpenClipboard 2] 3
[15] ONA'U% user32|EmptyClipboard 3
[16] ONA'P  user32|SetClipboardData Uy P 3
[17] ONA'U% user3?|CloseClipboard [3
[18] ONs'P gdid2|CreateCompatibleDC P 3
[19] ONs'P gdid2|CreateCompatibleBitmap P U4 U4 3
[20] ONA'P gdid2|SelectObject PP 3
[21] [ONA'Us gdi32|DeleteDC P »
[22] ONA'Us gdi32|Deletelbject =] 3
[23] ONA'Us gdi32|BitBLE PoUs Ut Us Us P Us Uk p
[24] | :EndSection

[25] @ :5ection MakeBitmap

[26] hwnd+ref .ONG'Handle'

[27] hdc+GetWindowDC hwnd

[28] sze+—— /82 2pl=GetWindowRect hwnd(4pl)

[29] mdc+CreateCompatibleDC hdc

[30] hbm~CreateCompatibleBitmap hdc,sze

[31] old+~SelectObject mdc hbm

[32] jnk+BitBlt mde 0O O,sze,hdc O 0 13369676 a SRCCPY

[33] jnk+SelectObject mde old

[34%] jnk+-ReleaseDC hdec O

[35] jnk+-DeleteDC mdc

[36] | :EndSection

[37] @ :5ection CopyToClipBoard

[38] jnk+0OpenClipboard 0

[39] jnk+EmptyClipboard

[40] jnk+SetClipboardData 2 hbm & 2 = CF_BITMAP

[41] jnk+CloseClipboard

[s2] jnk+DeleteObject hbm

[43] :EndSection

£ >
Function Pos: 07441
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Editing Classes

The picture below shows the result of opening the ComponentF i Le class. Notice
how each function is delineated separately and that each function is individually
line-numbered.

)ed ComponentFile

B Editor - [ComponentFile]

[e) File Edit Syntax Window Refactor View - 8 X
EE £ A & s X% %@ om x| 00 U
-4 #.ComponentFile :Class ComponentFile ~
D\\ [Constructars] I} :F'_IELd Pr'_lvate Fnstance tie i
) I} :Field Private instance temp+0 A Temporary F p
[Fields]
[Methods] Oie+1 & Oml+1
[Properties]
[o] 5] v Open filename
[1] A Open Named File
[2] :Implements Constructor
[31] :Access Public Instance
[4]
[5] 5] :Trap O
[&] tie+filename OFSTIE O
[7] :Elsze
[8] OFUNTIE filename OFCREATE O A Create =2 p
[9] tie+filename OFSTIE O A Then sha b
[10] L :EndTrap
[11] L v
[0] = v OpenTemp;OUSING;:
[1] A Default: Open temporary file
[2] :Implements Constructer
[3] :hccess Public Instance
[%]
[5] OUSING+""
[e] z+5ystem.I0.Path.GetTempFileName
[7] z [ONERASE z [NTIE O A Erase the temp file #
[8] tie+z OFCREATE O
[9] temp+1
[10] L v
[0] 7 Close
[1] :Implements Destructor
[2] :If tiee[FNUMS
[3] :If temp © Name [FERASE tie
[4] iElse ¢ OFUNTIE tie
[5] tEndIf
[&] EndIf
[7] v
"
L4 >

Class Pos: 0/113,0
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The outlining feature really comes into its own when editing classes because you
can collapse and expand whole functions. The picture below shows the effect of
collapsing all but the Append method.

EI Editor - [ComponentFile]
&) File Edit Syntax Window Refactor View - 8 X%
EE €A & 0 sear. x V% e B mom a0 U

E-¢ #.ComponentFile :Class ComponentFile
: :Field Private Instance tie
:Field Private instance temp+0 A Temporary F

[Constructors) o
[Fields] B
[Methods] Oio+1 ¢ Oml=1
i [Properties]

o] v Open filename
o] v OpenTemp;[USING;z

Close

o]
<

A --- Instance Methods --—-

[o]
[1]
[2]
[3]

r~Append data
tAccess Public Instance
r+datz OFAPPEND tie

v Rename name

B ©H —3
< <

v Replace(comp data)

A --- Instance Properties ---
:Property Name

:Property Count

:Property Access

H B B ©

:Property Numbered Components
A —-- Shared Members
= v Delete file;tie

:EndClass R Class ComponentFile

Class Pos: 0/113,0
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When you edit a class, a separate treeview is optionally displayed in the left pane
to make it easy to navigate within the class. When you click on a name in the
treeview, the editor automatically scrolls the appropriate section into view (if
necessary) and positions the edit cursor at its start. The picture below illustrates the
result of opening the [Methods] section and then clicking on Rename.

EI Editor - [ComponentFile]

&) File Edit Syntax Window Refactor View - 8 X
EE €A & 0 sern. x V% & B aom X0 U
= #.ComponentFile | [[0] v Close =
@ [1] :Implements Destructor
[ Construct
E1[ 9nsru ors] [2] :If tieelFNUMS
WL [Felds] [31 E iIf temp o Name [FERASE tie
Bﬂj [Methods] [4] iElse ¢ OFUNTIE tie
s] | :EndIf
6] | :EndIf
[71 L v
A --- Instance Methods --—-

&9 [Properties] [l o v reAppend data

[1] iAhccess Public Instance
[2] r+data OFAPPEND tie
[3] L v
ORI Renene nend
[1] tAccess Public Instance
[21 name [FRENAME tie
[3] L v
[o] 5] v Replace(comp data)
[1] ihccess Public Instance
[21] data OFREPLACE tie,comp
[31 L v

F --- Instance Properties ---

:Property Name
tAccess Public Instance

[0] v r+get
[1] +If tieeFNUMS o r+[OFNAMES[OFNUMSttie; »
[2] iElse ¢ r+'" & :EndIf
[3] v
:EndProperty

:Property Count
tAccess Public Instance

[0] v r+Get
ri ~"129=MFSTTF tie A
< >

Class Pos: 47/113,0
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Sections within Scripts

Scripts can also be subdivided into Sections using :Section and :EndSection
statements. As with single functions, the purpose is only to split the script up into
sections that you can open and close in the Editor. Sections have no effect on the

execution of the code.

The following picture illustrates a Class named actuarial which, for editing
purposes, has been sub-divided into five separate Sections named Main,
MenuHandlers, Validation, Utilities and OldCode. In this picture, all

the Sections are closed.

‘@ Editor - [actuarial]

%) File Edit Syntax Window Refactor View - & %
EE €A & 0 searcn. x V| % % @ oA om #0001
B4 #.actuarial :Class actuarial: Page
: . :Using System
=-[§ [Sections g oy
D- [. . ! :Using System.Web.UIL,system.web.dll
- & Main tUsing System.Web.UI.HtmlControls
MenuHandlg :Using System.Web.UI.WebControls
oldcade :Using System.Data,system.data.dll
Utilities tAccess plebL1C )
. o = :S5ection Main
- 3 Validation = :Section MenuHandlers
= :Section Yalidation
= tS5ection Utilities
= :Section OldCode
:EndClass
£ > £ >
Class Pos: 0/1498,0
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The next picture shows the effect of opening just the Main section.

E] Editar - [actuarial]

le) File Edit Syntax Window Refactor View - & %
EE £ A & 0sern. Xv]% 9B 8@ a0 U
=~ #actuarial :Class actuarial: Page
=9 [Sections] =Us‘_|ng System )
L . tUsing System.Web.UI,system.web.dll
EI Main :Using System.Web.UI.HtmlControls
E‘D\\ [Methods] tUsing System.Web.UI.WebControls
i ) CALC_FSL_RESULTS :Using System.Data,system.data.dll

:hccess Public

3 CALC_FSLTAB_RESULTS

: B :Section Main
] Page Load 0 v Page_Load; INT;AGE;DUR; TERM; TA b
#- & MenuHandlers ] v CALC_FSLTAB_RESULTS(o by s
-1 oldCode o| v CALC_FSL_RESULTS(obj e Hp
:EndSection
-3 Utilities
. L O] :S5ection MenuHandlers
- 3 Validation = :Section Validation
= :Section Utilities
= :S5ection OldCode
tEndClass
< >
Class Pos: 0/1493,0

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main
In this picture the 3 functions within the Main section are temporarily closed.
Similarly, the section called Validation is delimited by:

:Section Validation

:EndSection Validation
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| Editor - [actuarial]

&) File Edit Syntax Window Refactor View - 8 X
= E € A 4 0||Search... ®ow| % & aa Aal & | 3r 1) 11
-4 #.actuarial iClass actuarial: Page A
Loem - :Using System
BD [:Sectlo.ns] tUsing System.Web.UI,system.web.dll
E‘ Main tUsing System.Web.UIL.HtmlControls
-3 [Methods] :Using System.Web.UI.WebControls
73 CALC_FSL_RESULTS :Using System.Data,system.data.dll
) CALC_FSLTAB_RESULTS thecess Public
o :S5ection Main
r-'D Page_Load ] v Page_Load;:INT;AGE;DUR;TERM;TA )
- 3 MenuHandlers ol v CALC_FSLTAB_RESULTS(obj ev)zXp
&~ * OldCode [ v CALC_FSL_RESULTS(cbj ev):;X;CHp
:EndSection
- Ut
. I_I Ies_ = :Section MenuHandlers
: Validation :Section Yalidation
=-[ [Methods] E
..... ) VALIDATE_AGE [0] - vV VALIDATE_AGE(source args) a Vp
..... M VALIDATE DUR [1] tAccess Public
H - [z] :Signature VALIDATE_AGE Objech
----- #) VALIDATE_DUR1 [3] g :Trap 0
""" ] VALIDATE_INT [4] AGE+Convert.ToInt32 zrgs. »
----- ) VALIDATE_INTY [5] :Else o
----- 2 VALIDATE_INT2 E?% E';'i'i--”f d=0
:Return
----- #3 VALIDATE_INTY [8] EndTrap
----- '] VALIDATE_MPC1 [9] I args.IsValid+(10<AGE)AB02AGE
----- #J VALIDATE_TERM [10] L v
----- 3 VALIDATE_TERM1 z 2 ¥
Class Pos: 0/1493,0
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Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

Find / Replace
Search For: oo | Find Mext |
Feplace Wwith: oo Feplace
Feplace All
[ ]tatch Caze [] tatch whole 'ward
[ ] Use Regular Expressions “Wrap Search IIndo
Mowe Dialog if Hiding M atch Find Mext &fter Replace q
nze
Direction
i Up (®) Down
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Search For

Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
down list. If appropriate, the search text is copied from the
Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the same string in the functions.

Replace With

Enter the text string that you want to use as a replacement.
Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case

Check this box if you want the search to be case-sensitive.

Match Whole
Word

Check this box if you want the search to only match only
whole words.

Use Regular
Expressions

Check this box if you want to use Regular Expressions.

Move Dialog if
Hiding Match

If checked, the Find or Find/Replace dialog box will
automatically position itself so as not to obscure a matched
search string in the edit window.

Find Next After
Replace

If checked, following a replace operation, the selection will
move to the next occurrence of the target string in the edit
window.

Direction

Select Up or Down to control the direction of search.

147
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position
the cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu.
The Find Dialog box will appear on your screen with the input cursor positioned
in the edit box awaiting your input. Type "Adam" and click the Find Next button
(or press Return), and the cursor will locate the first occurrence. Clicking Find Next
again will locate the second occurrence. You can change the direction of the
search by selecting Up instead of Down. You could search another function for
"Adam" by opening a new Edit window for it and clicking Find Next. You do not
have to redefine the search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find
Dialog box to be replaced by the Find/Replace Dialog box. Enter the string
"Amanda" into the box labelled Replace With, then click Replace All. All
occurrences of "Adam" in the current Edit window are changed to "Amanda". To
repeat the same global change in another function, simply open an edit window
and click Replace All again. If instead you only want to change particular
instances of "Adam" to "Amanda" you may use Find Next to locate the ones you
want, and then Replace to make each individual alteration.

Text searches are performed using PCRE. If the Use Regular Expressions box is
checked, the full range of regular expressions provided by PCRE are available for
use. See Language Reference Guide: Appendix A.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the
File menu. The new version of the function replaces the previous one (if any) and
the edit window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the
history is also retained, so you can subsequently undo some changes and fix the
function again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if
any) is unchanged.
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Editing Scripts and Text Files

The Editor may also be used to edit Dyalog script files (. dyalog files) and
general text files.

There are two ways to choose the file to be edited. If the file exists, you can select
it from the Open source file dialog by clicking File/Edit Text File from the Session
menu bar.

Alternatively, type ) ED followed by the pathname to the file. To identify the name
given as a file, it must either contain a slash character ("\" or "/") or be preceded by
one.

Examples
JED c:\myfiles\myscript.dyalog
JED c:\myfiles\pete.txt
JED \x.txt A x.txt in current directory
Jed / x.txt a ditto

If the named file does not exist, you will be asked whether or not you want to
create it:

Dyalog APL/W-64

| The file "\w.ixt" does not exist

Do you want to create it?

[] Do not ask this question again - Yes Mo

If you edit a Dyalog script file, the editor will treat it as such and provide the same
formatting and syntax colouring as if it were a script in the workspace.

Otherwise, the file will be edited as if it were a character vector with embedded
new-lines.

When you exit the editor with Exit and fix, you will be offered a number of
alternatives depending upon the type of file, as shown below.
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Dyalog APL/W-64 Overwrite file

o Save file content

' —> Save as text in the workspace :
: Create text variable in the workspace, and update the file

—> Only save file to disk

This won't affect the contents of the workspace

—> Discard changes

[] Save this respense for all files with a " tct" Cancel
extension

Saving a Text file.

Note that if you choose Save as text in the workspace, information about the file
and the text variable associated with it is retained in the workspace. This
information may be obtained using 51761I and 5177I. See Language Reference
Guide: List Loaded Files and List Loaded File Objects.
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Dyalog APL/W-64 Overwrite file

o Save file content

' —> Fix as code in the workspace
Create objects in the workspace, and update the file

—> Save as text in the workspace
Create text variable in the werkspace, and update the file

—> Only save file to disk

This won't affect the contents of the workspace

— Discard changes

[] Save this response for all files with a ".dyalog" Cancel
extension

Saving a Script file.

Note that if you choose Fix as code in the workspace or Save as text in the
workspace, information about the file and the text variable associated with it is
retained in the workspace. This information may be obtained using 5176I and
51771. See Language Reference Guide: List Loaded Files and List Loaded File
Objects.
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Fix as code in the workspace

If you choose this option, the file will be updated and the script will also be fixed
in the workspace. Note that if the script refers to a base class or other external
elements, it cannot be fixed unless these elements are also present in the
workspace.

Save as text in the workspace

If you choose this option, the file will be updated and the contents of the file will
also be saved to a variable in the workspace. First you will see the following
warning dialog, which may be disabled subsequently by checking Do not ask this
question again.

Dyalog APL/W-64 Overwrite file

| Saving as text will not update the file on
" subsequent edits of the variable

[] Do not show this message again Cancel

Then you will be prompted to supply its name, which may be a new name or the
name of an existing variable:

Save in Workspace

Mame of vaniable to save az

Cancel

Only save file to disk

If you choose this option, the file will be updated but nothing will be changed in
the workspace.

Discard changes

If you choose this option, all changes will be discarded and nothing saved.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an
application line by line. During a Trace you can track the path taken through your
code, display variables in edit windows and watch them change, skip forwards and
backwards in a function. You can cutback the stack to a calling function and use
the Session and Editor to experiment with and correct your code. The Tracer may
be invoked in several ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace an expression that executes one or more defined
functions or operators by typing the expression then pressing Ctrl+Enter (TC) or by
selecting Trace from the Action menu. This lets you step through the execution of
an expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression
is (if necessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator,
execution halts at its first line and a Trace window containing the suspended
function or operator is displayed on the screen. The cursor is positioned to the left
of the first line which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in

the state indicator and you press Ctrl+Enter (TC) on the empty input line. This is
termed naked trace. The same thing can be achieved by selecting Trace from the
Action menu on the Session Window.

The effect of naked trace is to open the Tracer and to position the cursor on the
currently suspended line. It is exactly as if you had traced to that point from the
Input Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for
you whenever an error occurs. This is achieved by setting the Show trace stack on
error option in the Trace/Edit tab of the Configuration dialog (Trace_on_error
parameter). When an error occurs, the system will automatically deploy the Tracer.
Note that this means that when an error occurs, the Trace window will then receive
the input focus and not the Session window.
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Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session
window.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of
separate windows (one per function on the calling stack) or as a single, but still
separate, window.

You can disable the standard behaviour by selecting Classic Dyalog mode from
the Trace/Edit tab of the Configuration dialog box.

If you do so, you may then choose to have the Tracer operate in multiple windows
or in a single window.

These alternatives are discussed later in this Chapter.

The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current
function calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the
Session window. When you invoke the Tracer, it springs up as illustrated below. In
this example, the function being traced is [JSE . UCMD, which is invoked by typing
a user-command, in this case Jdisplay.

@ CLEAR WS (OSE)- Dyalog APL/

Teols  View

wsig BT [ @ BV BM el O G IZ 8 (MR A DT Suon

Language Bar X | X

(-] B leBle[ 2] (T[] [ell<Plll#) (AR-l=lnfafe] [sLlelelv[-] L slelel=ls] [+ DOGERL]] [ole-lelslvlae | T
~

Dyalog APL/W-6% Version 18.0.38293
Serial number: 000042 - pre-release software
Tue May 26 12:4%4%:35 2020
Idisplay i3
v
Debugger —oOx
Al e T 00MmOoONnN S ﬁHSE‘V‘h X v % % 4| X |UCMD[1]*a User Command Processor.
[0} r+{THIS}UCMD Input;dcl;in; Lbsur;notQ;cmd;BS A B
[11 [p User Command Processor. The result may be assigned to a global variable. !
[2] A Most of the implementation is in [SE.SALTUtils.Spice; this function enly »
[3] R "assignment syntax", i.e. ]varname+ucmd and 10+-ucmd
[4]
[5]1 r+~€18 A default to "no" result =)
[6] =
[71 rlb={(+/a\" '=w)éu} 5
[8] =
rol in+rlb Input MIE .
< > 3 2
4 o
Function Pos: 1/49,0 o >|[ @
Ready... Ins NUM
Cur0bj: &:1 0bQ:0 OTRAP [SI:i [OIO:1 [OML:1

In the default layout, the Sistack window is displayed alongside the main Tracer
window, although this can be hidden or made to appear as a separate floating
window, as required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools
which are arranged along the title bar of the Debugger window. Note that the
button names are solely for reference purposes in the description that follows.

Button
—
v
=

.

pa

44

44

i

X

Name

Exec

Trace

Back

Fwd

Continue

Restart

Restart all

Edit

Exit

Intr

Key o

Code Keystroke Description

ER Enter Execute expression
TC Ctrl+Enter Trace expression

BK Ctrl+Shift+Bksp Go back one line

FD Ctrl+Shift+Enter Skip current line

BH Stop on next line of calling
function

RM ~{LC Continue execution of this
thread

Continue execution of all

threads
ED Shift+Enter Edit name
EP Esc Quit this function
Ctrl+Pause Interrupt
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Button Name Iézfle Keystroke Description

a ﬂ Reset CB tChlie;acr) l‘;‘izf/ stop/monitor for
= [ LN Toggle line numbers

* Search for next match

o Search for previous match
Search hidden text

Aa  ah Match case

Aal ahl Match whole word

S Use Regular Expressions

Using the Trace Tools, you can single-step through the function or operator by
clicking the Exec and/or Trace buttons. If you click Exec the current line of the
function or operator is executed and the system halts at the next line. If you click
Trace, the current line is executed but any defined functions or operators referenced
on that line are themselves traced. After execution of the line the system again
halts at the next one. Using the keyboard, the same effect can be achieved by
pressing Enter or Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 16 times
to reach [JSE.UCMD[17].
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Tools  View
ws g VM r &) | Object @ o @D T Tool £ 5 IS 8 | Edit [ 51 D Q| Session o [ [WEEGEER | 16
Language Bar X | %
s = = 7] =[=[<] ] - BEERABEE n = |0
L[ eBle[te] [T [fl<PlER [t[[=Pl[0a]s] [+o]e]<]+[[] [-[<[eelefs] [TTT-[-[é[ele] MOBEB[][s] [o[al-lulalofe] | =
Dyalog APL/W-64 Version 18.0.38293 ~
Serial number: 000042 - pre-release software
Tue May 26 12:11:27 2020
ldisplay 113
v
Debugger =
st e T 00MON S EE _Q:HSear(h.. x v % | % | UCMD[35]*ur=(dcl,“decl<notQ=pnma )]
[28] notQ« 'O+ #nma+(~" 'enma)/nma+(®v\$<\{ '+ =in)>v\ine' " "' }/in A B
[29] dol+'+ " e4plISTACK A vere we at Desk Calculator » 0
[30] :If notQa{i<pnma)>0 2 9e“THIS.ONC ~14nma A is the assignment legal?
[31] ur~'s assignment syntax error' ¢ ur [SIGNAL dcl42 o [Oeur o =
[32] +EndIf
[33] =(pin=(pnma)tin) 40 A Jv+ is the same as ]
[3%]
[35] ur=(dcl,dclsnot@=pnma)ISE.SALTUt ls.Spice in
[36] OSIGNAL 0 A reset DM
[37] a5+0ucs 8
[38] +If (0 2€*10]0DR ur)aleppur
[39] sAndIf (2tur)=8s, '’ A error signature =
[40] ur~+BS 2
[41] ur OSIGNAL dcli911 ¢ [eur ¢ =0 A signal error only if calledr ||
[42] +EndIf 2
(42 . o § - vz .
< > 2 2
S 5
Function Pos: 35/49,0 e 5| @
Ready... Ins NUM
CurObj: 2:1 OoQ:0  OTRAP | OSI:t [I0:1  [OML:t

Execution Reached [JSE .UCMD[35]

The next illustration shows the result of clicking Trace at this point. This caused
the system to trace into [JSE.SaltUtils.Spice, the function called from
OSE.UCMD[351].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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Tools  View
ws 13 2l % & | Object B gl @ W H | Tool O IS Edit (31 4] 9 @ | Session [RA)[EPL3E5 Unicods)
Language Bar - s XX
FEEIBel' 7] (Ul [ (R[] [+ JJoleel) [T Fele] FOEEEEl] [oe- el | o
Gl
Dyalog APL/W-64% Version 18.0.38293 A~
Serial number: 000042 - pre-release software
Tue May 26 12:11:27 2020
ldisplay 113
v
D _ox
At e tT00mOoN S EE _g:HSEar:h R ov| % % 4| %[ Spice[1]r Called by the UCMD pro
[8] “l+b/List[;cLname cMinlen] B reduced [3Ey | D | UCMDIE5] ur-(del,“dcl<notQxpnma)l]
[o] ~0t<exactvppos<Where b\rl[;1]ecn A find an exap !
[10] pos+Where B\({ri[;21Tpn)t"rl[;1])ecn A try on all b
[11] L (EndIf
[12] L v
[o1 ] v {R}+{rgn}Spice msg:iargscicmdscomscsidetails;DMXihelpshelpfor;dimon;h
[1] [ Called by the UCMD progrem. This program can also be used directly b
[2]
[3] (rgn ASN)+2t{6::1 o rgn}0 A Is the result used (1) or simply displ)
[4] ASN+(modeBit 5)vUCauto<ASN A In this version we disregard "Allow Shh
[5] =
[6] A Put a stop before the call if requested 2
(7] emd="*[A"1a" [+ Ta' " a(a.e)28 IR’ 'emsg £
[81 cmdiZe"2x5top==DEBUG " ~2temd =
[91 ] tTf Ocier/a\'? =cmd={(*]'=1tu)bu}rlb cmd ol
A M TN ! 5 -
< > 2 i)
i 35
Function Pos: 279/2347,0 Wl NiK
Ready. .. Ins NUM
CurObj: 8:1 OoQ:0 QOTRAP [OsI:2 QOI0:1 [OML:3

Execution Reached [JSE.SALTUtils.Spice[1]
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The illustration below shows the state of execution having traced deeper into the
system.

Tools  View

ws 7 VM r | Object @ ol @ D AN | Tool £ 5 IS 8 | Edit [ 51 D Q| Session ol [ [APLIS Unicode [ 16[Z]

Language Bar x| x
LD eBRM?] (U] FRl<FREF [e[=]<0fa]¥] [tfalelelu]~ LLofeelefs] [TF[-[-[é[ele] MOMERIlsfs] [sfal-uloa]& | -
Dyalog APL/W-6% Version 18.0.38293 ~
serial number: 000042 - pre-release software
Tue May 26 12:37:23 2020

Jdisplay 113
)si
[SE.SALT.Load[1]=
[SE.SALTUES Ls. Spice[249]
OSE.ucHMD[ 351
v
Debugger - 0x
21 €3 10000 & IEE &|[search, X v % & u| % [Load[11x:Access Shared Public
Spice[249] R+BS,spc=0 ¢ OSE.SALT.
=43 OSE.SALTUtils [14] ~] O spicel249] Spetd © g
B tis] e T 1| UCMD[35] ur=(del, “dclsnotq=pnma)ll
@[3 [Fields] H10o" A0 iy
iy [16] class+I0>'-version="Aparse class'1
&3 Methods] [17] emd+'"",class,'" -noname',{O#AVERSION)/' -versi b
[18] ref+#.ONEM(Load cmd),hasargs/cargs
[19] v
(0] ¥ {ref}+{la}load fname;allpaths;cicnamesext;file; b
(1] [ +Access Shared Public
(2] ® This function returns either a ref/name after defin b
(3] B or a VIV if the source was requested or several fas b |
[4] :If isHelp fname 3
[5] ref+'Load <path> [-target=<ns>] [-disperse[ » |/
[¢] ref,+'Load item from native text file' '' 2
[7] ref,+<'Modifiers:' vz
< > E 8
= 5

Namespace Pos: 194/1630,0 Al >

Ready... Ins  NUM

CurObj: Spice (Function) g:1 | ODQ:0 OTRAP | OsI:3 0I0:1 | OML:2

Execution reached four levels deep

At this stage, the state indicator is as follows:

)SI
OSE.SALT.Load[1]*
OSE.SALTUtils.Spice[249]
(SE.UCMD[35]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in
the Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
state indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the 7race Tools
window. This causes execution to be suspended at the start of the line which was
previously traced. The same effect can be achieved using the keyboard by pressing
Esc. It can also be done by selecting Exit from the File menu on the Trace Window
or by selecting Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression ~[JLC.

The <BH> button continues execution until the current function has run to
completion and control has returned to the calling function. It leaves the Trace
window displayed and allows you to watch execution progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and
back again. While it is docked, you may resize the Tracer pane by dragging its title
bar, and you may use the buttons provided to maximise, minimise and restore the
Tracer pane within the Session window.

Unless you move it, the cursor is positioned to the left of the suspended line in the
top Trace window.

Depending where the cursor is in the tracer window, pressing Shift+Enter (ED) or
selecting Edit from the File menu may cause an edit window to open. If the cursor
is in the first column of the Trace window, or on whitespace, the Editor is opened
on function or operator on top of the stack. If the cursor in on a name, the Editor is
opened on the name under the cursor (point-and-edit). With the cursor in any other
location, no action is undertaken.

When you finish editing, the window reverts to a trace window with the new
definition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-
edit.

You can copy text from a trace window to the session for editing and execution or
for experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer
on a different expression.
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Setting Break-Points

Break-points are defined by JSTOP and may be toggled on and off in an Edit or
Trace window by clicking in the appropriate column. The example below
illustrates a function with a JSTOP break-point set on line [5].

<) File Edit Syntax Window Refactor View - 8 %
== e [ & 0||Search... Wov| % % Aa Eal

[o] {FILE}BUILD_SESSION LANG:0BJ:;MSG;0IO;0OML;OLD;NEW;FN;MB;581;5B82;TB:58;580 A
[1] A Build the session object and save if desired

[2] :If 0=[NC'NoPrompt’' ¢ NoPrompt+0 ¢ :EndIf

[3] :If O=[NC'FILE' & FILE= ¢ :EndIf

[4]

[5] L] OWX+[SE .OWX+1 o [OML OIO+1 ¢ OPATH+'#.Trans

[&] OPW+122 & allows room for Status Bar

[7] LA upCase,LANG A translation assumes uppercase

[8] INLCODE+B0=[IDR

[9]

[10] ( ‘Unknown language, pick one of',3Trans.CODES)OSIGNAL(Trans.CODESe~cLANp
[11]

[12] :If GUI+'Windows '=7t0I0=0WG'APLVERSION

[13] T Ose'[OWS 'Coord ScaledPixel

[14] :EndIf

[15]

[16] A Expunge MenuBar(s), StatusBar(s), ToolBar(s), TipField(s), OSE.WSDoc apw
< >
Function Pos: 0/183,1

OSTOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are
established immediately.

Clearing All Break-Points
a [

You can clear all break-points by pressing the above button in the Trace Tools
window. This in fact resets JSTOP for all functions in the workspace.
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The

If you

Classic mode Tracer

select Classic Dyalog mode from the Trace/Edit tab in the Configuration

dialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2.
However, the Tracer is not dockable in the Session.

Ifyou

select the Classic mode Tracer, you may choose between multiple trace

windows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

Each function on the SI stack is represented by a separate trace window. The
top window contains the function that is currently executing, other
windows display functions further up the stack, in the order in which they
were called.

When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and
displays the newly called function.

When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or
typing Alt-F4, the top trace window disappears and the focus moves to the
previous trace window

If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »[JLC. The <CS> button also
continues execution, but leaves the trace windows displayed and allows you
to watch their progress.

If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.

If you drag any Trace window with the mouse and at the same time press
Ctrl+Shift, the entire set of Trace windows is dragged.

Note that a maximum of 50 Trace windows may be displayed.
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Single Trace Window

The following behaviour is obtained by selecting the Single Trace Window option.

The trace window contains a combo box whose drop-down displays the
contents of the SI stack. This box is not provided if there are multiple trace
windows.

The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

When the last function in a traced suspension exits, the trace window
disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To
display the Threads Tool, select Show Threads Tool from the Session Threads
menu, or Threads from the Session pop-up menu.

i\ﬁThreadE

Tid

Tid:0 (Run)
Tid:1 (GUI)
Tid:2 (Lift 1)
Tid:3 (Lift 2)
Tid:11 (Man 11}
Tid:18 (Lady 18)
Tid:19 (Man 19}
Tid:20 (Lady 20)
Tid:21 (Man 21}
Tid:22 (Lady 22)
[Tid:23 (Man 23)

Location State Flags Treg » (10025
«RUN[63] OTGET... Session Norma m
SHOW[22] ODQ'F* 0oa Paused !
LIFT[8] :If 0... [OTGET (Ready... Paused 1001

GOTO[10] ODL 0.2 [DL Paused

PERSON[7] OTG... [OTGET (Ready... Paused 32

PERSON[4] Lif... [OTGET (Ready... Paused 2

PERSON[4] Lif... [OTGET (Ready... Paused 2

GETIN[1] ODL 0.2 [DL Paused _
PERSON[7] OTG... OTGET (Ready... Paused 11 §
PERSON[7] OTG... OTGET (Ready... Paused 21 5
PERSON[7] OTG... [OTGET (Ready... Paused &1 §

The above picture illustrates a situation using the 1ift.dws workspace after
executing the function RUN. The Pause on Error option was enabled and a Stop
was set on RUN[63]. When RUN suspended at this point, all other threads (1-8)
were automatically Paused. Note that all other threads happen to be Paused in the
middle of calls to system functions

The columns of the Threads Tool display the following information.

Column

Description

Tid

The Thread ID (OTID) and name (OTNAME) if set

Location

The currently executing line of function code

State

Indicates what the thread is doing. (see below)

Flags

Normal or Paused.

Treq

The Thread Requirements (OTREQ)




Chapter 1: The APL Environment 165

Thread States

State Description
Pending Not yet running
Initializing Not yet running

Defined function Between lines of a defined function

Dfn Between lines of a dfn

Indicates that the thread is suspended and is able to

Suspended accept input from the Session window.

Indicates that Session window is connected to this

Session
thread.

Indicates that the thread has no SI stack and the Session

(no stack) is connected to another thread. This state can only occur
for Thread 0.

Exiting About to be terminated

:Hold Waiting fora :Hold token
:EndHold Waiting fora :Hold token

doL Executing (DL

oQ Executing [JDQ

(ONA Waiting for a DLL ([ONA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue) Executing JTGET, having got a token

OTSYNC Waiting for another thread to terminate

Indicates a thread that is associated with a NET system

Awaiting request .
W g requ thread, but is currently unused

Called .NET Waiting for a call to .NET to return.
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Paused/Normal

In addition to the thread state as described above, a thread may be Paused or
Normal as shown in the Flags column. A Paused thread is one that has temporarily
been removed from the list of threads that are being scheduled by the thread
scheduler. A Paused thread is effectively frozen.

Threads Tool Pop-Up Menu

Switch to
Interrupt

Ignore Interrupts

Refresh Mow
Auto Refresh

" Pause Threads on Error

"  Paused
Pause All

Resume All

Restart All



Chapter 1: The APL Environment

Selecting this item causes APL to attempt to suspend (if

Switch to necessary) and switch to the selected thread, connecting
it to the Session and Debugger windows.
Causes a (STRONG) interrupt in the selected thread the
Interrupt next time it is scheduled, essentially it allows you to

target an interrupt at a specific thread.

Ignore Interrupts

Allows you to specify that the selected thread should
ignore weak interrupts.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on
Error

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or
an interrupt.

This item toggles a thread between being Paused and

Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.

Pause All This item causes all threads to be Paused.

Resume All This item resumes all threads.

Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.

167
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other

than Thread 0. The following picture shows the Debugger open on a multi-
threaded application (LIFT.DWS) when only Thread 0 is suspended. This has been

achieved by setting a stop on RUN[63]

rogram Files\Dyalog\Dyalog APL-

File Edit View Windows Session Log Action Options Tools Threads Help
ws ig Yl [ Obect o) @Y T M Teol O IS 8 | Edit (§ 4] 9 | Session APL3E5 Unicode  ~
Language Bar x| X
: - = = " ~ | O
(<] [=ls[efelo[ 2] (L[] [[l<l<pTol=l#] L=l 0l4]3] [t]sele]o]~[-] Lo[slolelols] [T[<].[-[3]sle] CiDElEa=]s}s] [o[a[-llolvlele | -
Dyalog APL/W-6% Version 18.0.38293 ~
Serial number: 000042 - pre-release software
Wed May 27 14:54:07 2020
C:\Program Files\Dyalog\Dyalog APL-6% 18.0 Unicode\ws\lift.dws saved Mon Apr 20 20:32:10 2020
Lift simulation designed to illustrate multi-threading
and thread synchronisation, using the Token Pool.
To run it:
RUN 20 @ Simulate 20 arrivals
RUN 20 A Simulate 20 arrivals
RUN[63]
v
Debugger —0Ox
At et 00MON & =E .ﬁ‘lsear(hm X v % % 4 % [RUN[63T+0TGET 2pJobDone A Wa
[56] OTGET GUIReady Al B
[57] F.LIFT1 F.LIFT2 LIFTR"<FLOORS CAPACITY A Start Lift threads !
[58] sFor I :In N # Start <N> people threads
[59] PERSON&F LOORS 2
[60] OpL 0.2x7 8 Simulate random(ish) arrival é
[61] :EndFor =
[62] OTPUT AL LDone R Tell Lifts "that’s it" B
[63] @ [DTGET 2pJobDone ® Wait until Lifts have finished delivering men %
[64] OTKILL OTNUMS R Zap any threads =
vl %
£ =
< > 2 2
- o] 3
Function Pos: 63/65,0 % |« > =
Ready... Ins NUM
CurObj: RUN (Function) 8:8 0DQ:0 | OTRAP [5I:1 DOIO:1 [ML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock
it between the Session and Debugger windows. Note that only one thread, thread 0
(Run) is suspended. All the other threads are Paused (because Pause on Error is
enabled).

File Edit View Windows Session log Action Options Toels Threads Help
WS 1ig Y H Y Obet @@ @Y AW | Tool O o) IS & | Edit (P &1 9D Q| Session [l | APL385 Unicods V
Language Bar X | *
[T [eBlete] [ITILRre] [fefel<P] ([ L[0ldly] [l Tf#fele] [TET-Tee] BB e[ ulaleiles | 2
~
RUN 20 & Simulate 20 arrivals
RUN[63]
v
Threads - 0Ox
Tid Location State Flags Treg 3 [1001.5
Tid:0 (Run) *RUN[63]1 OTGET 2pJobDone A Wait unti... Session Normal ©
Tid:s1 (GUI) SHOW[22] ODQ'F* ooa Paused !
Tid:s2 (Lift 1) GoTo[10] OOL 0.2 OoL Paused
Tid:3 (Lift 2) GoTo[10] OOL 0.2 oL Paused
Tid:t4 (Lady 1%}  PERSON[7] OTGET Lift REACHED MYFLOOR ... OTGET (Resdy... Paused 31 =
Tid:20 (Lady 20}  PERSON[7] OTGET Lift REACHED MYFLOOR ... DTGET (Ready... Paused 42 £
Tid:21 (Man 21) PERSON[7] OTGET Lift REACHED MYFLOOR ... OTGET (Ready... Paused 22 g
‘Tid:23 (Man 23) PERSON[4] Lift~{TGET Goinglp f... DOTGET (Ready... Paused 2 2
Debugger _ox
At et 00O S EE _g:HSear(h..‘ x v & | X |RUN[63]+0TGET 2pJobDone A Wa
[5611 | OTGET GUIReady A B
[571 | | F.LIFTi F.LIFT2 LIFTR"=FLOORS CAPACITY A Start Lift threads 0
(5811 i :For I :In 1N A Start <N> people threads
[59]: : PERSONRFLOCRS =
[60] : oL 0.2x710 A Simulate random(ish) arrival 2
[61] | | :EndFor 2
[62] | | [DOTPUT AllDene A Tell Lifts "that’s it" =
[63] #i [OTGET ZpiobDone A Wait until Lifts have finished delivering men 5
[64] | | OTKILL OTNUMS A lap eny threads E
; vl =
< I > |8 ]
= 5
Function Pos: 63/65,0 9 || @
Ready... Ins  NUM
CurObj: RUN (Function) 2:8 ODQ:0  DOTRAP | OSI:t [IO:1  [OML:0
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The user then uses the context menu to Switch To Thread 14 (whose name is Lady
14) which was Paused on PERSON[ 7] in the middle of a OTGET. The act of
switching to this thread caused it to be suspended at the beginning of its current
line PERSON[ 7] and the Debugger now displays two Tabs to represent the two
suspended threads. Note that both the thread id and the thread name are displayed
on the Tabs.

Note also that the Session window is connected to the thread indicated by the
selected Tab. In this case, typing MYFLOOR into the Session window displays the
value of the local variable MYFLOOR in Thread 14 (Lady 14).

® c\program alog APL- n f yalog APL/W-6

File Edit View Windows Session log Action Options Tools Threads Help

WS 13 Y% (Ot @S @Y TM Tol £ o = & | Edit (1 41 9 ¢ Session

Language Bar X | X
" . o =~ O
(] [l-[=l<[efefel 2] [[FILL[rl-] [el<l<P =[] ([[<[-l<[Oa]s] [[oe]e]o][-] L[sel¢felx DRl [ofa-bleslE | o
~
RUN[63]
MYFLOOR
3
v
Threads —ox
Tid Location State Flags Tregq X 10015
Tid:0 (Run} *RUN[63] OTGET 2pJebDene A Wait unti... Suspended Paused o
Tid:1 (GUD) SHOW[22] ODQ'F" b} Paused :
Tid:2 (Lift 1) GOTO[10] ODL 0.2 OoL Paused
Tid:3 (Lift 2) GoTo[10] ObL 0.2 OoL Paused
Tid:1% (Lady 14) =PERSON[7] OTGET Lift REACHED MYFLOOR m... Session Normal _
5
Tid:20 (Lady 20) PERSON[7] OTGET Lift REACHED MYFLOOR a... [OTGET (Ready... Paused L2 2
Tid:21 (Man 21) PERSON[7] OTGET Lift REACHED MYFLOOR  A... [OTGET (Ready... Paused 22 <
g
I73d:23 (Man 23) PERSON[%] Lift-OTGET Goingl ... OTGET (Ready... Paused 2 ]
P =
Debugger _ox
Tidk0 (Run) Tidk14 (Lady 14) X | PERSON[7]+0TGET Lift REACHED MYFL
= o
2t €2 100N ON S EE £ |[san. x v[% & @ X
[0] PERSON FLOORS:MYFLOOR:Lift;SEX R Implements Person thread
(11 | Sex«1+0T 071D+ -
[2]: i [OTNAME-(SEX='Man ' ‘Lady '),s0TID £
[3]11 | ARRIVE A Arrive at Lift shaft =
[4]: i Lift+OTGET Goinglp A Wait for Lift door to be open/free 3
[5] Lift GETIN MYFLOOR+?FLOORS A Get into the Lift, tell the Lift where I'm » =
6] H MYFLOOR OTPUT Lift.ID*ManIn A Clear the Lift door for next person :
[71 i [[OTGET Lift REACHED MYFLOOR A Wait for Lift to reach my fleer =
[8]! ! Lift GETOUT MYFLOOR a De-Lift ]
[91: i OTPUT Lift.ID+ManOut a Tell Lift I'm out, thread ends E
< > |8 5
Function Pos: 7/10,0 3¢ 5|8
Ready. .. Ins NUM

CurObj: RUN (Function) g:8 Opg:0 OTRAP [OSI:2 [OI0:1 [OML:0
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You can use the Tabs to switch between the suspended threads, so clicking the
Tab labelled 0:Run causes the display to change to the picture shown below. The
Session is now connected to Thread 0 (Run), so the value of [JLC is 63.

File Edit View Windows Session Leg Action Optiens Toels Threads
WS g © o My | Object B o @ D WM Tool £ 5 = & |kt 41 9 Q| Session ol [ [APLIS Unoode v [ 16Z]
LEVGUEIGE B 550350050500 0 0 00 08005 05 005 505500 00 1053503500050 503550035 0050075 x| x
=[]+ [ele[t]2] [ITT[L] [olfelele) [TF[-[FEle] OOBEELs] [olofelelelesi | B
o
&
RUN[63]
MYFLOOR
El
v
Threads - -0 x
Tid Location State Flags Treq > (10015
Tid:0 (Run} *RUN[63] OTGET 2pJobDone A Wait unti... Suspended Paused o
Tid:1 (GUI) SHOW[22] ODQ'F* ooQ Paused 0
Tid:2 (Lift 1) GoTo[10] OoL 0.2 Oot Paused
Tid:3 (Lift 2) GOTO[40] ODOL 0.2 ooL Paused
Tid:1% (Lady 1%) «PERSON[7] OTGET Lift REACHED MYFLOOR AL Session Normal _
Tid:20 (Lady 20} PERSON[7] OTGET Lift REACHED MYFLOOR A. OTGET (Ready... Paused 42 §
Tid:21 (Man 21) PERSON[7] OTGET Lift REACHED MYFLOOR A. OTGET (Ready. Paused 22 Z
g
|ﬁd=23 (Man 23) PERSON[4] Lift-{TGET Goinglp a... OTGET (Ready... Paused 2 °
Debugger :: —Ox
Tidi0 (Run)  Tid:14 (Lady 14) X |RUN[63]1=0TGET 2pJobDone A Wa
1= O
Fte>t 00 NON S SE &|[seh. x~]% e @
[55] ; SHOW&O A Start GUI Display thread ~
[56] ! DTGET GUIReady
[57] ; F.LIFTY F.LIFT2 LIFT& 'cFLOORS CAPACITY m Start Lift threads
[58] § iFor I :In 1N R Start <N> people threads -
[59] i PERSONEFLOORS 5
[60] OpL 0.2x210 A Simulate random(ish) arrival =
[61] :EndFor 2
[62] i OTPUT AllDone A Tell Lifts "that’s it" F
[63] i@ “]TGET 2pJobDone A Wait until Lifts have finished delivering men =
[64] ; OTKILL OTNUMS R Zap any threads o 12
< |15 i
Function Pos: 63/65,0 I < 512
Ready... Ins NUM
CurObj: RUN (Function) &:8 Ooq:0 OTRAP [OsI:2 Q0OI0:1 [OML:0
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The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To
display the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

« which types of events you want to monitor
« which objects you want to monitor

Spy Ceolumns  Select Options

ObjectMName Object Type EventName EwentNumber Parameters e
#f Form Configure 3 4277777863 8.020833015 ¢
#f Form Configure 3 4287036896 8.020833015
#f Form Configure 31 42.9629631 7.96875 50 50
#f Form Configure 31 42,9629631 7.96875 50 50
#f Form MouseUp 2 20.55555534 64.27083588 -
#f Form MouseUp 2 2574073982401 0

#f Form MouseUp 2 2574073982401 0

#f Form MouseDblClick 5 25.74073982 4010

#f Form MouselUp 2 2574073982401 0

#f Form LostFocus 41

#f Form GotFocus 40

#f Form LostFocus 41

#f Form GotFocus 40

#f Form LostFocus 41 v
< >

In the example illustrated above, the user has chosen to monitor events on a Form
# . f. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDblIClick and Configure events.

Entries in the Action column report the action that was associated with the event at
the time it was placed in the queue. This may or may not be the same as the action
that is associated with the event when it reaches the top of the event queue and is
processed.
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The Spy Menu
Clear

Copy

& All
When Placed in Object's Queue

Current Queue State
~  Enable Logging

Close

The Spy menu, illustrated above, provides the following options and actions.

Item Description

Clears all of the event information that is currently

Clear displayed in the Event Viewer.

Copy Copies the highlighted rows to the clipboard.

In this mode all the events are displayed in the Event
All Viewer as they occur, whether or not there is an action
associated with them.

In this mode only events that have associated actions

When Placed in are displayed in the event viewer. Note that KeyPress

Object's Queue events are always queued and therefore always appear,
even if there is no associated action.

In this mode the Event Viewer displays a snapshot of
the internal event queue. Only those events that are
currently in the internal APL event queue waiting to
be processed are displayed.

Current Queue State

Enable Logging This item switches event logging on and off.

Close Closes the Event Viewer
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The Columns Menu

ObjectName
ObjectType
EventMame
EventMumber
Parameters
Action
ThreadID
MCed

EventlD

L S U U U e T Y

Tirnestamp

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.
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Item Description

If checked, this item displays the name of the object

jectN .
ObjectName on which the event occurred.

If checked, this item displays the #ype of the object on

ObjectType which the event occurred.

If checked, this item displays the name of the event

Event Name
that occurred.

If checked, this item displays the event number of the

Event N
vent Number event that occurred.

If checked, this item displays the parameters for the
Parameters event that occurred. These are the items that would be
passed in the argument to a callback function.

If checked, this item displays the action associated
with the event when the event is placed in the event

Action queue, for example the name of a callback function, or
an expression to be executed.
Thread 1D If checked, this item displays the thread id of the

thread in which the event occurred

If checked, this item displays 0 or 1 according to
NQed whether or not the event occurred naturally or was
generated programmatically by ONQ.

If checked, this item displays the event id of the event

Event ID that occurred. This id is used internally.

If checked, this item displays the time stamp of the

Ti t
imeStamp event that occurred.
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The Select Menu

Select All

Select Matching Events
Select All Events on this Object
Select All Events of this Type
The Select menu allows you to highlight certain events in the Event Viewer. For

example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Item Description

Select All Highlights all the events.

Highlights all the events that have the same Object
and Event Name (or Event Number) as the currently
selected event.

Select Matching
Events

Select All Events on | Highlights all the events that have the same Object as
This Object the currently selected event.

Highlights all the events that have the same Event
Name (or Event Number) as the currently selected
event

Select All Events of
this Type

These items are also available from the pop-up menu that appears when you press
the right mouse button over an event displayed in the Event Viewer window.
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The Options Menu

Always on Top

" llse APL Font

Settings..

The Options menu allows you to choose which information is displayed for the

events you are monitoring.

Item

Description

Always on Top

If checked, this item causes the Event Viewer window
to be displayed above all other windows (including
other application windows).

Use APL font

If checked, this item causes the information displayed
in the Event Viewer window to be displayed using the
APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings...

Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

Event Viewer Options

Options
Events to view: Objects to view:
() Uk i) vt Find Toal: @ Select From List...

Mame o] a | MName: #f

[ MouseDawn 1 Tomes

e Form:

Mouzellp 2 orm

[ MouseMove 3 ThreadlD: g

[ MouseClick 4

MouseDbClick 5 Handle: 000000000071 B30404

[ MouseEnter g

[ MoussLeave 7 [CJPaient Object

[ Mousetwheel g

L] Dragver 1 [ Child Objects

[ DragDrop 1

[ DragStart 12 []5ame Thread

[ DragListtove 15

[ DraglistCopy 16 [0 Objects

I KeuChar 19 hd

Inver Check Selected| | Chackal Charl | [JObiectsof Tope Select From List.
5 event(z] of 312 selected
Canel

Events to view

The list box shows all the events that are support by the Dyalog APL GUI and
allows you to select which events are to be monitored. User defined events may be
selected by checking the User defined events box. Only those events that are
selected will be reported. You can sort the events by name or by event number by
clicking the appropriate column header.
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Objects to view

Item

Description

Find Tool
Select from List

This tool allows you to choose a single specific
Dyalog APL GUI object that you want to monitor. To
use it, drag the Find Tool and move it over your
Dyalog APL GUI objects. As you drag it, the
individual objects are highlighted and their details
displayed in the Name, Type, Thread ID and Handle
fields. Drop the Find Tool on the object of your
choice.

Clicking the Select from List button brings up a dialog
box that displays the entire Dyalog APL GUI structure
as a tree view. You can choose a single object by
selecting it.

Parent Object

Enables event reporting on the selected object's
immediate parent.

Child Objects

Enables event reporting on the all selected object's
descendants (at any level).

Same Thread

Enables event reporting on all the objects in the same
thread as the selected object.

All Objects

Enables event reporting on all Dyalog APL GUI
objects.

Objects of Type
Select from List

Activates the adjoining Select button and disables all
other Object selection mechanisms.

Clicking the Select from List button brings up a dialog
box that allows you to choose which types of Dyalog
APL GUI objects you want to monitor.
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The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite

Events Close, Create, FontOK, FontCancel, WorkspaceLoaded,
SessionPrint, SessionTrace

Description

There is one (and only one) object of type Session and it is called OSE. You may
use OWG, WS and [OWN to perform operations on JSE, but you cannot expunge it
with [JEX nor can you recreate it using OWC. You may however expunge all its
children. This will result in a bare session with no menu bar, tool bar or status bar.

[SE is loaded from a session file when APL starts. The name of the session file is
specified by the session_file parameter. If no session file is defined, JSE will have
no children and the session will be devoid of menu bar, tool bar and status bar
components.

An additional feature is provided to establish code in the Session. See .

You may use all of the standard GUI system functions to build or configure the
components of the Session to your own requirements. You may also control the
Session by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a
WorkspaceLoaded event when a workspace is loaded or on a clear ws.

The Session reports a SessionPrint event when certain types of output are about to
be displayed. This may be used to alter the normal default display. The Session
also reports a event when executing when an expression is execute with trace
control. This may be used to alter the normal default trace.
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Read-Only Properties
The following properties of SE are read-only and may not be set using OWS:
Property Description
Type A character vector containing 'Session'
. A character vector containing the current caption in the title bar
Caption . .
of the Session window.
. Reports the bounding rectangle for a text string. For a full
TextSize L .. .
description, see TextSize in Object Reference.
A character vector containing the name of the current object.
CurObj This is the name under or immediately to the left of the input
CUrSOTr.
A 2-element integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
CurPos dependent. IfI0 is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). IfFQI0 is 0, its value would be (0 0).
A character vector which identifies the namespace from which
the current expression was executed. If the system is not
CurSpace . . . .
executing code, CurSpace is the current space and is equivalent
to the result of »' '[INS ' ',
Handle The window handle of the Session window.
A vector of character vectors containing the most recent set of
Log lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.
A vector of character vectors containing the most recent set of
Input input statements (lines that you have executed) contained in the
input history buffer.
ChildList A vector of character Yectors containing the types of object that
can be created as a child of [JSE.
MethodList A vector of chgracter Yectors containing the names of the
methods associated with [JSE.
. A vector of character vectors containing the names of the events
EventList
generated by [1SE
. A vector of character vectors containing the names of the
PropList . . .
properties associated with [JSE.
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Read/Write Properties

The following properties of JSE may be changed using [WS:

Property

Description

Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
OsE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

FontObj

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

HintObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
"Ready..." when APL is waiting for input.

Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left comer of the
screen. This is reported and set in units specified by the Coord

property.

Size

A 2-element numeric vector containing the height and width of the
session window expressed in units specified by the Coord property.
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Property

Description

State

An integer that specifies the window state (O=normal,
I1=minimised, 2=maximised). You may wish to use this property to
minimise and later restore the session under program control. If you
save your session with State set to 2, your APL session will start
off maximised.

TipObj

Specifies the name of the object in which tips are displayed.
Unless you specify TipObj individually for session components,
this object will be used to display the tips associated with all of
the menu items, buttons, and so forth in the session.

XRange

See Object Reference

YRange

See Object Reference

Special Properties

The following properties of [JSE are used internally by Dyalog tools such as
SALT. They are not intended nor supported for general use and are not reported by

PropList.
This read-only property returns a reference to the Status
. Window. The expression:
StatusWindow | (e G statusMindow' )OMG' Text ' retums the
(read-only) contents of the status window.
This read-only property returns a reference to the Editor
Editor Window. The Editor generates the special events Fix,
AfterFix and Format.
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Special Events

The following special events are generated by [JSE or its child objects. They are
used internally by Dyalog tools such as SALT. They are not intended nor
supported for general use.

AfterFix

This event is reported by the Editor after it has
successfully fixed a new object, or a new version of an
object, in the workspace.

Fix

This event is reported by the Editor when the user
attempts to fix an object.

Format

This event is reported by the Editor when the user
attempts to format an object.

SessionPrint

This event is reported when a value is about to be
displayed in the Session window. The default display of
the value may be intercepted by a callback function and
displayed differently. This event is used by the Jbox
and Jrows user commands.

SessionTrace

This event is reported when an expression is executed
with trace control. The trace behaviour may be
intercepted by a callback function and altered. This
event is used by the Jbox and Jrows user commands.

WorkspaceLoaded

This event is generated when a workspace is loaded or
upon )CLEAR.
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AfterFix

Event 822

Applies To: Editor

Description

If enabled, this event is reported immediately after the Editor has successfully fixed
a new object, or a new version of an object, in the workspace.

You may not nullify or modify the event with a O-returning callback, nor may you
generate the event using [INQ, or call it as a method. However, returning 0 from a
callback will cause the Edit window to remain open if the user action was Fix and
Exit (EP).

The event message reported as the result of DQ, or supplied as the right argument
to your callback function, is a 7-element vector as follows :

[1] [Object |refto the Editor object
[2] |Event "AfterFix' or 822

the contents of the Edit window, as a vector of character

Contents
[3] vectors

[4] |Space ref to the namespace in which the object will be fixed

[5] Old a character vector containing the original name of the
Name object when it was opened by the Editor

[6] New a character vector containing the name of the object which
Name was fixed. This is empty if the object is a variable.

[7] File a character vector containing the name of the file (if any)

Name associated with the object.
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Fix Event 820

Applies To: Editor

Description

If enabled, this event is reported when the user attempts to fix an object from the
Editor window. It is reported immediately, before the user's action is processed in
any way by the Editor.

The default action is to check whether the object has changed. If not, no further
action takes place. If the object has changed, the system validates the contents of
the Edit window, and either displays an error dialog or fixes a new version of the
object in the workspace. If the user action was to fix and exit (EP), the Edit
window is closed unless the validation failed.

If the callback function returns 0, the default action is aborted in its entirety (not
even the validation takes place) and the Edit window remains open.

You may not generate the event using [INQ, or call it as a method.

The event message reported as the result of [IDQ, or supplied as the right argument
to your callback function, is a 7-element vector as follows :

[1] |Object ref to the Editor object

[2] |Event "Fix' or 820

the contents of the Edit window, as a vector of character

3 Contents
[3] vectors

[4] |Space ref to the namespace in which the object will be fixed

[5] Old a character vector containing the original name of the
Name object when it was opened by the Editor

[6] New a character vector containing the new name of the object.
Name This is empty if the object is a variable.

[7] File a character vector containing the name of the file (if any)
Name associated with the object.

For objects whose names are part of the content of the Edit window, this event is
not reported if the name is missing or invalid. Instead the system will display an
error dialog box.
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Format

Event 821

Applies To: Editor

Description

If enabled, this event is reported when the user attempts to format an object in the
Editor window.

If the callback function returns 0, the contents of the Edit window are not
reformatted.

You may not generate the event using ONQ, or call it as a method.

The event message reported as the result of 0DQ, or supplied as the right argument
to your callback function, is a 6-element vector as follows :

[1] |Object |refto the Editor object
[2] |Event '"Format' or 821

the contents of the Edit window, as a vector of character

3 Contents
[3] vectors

[4] |[Space ref to the namespace in which the object will be fixed

[5] Old a character vector containing the original name of the
Name object when it was opened by the Editor

[6] New a character vector containing the new name of the object.
Name This is empty if the object is a variable.

SessionPrint Event 526

Applies To: Session

Description

If enabled, this event is reported when a value is about to be displayed in the
Session. It is generated by the display of a variable or the result of a function
including system variables and functions. Error messages and output from system
commands do not generate this event.
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The event message reported as the result of [JDQ, or supplied as the right argument
to your callback function, is a 2-element vector as follows :

[1] |Object ref or character vector

[2] |Event 'SessionPrint' or 526

The attachment of a callback function intercepts and annuls the normal display of
any value.

Note that this event may be extended in future; in particular the number of
elements in the event message may be increased, and the event may be generated
by some system commands. You should therefore allow for such extensions in any
code which refers to SessionPrint.

When the event is generated, the left argument of the callback function contains
the value which was about to be displayed. The callback function may display this
or any other value, using default output or by assignment to [J. If so, this output
will be processed normally, without generating a subsequent SessionPrint event. If
the callback fails to explicitly display anything, nothing will appear in the Session.

Example

OVR'OSE.TimeStamp'
V VAL TimeStamp EV
[1] 0TS VAL

v
'0OSE'0OWS'Event' 'SessionPrint' '(0SE.TimeStamp'
2
2014 9 18 16 20 38 318 2
OA

2014 9 18 16 20 44 668 ABCDEFGHIJKLMNOPQRSTUVWXYZ
The result (if any) of the callback function is ignored.

You may not disable the event (by setting its action to ~ 1), nor generate the event
using [ONQ, nor call it as a method.
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SessionTrace Event 527

Applies To: Session

Description

If enabled, this event is reported when an expression is executed with trace control.
See Language Reference Guide: Set Trace. Error messages and output from system
commands do not generate this event.

The event message reported as the result of 0DQ, or supplied as the right argument
to your callback function, is a 4-element vector as follows :

[1] |Object ref or character vector

[2] |Event 'SessionTrace' or 527
[3] |Function Character vector (' ' if none)
[4] |Line number Numeric scalar (0 if none)

The attachment of a callback function intercepts and annuls the normal display of
function name, line numbers and any value.

Note that this event may be extended in future; in particular the number of
elements in the event message may be increased. You should therefore allow for
such extensions in any code which refers to SessionTrace.

When the event is generated, the left argument of the callback function contains
the result value of the expression, if any. The callback function may display this or
any other value, using default output or by assignment to [. If so, this output will
be processed normally, without generating any SessionTrace or SessionPrint events.
If the callback fails to explicitly display anything, nothing will appear in the
Session.

If the expression has no value, then the callback function will be called
monadically. It is therefore required that the callback function is ambivalent (can
be called both monadically and dyadically).
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Example
)cs [ISE
QsE

v {VAL}TimeStamp EV
[1] [O«0TS(2124EV)

[2] :If O0#[NC'VAL'
[3] [l«VAL
[4] tEndIf
[5] O«0ucs 13
v
)cs
#
'OSE'OWS'Event' 'SessionTrace' '[OSE.TimeStamp'
vV Foo
[1] A just a comment
[2] global<[JA
v

1 2 OTRACE'Foo'
Foo
2020 7 3 14 2 37 762 Foo 1
2020 7 3 14 2 37 763 Foo 2 ABCDEFGHIJKLMNOPQRSTUVWXYZ

The result (if any) of the callback function is ignored.

You may not disable the event (by setting its action to ~ 1), nor generate the event
using [INQ, nor call it as a method.
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WorkspacelLoaded Event 525

Applies To: Session

Description

If enabled, this event is reported when a workspace is loaded oron a clear ws.
You may not nullify or modify the event with a 0-returning callback, nor may you
generate the event using [INQ, or call it as a method.

The event message reported as the result of 0DQ, or supplied as the right argument
to your callback function, is a 2-element vector as follows :

[1] |Object ref or character vector

[2] |Event ‘WorkspacelLoaded' or 525

This event is fired immediately after a workspace has been loaded and before the
execution of (L X.

The callback function you attach should be defined in [JSE.
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Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the
following:

You may select a different APL font or character size.

You may alter the appearance of the menus by changing the Caption properties of
the various Menu and Menultem objects. For example, you may prefer the menus
to appear in your own language.

You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part
of the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your
functions or to display output. For example, you may display a Combo object that
offers you a selection of names applicable to a particular task.

You may add additional toolbars.

You may remove objects too; for example, you can remove fields from the
StatusBar or even delete it entirely. Indeed, you may dispense with the menu bar
and/or tool bar as well.

This section illustrates how you can configure your session using worked
examples. The examples are by no means exhaustive, but are designed to
demonstrate the principles. Please note that the structure and names of the objects
used in these examples may not be identical to your default session as supplied.
Before you attempt to change your session, please check the structure and the
object names using OWN and [OWG. The supplied session was created using the
function BUILD_ SESSION in the workspace BUILDSE. If you wish to make
substantial changes to your session, you may find it most convenient to edit the
functions in this workspace, re-run BUILD SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.
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Changing the Font

The APL session font is defined by the Font property of OSE. To change the font
permanently, you should select a different Font and/or size of Font using the
combo and spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but
it is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come
in two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may
select other sizes, so long as the height is a multiple of 16 or 22. The scaling is
performed automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is [ISE .mb". To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS OSE.mb
0OSE.mb

The names of the Menu objects owned by the MenuBar are given by the
expression:

‘Menu' OWN "'
file edit view windows session Llog action options
tools threads help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 O
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Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by
adding a Search menu to the menu bar to provide access to the Find and
Find/Replace dialog boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
[SE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at
position 3 (after Edit).

'search'JWC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edit menu.
Their names can be obtained from JWN:

‘MenuItem'WN'edit'
edit.prev edit.next edit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace]
respectively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replacel

The following statement removes them from the Edi¢t menu:
OJEX"'edit.find' 'edit.replace'’
and the following statements add them to the Search menu:

'search.find' (OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]')
'search.replace' [OWC 'Menultem' '&Replace'’
('Event' 'Select' '[Replacel]')
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Adding your own Menultem

This example shows how you can add a menu item that executes an APL
expression. In this case we will do something very simple; namely add a Time
option to the Tools menu which will execute OJTS. Notice that the statement also
defines a Hint. This will be displayed when you select the option, prior to
releasing the mouse button to action it.

Once again, we will start by changing space into the 7ools menu itself

)CS [JSE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'OWC'Menultem' '&Time'
('Event' 'Select' 'o[TS')
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed
immediately, as in this case, from a callback function. The resulting Tools menu
now appears as follows:

Explorer...
Search...
Status...

¥ AutoStatus

Event Viewer
Properties...
Tirme

A customised Tools menu

Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O
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Adding your own Tool Button

This example shows how you can add a button to the session tool bar that
executes an APL function called XREF.

XREF analyses the function whose name is under the cursor, listing the names of
the other functions that it calls in a Form.

vV XREF;REFS;FN
[1] :If O<pFN<«'SE'0WG'CurObj'
[2] :AndIf 3=[JNC FN

[3] REFS*DREFS('DSE'DWG'CurSpace'),'.',FN
[4] REFS«(4REFS)~""
[5] REFS«(3.1=[ONC REFS)/REFS
[6] REFS<«REFS~cFN
[7] :If O<pREFS
[8] "F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«[JSE.FontObj
[10] '"F.L'OWC'List'REFS(0 0)(100 100)
[11] :EndIf
[12] :EndIf
v

XREF [ 1] gets the value of the CurObj property of JSE which reports the name
under the cursor.

XREF [ 3] prefixes this name by its pathname which comes from the CurSpace
property which reports the user's current namespace.

To make this function available from a Session tool button, we need to do a
number of things. Firstly, we must install the function in [JSE so that it is always
there, regardless of the current active workspace. This is easily achieved using the
Explorer or [INS.

'OSeE’ [ONS 'XREF'

Next we will add a new button to the tool bar in the 7ools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard
text button:

)CS [OSE.cbtop.bandtb3.tb
OSE.cbtop.bandtb3.tb

'xref' [OWC 'Button' 'XREF'
"'xref' [OWS 'Event' 'Select' 'e¢[SE.XREF'

Tool P 57 i= &P XREF
Adding a tool button

All that remains is to save the new Session.
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Session Initialisation

Introduction

Each time Dyalog starts it loads and executes an initialisation file whose name is
defined by the DyalogStartup parameter. If this is undefined, the default file is
named startup.dyalog in the Dyalog directory. Among other tasks, the code
defined in startup.dyalog also performs Session initialisation.

Implementation

Code to be installed in [JSE is specified in APL source code files contained in
Session initialisation directories identified by the DyalogStartupSE parameter. If
this parameter is not specified, the default is a directory named StartupSession
located in three standard locations as described below.

Only content stored in files matching the wildcard patterns * . dyalog and
* . apl? will be loaded. All such files must be appropriate for (JF IX.

For each sub-directory in a Session initialisation directory, a corresponding
namespace is created in JSE, and any source code files in these sub-directories will
be fixed in their respective corresponding namespaces. There is currently no
support for additional subdirectories inside these subdirectories, although this
feature is planned.

The Session initialisation directories are processed in order and code defined in
each directory will replace code with the same name defined previously. In effect,
this means that user-supplied content can replace content supplied by Dyalog Ltd.
and version-specific content can replace version-agnostic content.

Default Session Initialisation Directories

If the DyalogStartupSE parameter is undefined, APL looks for Session
initialisation directories named StartupSession in the following three
locations, and processes them in that order:

1. The Dyalog installation directory (which contains the dyalog executable)

2. A version-agnostic sub-directory in the user directory (the standard directory
for user-related Dyalog APL files)

3. A version-specific sub-directory in the user directory, whose name is derived
as described below.
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Under Windows these might be:

1. C:\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode

2. C:\Users\Pete\Documents\Dyalog APL Files

3. C:\Users\Pete\Documents\Dyalog APL-64 18.0 Unicode
Files

The version-specific name is :
Dyalog APL{bit} {version} {edition}
where:

o {bit} is "-64" if 64-bit version, otherwise nothing

o {version} is the main and secondary version numbers of dyalog.exe
separated by ".".

« {edition} is "Unicode" for the Unicode Edition, otherwise nothing
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed
without having to explicitly copy code into your workspace and/or save it in every
workspace in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be
niladic or take an argument. A User Command executes APL code that is typically
stored somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user
command mechanism, and a number of new SPICE commands have been added.
For example:

Jdisplay 'hello' (5'world')

7
hello| ‘w

o

£0~—7

-€

The implementation of User Commands is very simple: If a line of input begins
with a closing square bracket (]), and there exists a function by the name

[SE .UCMD, then the interpreter will call that function, passing the input line
(without the bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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File Explorer Integration
Unicode Edition Only

You can browse the contents of workspaces and Dyalog script files using the
preview pane of Windows File Explorer. The following example show what you
see in the preview pane when you select the supplied workspace ddb . dws.

. = | CA\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode\ws
g/ yalog\Dyalog

GUSM Home  share  view e
« © 4 || ThisPC > OS(C) > ProgramFiles > Dyalog > Dyalog APL-6418.0 Unicode > ws v @  Ssearchus »
Dyalog A Name ~ B Narne Type Description Size
Dyalog APL-64 14.0 Unicode & apiconico [;"5-’0”5] D Examples Variable Vector: 4404 char 8711Ks
' Varz] {IReadMe Variable Vector: 20184 char 3952Kb
Dyalog APL-64 14.1 Unicode S) aplservice.dws ddb
) JIRefCard Variable Vector: 3031 char 6.023Kb
¥ 5 scripts
Dyalog APL-64 15.0 Unicode &) arachnid.dws P b Namespiace Namespace 400K
Dyalog APL-6417.0 Unicode de arachnid.ico Hdisp Function 15.73Kb
Dyalog APL-6417.1 Unicode <) atfin.dws “display Function 7.047Kb
&) avu.d .
Dyalog APL-6412.0 Unicode ) avu.dws fimport Function 14.38Kb
™ bubblesbmp Ml scripts Namespace Mamespace 53.64Kb
aplfmt &) buildse.dws Ditest Function 1327Kb
apltrans &) cale.dws “atime Operator 4.359Kb
Base ) calcultrwmf
dwa ™ carsbmp
help A ch2avi
Library %) congadws
%) cpro.dws
locales
€) deomreg.dws
PublicCACerts S dibae
SALT 5) dns.dws
Samples &) display.dws
Setup 8 dollarwmf
StartupSession 3 dyalogl.rf
cwiftshader #a] editicon.ico
2) eval.dws
Syncfusion
%) exceldws
TestCertificaty
EstereEes %) fastins.dws
e %) files.dws .
I\
xflib e 5 z =
Stitems 1 item selected 228 KB =
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When you move the cursor to the next workspace in the list, dfns.dws, the
preview pane is immediately updated to show its contents.

C:\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode\ws

File Home Share View (]
= “ 4 > ThisPC » OS(C) » ProgramFiles > Dyalog 5 Dyalog APL-6418.0 Unicode » ws v Searchws »
Dyalog APL-64 14.1 Unicode  ~  Name . ~ [ Name Trpe Size Modifiedon  ~
Dyalog APL-64 15,0 Unicode & cpliconico LFD’L:;DFS] ) Cholesky Function 1.883Kb  16/06/2015 16:07
Dyalag APL-64 17.0 Unicade © splsenvice.dus woipte Dt Operator 5375Kb  07/10/2015 17:53
' #1Depth Operator 2850Kb  31/10/2017 12:03
Dyalog APL-64 17.1 Unicode @) arachnid.dws A Operstor 1351k | 1971072016 1741
Dyalog APL-64 12.0 Unicode sk arachnid.ico A NermRand Function 1.992Kb  28/07/2014 1715
aplfmt 1 atfin.dws ) UndoRedo Operator 5.68Kb  31/10/2016 16:09
apltrans € avudws fxX Function 4297Kb  21/02/2013 13:15
™ bubbles.bmp £ _fk Operator 1258Kb  20/05/2014 18:38
Base € buildse.dws Dace Operator 968b  16/05/2005 13:35
dwa @) cale.dws Madic Function 243Kb  29/06/2010 10:54
help ] caleuttramt Malger Function 1242Kb  22/05/2018 11:53
Malpop Function 1922Kb  23/05/2018 14:26
Library ™ carsbmp
| Malpush Function 10086 22/05/2018 11:52
locales & chlavi alset Function 1.266Kb  22/05/2012 11:53
PublicCACerts © conga.dws “alt Operator 1.844Kb  31/01/2018 14:23
ST © cpro.dws Mambiv Function 5734Kb  24/07/2017 18:11
©) deomreg.dws and Operator 848 31/10/2009 11:18
Semples ©) ddb.dws Mapportion Function 1960Kb  16/06/2015 16:11
Setup 1) dfns.dws fary Function 9.258Kb  06/02/201413:39
StartupSession ©) display.dws ascan Operator 1227Kb  22/05/2013 10:20
swiftshader ) dollarawm Hascana Operator 1172Kb  22/05/2013 10:20
2 dyologi Massign Function 9477Kb  22/05/2013 11:14
Synefusion £ cyeed et Operator 5.047Kb  12/11/2019 18:15
TestCetificates ] edticonico Dattrib Function 1231Kb  31710/2002 17:16
- © eval.dws Davi Operator 26.28Kb  06/08/2014 10:47
b ) excel.dws baby Function 8.297Kb  02/03/2017 16:16
) fastins.dws #bags Operator 5172Kb  25/09/2010 18:11
xsre € files.dws . basets Function 47090 220520131115,
UnicodelME v < - 5 BT = ars
Sditems 1 item selected 5.64 MB =

If you open the Fns/Ops node and click on a function name, the function is
displayed. The next picture shows the function assign.

| ] B - | c:\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode\ws

GOl Home  share  View 7]
= “ 4 . ThisPC » OS(C) » ProgramFiles » Dyalog » Dyalog APL-6418.0 Unicode » ws v @  Searchws ¥
Dyalog A Name - A~ [Fns/Ops] ~ [0] 0 assigne{OML~1 A Hub A
It
. i .
Dyalog APL-64 14.0 Unicode © splicon.ico o {g 108 \bpu) tur} A 0
Dyalog APL-84 14.1 Unicode © aplservice.dws adic 4] 2t(bu)-1/u} e
Dyalog APL-64 15.0 Unicode ) arachnid.dws alget {2} .
Dyalog APL-64 17.0 Unicode % arachnid.ico alpop 7] g A in
tin. alpush [a] A nok
Dyalog APL-64 17.1 Unicode & atfin.dws alset [91 A mos.
X 10 ext A »
Dyalog APL-64 18.0 Unicode Shovudus alt ne . o
™ bubbles.bmp ambiv
aplfmt [12] a
€ buildse.dws and [13] a1
apltrans @ cale.dws apportion H;% , A nek
Base ) calcultrwmf ay [16]
ascan [17] & 3:n
™
dwe N carsbmp ascana [18] A sty
help A ch2.avi — [1s] A cob
d [20] A aly
Library 1 conga.dus at [21] 4 ner
Jocal € cpro.dws attrib [22]
ocales
€3 deomreg.dws avl {gf} .
PublicCACert: :
ublictALerts €3 ddb.dws baby [25] A ma
SALT bags [26] a unp
3 dfns.dws basebd [27] u A nop
Samples & display.dws bayes [28] a chr
Setup 8] dollarawmf b {ig} e
StartupSession B dyslogl.f big {31% 8 nob
" birthd 3z 8 adp
swiftshader 8 editicon.ico b‘ a [33] A nek
Synch &) eval.dws o [34] a ade
yncfusion ) excelws bsearch [3s] A pry
TestCertificates bt [3e] a zdr
€ fastfns.dws cache [37]
wWs . [38]
©) files.ds v <l [ECH:| a5y
flib - - D
R v € > case vt >
S4items 1 item selected 5.64 MB =
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You can also browse Dyalog script files. The following picture shows what you
see when you select the fileUtils.dyalog file.

. l C:\Program Files\Dyalog\Dyalog APL-64 18.0 Unicode\SALT\tools\code
QOB Home  share  view (2]
&« v A ||« 0S(C) > ProgramFiles » Dyalog » Dyalog APL-6418.0 Unicode > SALT 5 tools > code v @] | Search code P
Dyalog APL-64 14,1 Unicode  * Name - :Namespace fileUtils A V1.09
A This namespace contains various file utilities. Some require .Net.
Dyalog APL-64 15.0 Unicode 3 Ar A 2015 : dywftt domain note, replExpr properly raturns numb b
[9] A~sF.dyaleg A 2015 Fixed confusing comment typo
Dyalog APL-6417.0 Unicode [4] aplutils.dyalog A 2015 filesIn was returning more files than necessary an b
Dyalog APL-6417.1 Unicode 5] bigsting dyslog A 2015 12 13 DanB: changed dywtss to FileTStoQTs
Dyalog APL-64 18.0 Unicode 8] callingTree.dyalog Oio«dmi«1
aplfmt [£] codecov.dyalog BigEndian—/
[9] compare.dyalog
apltrans (5] fileUtits.dyal (0] v CharseReadFile name;nid;signature;nums;szsb
Base el anieny [t &/ Read ANSI or Unicode character file
5] listsUtils.dyalog r2] 0
dwa S i (3] o
[#] miscUtils.dyalog Ihl gnatu S R
help [] partScan.dyalog [s] nums +[NREAD nid 83
= [6] Chars='UTF-8'0UCS 256|nums A Signed ints
Library [9] Regecdyalog 71 Elself wib=(21 2 2p71 ~2 ~2 & Unicode (UTF-16)
lacales 5] textutils.dyalog (8] Chars«{,$(2 Jpu}s(+/b)ONREAD nid 83 sz 2
[s] Chars+'UTF-16'0UCS(2#16) 163 ODR Chars
PublicCACerts (5] Windows.dysiog [10] :Else A ANSI or UTF-8
[11] Chars—{11::0UCs w & 'UTF-8'0UCS w}256|0NREAD nid &3
SALT [12] :EndIf
core [13] ONUNTIE nid
[i] v
lib
[ol v {format}WriteFile(name chars);:nid
spice [1] A Write ANSI or Unicode character
tud [2] A format = ANSI, UTF-8 or UTF-16
ey (3] [ISTGNAL (=1 DR chars)/=('EN' 11){'Messags' 'Doss not work »
tools [4] INC' Format
(5] ormat='ANSI' 'ANSI' 'UTF-16'
code (6] tElse
7] format«'ANSI' 'UTF-8' 'UTF-16' 'UTF-8' 'UTF-16' '2'a='ANSI' »
data [a] OSIGNAL(form ?')/=(EN' 11)('Message' 'Invalid file tran v
Inet [s] EndIf
r1a] :Trap 22
special [11] nidename ONCREATE 0
[12] :Else v
Samples |- i
13items  1item selected 20,6 KB =]

Note that you may only view workspace objects and scripts in the preview pane, it
is not possible to edit them in the preview pane.
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Editing Dyalog Scripts

You may edit a script file from File Explorer by first selecting the script file and
then choosing Edit from the File Explorer context menu.

B - | C¥rogram Fies\DplogyDye.

Fone  Swre  View

€ vt [etook ) ok VO sacto. gl
Dyalog AFLEAT4T Unicode A Hiame

Dplog SLEA IS0 Uicode 3 aushapaeg

Dyslog SFL&A 170 Unicode (3]sl yelog
Dyslog SFL&4 71 Unicode 9 sgeengcyeog
Dyslog 4FL&4 180 Unicode 9] 2 IngTiceyang
it 8 o log
" @ comparecyg
spans @5
Buse it
8] sl
™ SR
e 5 ot © Shrewithsigpe
iy B T >
locles R >
PuslcCACets Sendvith Tende
saT € Corvettuitn AV Converter
core (3 Py nichFLV Payer
o 2 shre
e Ogenvith
iy ¥ Noton ntemetszcary
o0 % TorbisesVN
code <toreprevivs verions
o sendtc
Ine:
o
specil ;
Copy
Samples o =
e s Cratesharcat
6 deere
6 Reme

This brings up the standard Dyalog Editor, in a stand-alone window, just as it
would appear if undocked from the Session, as shown in the next picture.

File Edit View Help
EE £ A & 0|[san X% % B s om
% [Namespacel.C\Program File Namespace fileUtils a V1.09 ~
5 Methods) @ This namespace contains various file utilities. Some require .Net.
A 2015 05 19 Adam: dywftt domein note, replExpr properly returns number of changes (not files), fileRena b
- DNetfilelnfo @ 2015 06 22 Adam: Fixed confusing comment typo
Eis @ 2015 10 31 DanB: filesIn was returning more files then necessary and removed folders from result
Exists @ 2015 12 13 DanB: changed dywtss to FileTStoQTS
" Oio+Oml+t
filenameof
-filePermission BigEndian~+/33 Odr 256
fileRename
o] v Chars~ReadFile name;ni
filesin 1] @ Read ANSI or Unicode
filesort 2]
-FileTstoQTS [3]
makesdb [+]
[5]
mergesort (6] Chars nums a Signed ints
Options 071 signa 2 2071 "2 "2 a Unicode (UTF-16)
ReadFile 8] s={,6(2 pu)pu}¥ (4/b)ONREAD nid 83 sz 2
reckLib Eg]j ~'UTF-16'0UCS(2#16) 163 OOR C
10 :Else A ANSI or UTF-8
d
reoraer [11] rse OUcs o o ‘UTF-8'0UCS d 0
replExpr [12] tEndIf
showExpr [13] ONUNTIE nid
split [14] v
“spliame [ol v {format}Writefile(name es
test [11 a Write ANST or Unicode character file
treefileinto [2] a format I, UTF-8 or UTF-16
WriteFile [3] ers)/=('EN' 11)('Message’ 'Does not work in Classic APL')
[%]
[51 P
[e]
(7] forma UTF=8' "UTF-16' '2'5'ANSI' 'UTF8' 'UTFi6' 'UTF-8' 'UTF-16'1ef b
& STGNAL Message' ‘Invalid file translation format
O ( g )
9] +EndIf
[10] iTrap 22
[11] nid+name [INCREATE 0
r+n1 PP he
< > < >
Namespace Pos: 0/453,0
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Index

NET Classes
exploring 94

A

ActiveXControl object 66
aedit User Command 37
AfterFix 185
aligning comments 133
APL fonts 193
Array Editor 37, 61
assemblies

exploring 94
auto_pw parameter 31
AutoComplete 30

B

backtick keyboard 9
Browse .NET Assembly dialog box 95

C

chart wizard 61
class constructor 98
Classes
browsing 77
Classic Dyalog mode 154
multiple trace windows 162
single trace window 163
Classic Edition 45, 64
ClassicMode parameter 116
ClassicModeSavePosition parameter 116
CloseAll system operation 46
collapsing outlines 130, 136, 141
compiler errors 129

configuring the session 192
Constructors folder 98

context menu 26

Create (session event) 180
CurObj (session property) 5, 181
CurPos (session property) 181
Current Object 5

CurSpace (session property) 181

D

Debugging Threads 168
default wx parameter 51
deleting lines 29

Docking 21

DyalogStartSE Parameter 197
DyalogStartup Parameter 197

E

edit_cols parameter 113,116
edit_first x parameter 113, 116
edit_first y parameter 113,116
edit_offset x parameter 113,116
edit offset y parameter 113,116
edit_rows parameter 113, 116
editor

aligning comments 133

class treeview 129, 142

collapsing outlines 130

compiler errors 129

edit menu 124

editing classes 140

expanding outlines 130

file menu 120

function line numbers 129

invoking 111

outlining 130, 135

refactor menu 128

sections 143

selecting text 117

syntax menu 126

toolbar 118

trace, stop and monitor 134

using 131

view menu 129

windows menu 127
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endsection statement 137, 143
Enums 93
Event (session property) 182
Event Sets 92
Events
AfterFix 185
Fix 186
Format 187
SessionPrint 187
SessionTrace 189
WorkspaceLoaded 191
executing expressions 30
execution (tracing) 160
expanding outlines 130, 136, 141

F

File (session property) 182

file explorer integration 200
find 146

find and replace dialogs 146
Find Objects Tool 103

Fix 186

Font (session property) 182
Format 187

function line numbers 129-130

H

Handle (session property) 181
HintObj (session property) 182

I

ILDASM 94

IME Configuration 8

Input (session property) 181
input codes 13

input line 29

interrupt 6

K
keyboard shortcuts 2, 11

L

language bar 27
line numbers 129-131
Log (session property) 181

M

Metadata 94, 96
Methods folder 101
monitor 134
mouse

using in session 5

N

NET classes 94
Net Metadata 83
New method 98

(0]

Object CoClasses 87
Object Properties
COM Properties tab 109
Monitor tab 108
Net Properties tab 110
Properties tab 106
Value tab 107
Objects 89
OLEClIient object 83, 86
OLEServer object 66
outlining 130, 135

P

page width 31

Popup (session property) 182
Posn (session property) 182
private 98

Properties folder 99
PropertyExposeRoot parameter 51
PropertyExposeSE parameter 51



Index

207

R

registry keyboard 3
replace 146

S

section statement 137, 143

selecting text 117

session
configuring 4, 192
deleting lines 29
file menu 41
help menu 53
initialisation 197
options menu 50
popup menu 55
session menu 47
status bar 64

status field styles 64

threads menu 52

tools menu 51

value tips 33
session action menu 48

session colour scheme 17
session initalisation 197

session log 19, 29

session log menu 48

session menubar 41
action menu 48
edit menu 44
file Menu 41
help menu 53
log menu 48
options menu 50
session menu 47
threads menu 52
tools menu 51
view menu 46
windows menu 46

session object 4, 20, 47

session statusfields 65

session toolbars 59
edit tools 62
object tools 61
session tools 63

tools tools 62

workspace tools 60
session_file parameter 4, 20, 180
SessionOnTop parameter 116
SessionPrint 180, 187
SessionTrace 189
Show trace stack on error 153
Size (session property) 182
SPICE 199
State (session property) 183
Status window 21, 66
stop 134
system operations 4, 47, 194

T

Threads Tool 164
TipObj (session property) 183
trace 134
trace tools 155
Trace on_error parameter 153
tracer
automatic trace 153
break-points 161
Classic Dyalog mode 154
controlling execution 160
invoking 153
naked trace 153
tracing an expression 153
treeview 129, 142
Type Libraries 74, 83

U

underscored characters 11

Unicode Edition 64

User Commands 199
aedit 37

\%

value tips 33

view menu
editor 129
session) 46

Visual Styles 59
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W

white space 134
WorkspaceLoaded 180, 191
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